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CHAPTER 1 INTRODUCTION TO JASPERREPORTS SERVER
TIBCO JasperReports® Server builds on TIBCO JasperReports® Library as a comprehensive family of Business
Intelligence (BI) products, providing robust static and interactive reporting, report server, and data analysis
capabilities. These capabilities are available as either stand-alone products, or as part of an integrated end-to-end
BI suite utilizing common metadata and provide shared services, such as security, a repository, and scheduling.
The server exposes comprehensive public interfaces enabling seamless integration with other applications and
the capability to easily add custom functionality.

This section describes functionality that can be restricted by the software license for JasperReports
Server. If you don’t see some of the options described in this section, your license may prohibit you from
using them. To find out what you're licensed to use, or to upgrade your license, contact Jaspersoft.

The heart of the TIBCO Jaspersoft® BI Suite is the server, which provides the ability to:
• Easily create new reports based on views designed in an intuitive, web-based, drag and drop Ad Hoc

Editor.
• Efficiently and securely manage many reports.
• Interact with reports, including sorting, changing formatting, entering parameters, and drilling on data.
• Schedule reports for distribution through email and storage in the repository.
• Arrange reports and web content to create appealing, data-rich Jaspersoft Dashboards that quickly convey

business trends.

For users interested in multi-dimensional modeling, we offer Jaspersoft® OLAP, which runs as part of the server.

While the Ad Hoc Editor lets users create simple reports, more complex reports can be created outside of the
server. You can either use Jaspersoft® Studio or manually write JRXML code to create a report that can be run
in the server. We recommend that you use Jaspersoft Studio unless you have a thorough understanding of the
JasperReports file structure. See “Adding Reports Directly to the Repository” on page 157 and the Jaspersoft
Studio User Guide for more information.

You can use the following sources of information to learn about JasperReports Server:
• Our core documentation describes how to install, administer, and use JasperReports Server and Jaspersoft

Studio. Core documentation is available as PDFs in the doc subdirectory of your JasperReports Server
installation. You can also access PDF and HTML versions of these guides online from the Documentation
section of the Jaspersoft Community website.

• Our Ultimate Guides document advanced features and configuration. They also include best practice
recommendations and numerous examples. You can access PDF and HTML versions of these guides online
from the Documentation section of the Jaspersoft Community website.

TIBCO Software Inc. 9

http://community.jaspersoft.com/documentation
http://community.jaspersoft.com/documentation
http://community.jaspersoft.com/documentation?version=7114


JasperReports Server User Guide

• Our Online Learning Portal lets you learn at your own pace, and covers topics for developers, system
administrators, business users, and data integration users. The Portal is available online from Professional
Services section of our website.

• Our free samples, which are installed withJasperReports Library, Jaspersoft Studio, and JasperReports Server,
are documented online. See “Adding Reports Directly to the Repository” on page 157 and Jaspersoft
Studio User Guide for more information.

JasperReports Server is a component of both a community project and commercial offerings. Each integrates the
standard features such as security, scheduling, a web services interface, and much more for running and sharing
reports. Commercial editions provide additional features, including Ad Hoc charts, flash charts, dashboards,
Domains, auditing, and a multi-organization architecture for hosting large BI deployments.

This chapter contains the following sections:
• Logging In
• The Getting Started Page
• The Library Page
• Browsing the Repository
• Searching the Repository
• Using Repository Resources
• Sorting the Repository List

1.1 Logging In
Launch JasperReports Server by entering http://<hostname>:8080/jasperserver-pro in a web browser,
where <hostname> is the name of the computer that hosts JasperReports Server. The Login page appears.

Figure 1-1 Jaspersoft Login Page

10 TIBCO Software Inc.
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To log in to the server, JavaScript and cookies must be enabled in your browser.

Before logging in, review the information on the login page. There are links to the online help and additional
resources.

To log in to the server:
1. Enter your user ID and password.

If you installed an evaluation server with the sample data, you can log in with the sample user IDs and
passwords. For more information, click Need help logging in?

If the Organization field appears in the Login panel, enter the ID or alias of your organization. If you don’t know
it, contact your administrator. For more information, see “Logging into a Server with Multiple Organizations”
on page 11.

The default administrator login credentials are superuser/superuser and jasperadmin/jasperadmin.

For security reasons, administrators should always change the default passwords immediately after installing
JasperReports Server, as described in the JasperReports Server Administrator Guide.

2. If you want to use a different locale and time zone than the server uses, click Show locale & time zone.
The Locale and Time Zone fields appear in the Login panel. Select your locale and time zone from the
drop-down menus.

3. Click Login.
If you entered a valid user ID and password, the server displays the Getting Started page, as shown in
Figure 1-3.

1.1.1 Logging into a Server with Multiple Organizations
If the administrator has configured your server to use the multi-tenancy feature, it supports multiple
organizations. Each organization has its own private area for storing files and resources. The default Login
dialog for a multi-tenant server has an additional field: Organization. The left side of Figure 1-2 shows this
field. Enter the ID or alias of your organization. For example, enter the ID of the default organization:
organization_1.

You don’t have to enter the organization ID each time you log in. The first time you log in, include the
organization ID in your login URL, as shown on the right side of Figure 1-2. Bookmark the URL and use it for
subsequent log ins. The Organization field does not appear in the dialog when you specify it in the URL.

http://<hostname>:8080/jasperserver-pro/login.html
http://<hostname>:8080/jasperserver-pro/login.html?

orgID=organization_1

TIBCO Software Inc. 11



JasperReports Server User Guide

Figure 1-2 Login Methods for Multiple Organizations

The superuser account does not specify an organization because it is the system-wide administrator. If the
Organization field appears in the Login dialog when you log in as superuser, leave it blank. If you try to log
in as superuser with an orgID in the URL, the server returns an error.

1.2 The Getting Started Page
From the Getting Started page, you can quickly access the most frequently used features of the server.

12 TIBCO Software Inc.
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Figure 1-3 Getting Started Page

1.2.1 Core Workflows
The Getting Started page for standard users has multiple blocks that link to the core workflows of JasperReports
Server, that may include some or all of the following options:
• Data Sources – Select or define a connection to a database or other data source.
• Domains– Add structure to your data source for use in an Ad Hoc view.
• Ad Hoc Views – Select or create the visualization for your data.
• Reports – Create an interactive report from an Ad Hoc view, or select an existing report.
• Dashboards – Combine related reports into one layout, or select from existing layouts.
• Admin – Configure your server and manage user settings. This block is visible only to users with

administrator privileges.

Each workflow block on the Getting Started page may contain links to video tutorials, pages or wizards to
create related elements, and filtered repository lists containing relevant items. Click these links, rather than the
blocks themselves, to access these resources. Users with administrator access may have more of these options
available to them.

1.2.2 The Getting Started Column
On the left side of the page, there are two lists to help you locate and access relevant information and assets.
• Popular Resources – Includes links to educational and support resources.
• Recently Viewed Items – Includes links to up to 10 recently viewed repository items, such as reports, Ad

Hoc views, dashboards, and the like.

TIBCO Software Inc. 13
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1.2.3 Menu Items
The menu items along the top of the Getting Started page are available from every page on JasperReports

Server. and the Library, View, Manage, and Create menus offer the options described in the table below.

Menu Description

Returns to the Getting Started page.

Library Displays a pared-down repository page that contains the Ad Hoc views, reports, and
dashboards the currently logged-in user has rights to

View • Search Results – Displays the repository of resources filtered by criteria selected in the
Filters panel.

• Repository – Displays the repository of files and folders containing resources, such as
reports, report output, data sources, and images.

• Schedules – Lists the reports that you have scheduled.
• Messages – Lists system messages, such as an error in a scheduled report.
• UI Samples – (administrators only) Presents galleries of UI components that you redesign

using Themes.

Manage • Organizations – Opens the Manage Organizations page.
• Users – Opens the Manage Users page.
• Roles – Opens the Manage Roles page.
• Server Settings – Opens the Server Settings | Log Settings page.

Create • Ad Hoc View – Launches the Ad Hoc Editor for designing views interactively.
• Report – Launches the Create Report dialog for creating a report based on an Ad Hoc

view and a report template.
• Dashboard – Launches the Dashboard Designer for laying out multiple reports with input

controls, labels, and images.
• Domain – Launches the Domain Designer for setting up a Domain.
• Data Source – Launches the New Data Source page for specifying the attributes of the

new data source.

If you log in as an administrator, the Home page has additional options and menu items for managing users,
roles, organizations, and settings, such as repository folder names. Administrator functions are documented in
the JasperReports Server Administrator Guide. The links to the Online Help, Log Out, and a search field
appear on all JasperReports Server pages. For more information about searching, see “Filtering Search Results”
on page 18.

1.2.4 JasperReports Server Keyboard Shortcuts
JasperReports Server provides keyboard shortcuts to help you navigate its web UI without the use of a mouse or
other pointing device. These shortcuts are available on the Login page, the Home page, the Library Page, the
Repository page, the Search Results page, and the interactive report viewer, allowing you to log in, move
between major navigational elements of these page, select and open reports, and navigate tabular reports.
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Shortcuts include:

Key Action

Left Arrow Navigate left one column, cell, or item.

Right Arrow Navigate right one column, cell, or item.

Up Arrow Navigate up one row, cell, or item.

Down Arrow Navigate down one row, cell, or item.

Enter Select an item or navigate into an inner control.

Escape Cancel an action or navigate out to an outer control.

Tab Navigate to the next major region or form field.
Focus moves from left to right.

Note that, on some pages, the Shift key can also be used in conjunction with the arrow keys or Tab:
• When used with the arrow keys, Shift multi-selects items, such as reports listed in the Library page.
• When used with Tab, Shift changes the direction that focus moves from left to right to right to left.

In addition, the web UI has improved compatibility with screen readers, which assist visually impaired users in
using computers. The implementation follows the WAI-ARIA (Web Accessibility Initiative Accessible Rich
Internet Applications Suite) technical specification, and has been certified for certain versions of JAWS (Job
Access With Speech) with certain browsers:
• Internet Explorer 8 with JAWS 14
• Internet Explorer 11 with JAWS 16

To further increase JasperReports Server's accessibility, we recommend that you enable the Easy Access theme,
which increases color contrast and highlighting in the web UI. It can improve the user experience of those with
visual impairment. For more information on themes, see the JasperReports Server Administrator Guide.

1.3 The Library Page
The Library page offers a more focused view of the repository objects. It contains only the Ad Hoc views,
reports, and Dashboards that the currently logged-in user has rights to view and work with.

Click Library to view your Library list.

TIBCO Software Inc. 15
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Figure 1-4 Library Panel

From the Library page, you can:
• Run and schedule reports
• Open Ad Hoc views and generate reports from them
• Run and edit dashboards
• Run OLAP views

All of these functions are available by right-clicking the item you want to work with and selecting an action
from the context menu.

1.3.1 Created vs. Modified Dates
The Library table has two columns that refer to when the repository items were created and last modified.

Generally, the created date will be earlier than the modified date. In some situations, however, the created date
may be after the modified date. This can happen for one of two reasons:
• When an existing report (A) is modified, then subsequently copied into a new report (B). In the Library list,

report B’s created date is the day it was created, but its modified date reflects the last time report A was
changed.

• An existing report is exported from one system and imported into another. In the Library list, the reports
created date is the date it was imported into the new system, and the modified date is the date it was last
modified in the original system.

1.4 Browsing the Repository
The repository is the server’s internal storage for reports, analysis views, and related files. The repository is
organized as a structure of folders containing resources, much like a file system. However, unlike a file system,
the repository is stored as a private database that only JasperReports Server can access directly.

To browse the repository, select View > Repository. From the repository page, you access the reports, themes,
and other files stored on the server. You can browse the repository contents that you have permission to view

16 TIBCO Software Inc.
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by expanding icons in Folders. Click a folder name to view its contents. In Figure 1-5, you'll see the
Repository page.

Figure 1-5 Repository Folders Panel

1.5 Searching the Repository
You can search the entire repository, subject to permissions, or narrow the search using filters. Filters restrict a
search by name, who changed the resource, type of resource, date of the resource, and schedule.

1.5.1 Searching the Entire Repository
To search the repository, select View > Search Results. The search results page appears. Instead of only
viewing resources by folder, use intuitive search criteria, such as who modified the resource and when, to find
pinpoint resources.

On the search results page, use either the Filters panel or Search field to find resources. The search results page
displays results of searches and filters.

TIBCO Software Inc. 17
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Figure 1-6 Search Results Page

To search all resources in the repository:
1. Select one of these filters: All available, Modified by me, or Viewed by me.

2. Click the icon in the search field to clear the search term if there is one.
3. Select All types, as shown in Figure 1-6.

4. Click .
The search results appear listing files that your user account has permission to view. Click a resource in the
list to view it or right-click a resource to see what functions are available from the context menu.

The server remembers your settings on the Search Results page, so the most commonly needed resources remain
visible when you return to the page.

1.5.2 Filtering Search Results

If you enter a search term and click at the top of any server page, the server doesn’t use filters. The search
uses these default settings:
• Include subfolders
• Start at the top-most folder visible to the user
• Search for reports, report outputs, OLAP views, or other resources
• Sort alphabetically by name

If you click View > Search Results and click on the search results page, the server uses the filters you set
in the Filters panel.

In Figure 1-7, you can see the results of a search for the term “account” using the filters All available and All
types.

18 TIBCO Software Inc.
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Figure 1-7 Search Field and Search Results

The search term you enter in the search field isn’t cleared automatically. To clear the search term, click the
icon in the search field.

You refine a search using filters. For example, filters can help you find your most recently viewed reports. You
can set each filter independently. You can set the following types of filters:
• User
• Resource
• Access time
• Scheduled report

The user filter has the following settings:

Filter Setting Description

All Available (default) All resources.

Modified by me Selects only resources that were last modified by the user who’s logged in.

Viewed by me Selects only resources that were run and viewed by the user who’s logged in. This
filter not only applies to visualization types, but also to resources that are included in
reports such as images.

The resource type filter has the following settings:

Filter Setting Description

All types (default) All resources.

Reports Displays only reports, both JRXML reports and Ad Hoc reports.

Report outputs Displays only the output from reports that were scheduled or run in the background.
Report output can be any of the supported export types, such as HTML and PDF.

Dashboards Displays only dashboards.

TIBCO Software Inc. 19
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Filter Setting Description

OLAP views Displays only analysis views (if you implement Jaspersoft OLAP).

Domains Displays only Domains.

Data sources Displays only data sources.

The access time filter has the following settings. All times are relative to the user’s effective time zone:

Filter Setting Description

Any time (default) All resources.

Today Resources viewed or modified since the previous midnight.

Yesterday Resources viewed or modified during the previous day ending at midnight.

Past week Resources viewed or modified during the past 7 days, including today.

Past month Resources viewed or modified during the past 30 days, including today.

The scheduled report filter has the following settings:

Filter Setting Description

Any schedule (default) All resources.

Scheduled Only reports that have scheduled jobs.

Scheduled by me Only reports that have jobs scheduled by the currently logged in user.

Not scheduled Only reports that don’t have scheduled jobs and all other resource types.

Remember these do's and don'ts when searching for resources:
• Do use word fragments.
• Do search for the display name or part of the display name of a resource.
• Do search for words or fragments in the description of a resource.
• Do use multiple words.
• Don’t search for folder names.
• Don’t enter quotes around terms or symbols between terms.
• Don’t worry about using upper- or lower-case letters in search terms.

1.6 Using Repository Resources
After finding a resource in the repository, naturally you want to do something with it. Options are:
• Click the name of a report to run and view it.
• Right-click the name of a resource to access other operations on the context menu, for example Edit or

Open in Designer. Items appear on the context menu according to your permissions.
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• Click anywhere in the row except the resource name to select a resource. Ctrl-click anywhere in the rows to
select multiple resources. Use the context menu or buttons above the results list: Run, Edit, Open, Copy,
Cut (move), or Delete. If the button is unavailable, the resource doesn’t support the operation or you don’t
have permission for the operation. For example, the Open button is available when you select a dashboard
or an Ad Hoc report if you have permission to write to it.
You might also need permission to access the folder or dependent file, such as an image, of a resource. For
example, to schedule a report, you need to have read/write/delete permission on the folder where server
saves the report output. For more information about permissions, see the JasperReports Server Administrator
Guide.

These two icons may appear in the Repository panel:

•  indicates that the report has saved options for its input controls. Click the  icon to list the saved
options. For more information, see “Running a Report with Input Controls or Filters” on page 65.

•  indicates that the report is scheduled to run or is running in the background. Click this icon to view the
list of jobs scheduled for the report. For more information, see “Scheduling Reports” on page 70.

1.7 Moving Folders
If you have read permission on folders and resources, you can copy and cut them from one folder and paste them
to another if you have write permission on the destination folder. The server pastes all contents of the folder
into the new location.

You can drag-and-drop the objects instead of using the paste menu item. Move folders one at a time. You can
move other resources in batches.

Relocated objects inherit permissions from the destination folder, losing the permissions in place before
the move. To change permissions on an object, set the permissions explicitly.

To move folders and resources by cutting and pasting:
1. Log into the server as a user who has these permissions:

• Read permission on the folder or resource to move
• Write permission on the destination folder
For example, log in as joeuser (use the password, joeuser).

2. Click View > Repository.
3. In the Folders panel, right-click Reports > Samples and select Add Folder.
4. In the Add Folder dialog, enter a name, such as Financial Reports, and click Add.

The Financial Reports folder appears as a subfolder of Samples and inherits Joe User’s default permissions
(read-write-delete) on the parent folder.
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Figure 1-8 New Financial Reports Folder

5. The Financial Reports folder deserves a more prominent location. Move it up one level:
a. In Folders, right-click Financial Reports, and select Cut.
b. Right-click Reports, and select Paste.

The Financial Reports folder now appears in Reports at the same level as Samples.

You can relocate a folder, subject to permissions, anywhere in the repository with one exception: The
server doesn’t support copying and pasting a folder to the same location. If the Paste command is
disabled when you right-click a destination folder, you don’t have write permission on the folder.

1.8 Sorting the Repository List
To change the order of the list of reports and other resources, use the Sort By controls:
• Click Name to sort alphabetically (A at the top). This is the default sort order.
• Click Modified Date to sort by the latest modified time and date (most recent at the top).
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This section describes functionality that can be restricted by the software license for JasperReports
Server. If you don’t see some of the options described in this section, your license may prohibit you from
using them. To find out what you're licensed to use, or to upgrade your license, contact Jaspersoft.

A Jaspersoft dashboard displays several reports in a single, integrated view. A dashboard can include input
controls for choosing the data displayed in one or more dashlets, and custom dashlets that point to URLs for
other content. By combining different types of related content, you can create appealing, data-rich dashboards
that quickly convey trends.

Figure 2-1 Sample dashboard

Dashboards created with JasperReports Server 6.0 and later use the Dashboard Designer, Jaspersoft's web UI for
grouping all of these elements, along with creating new content from existing JasperReports Server data sources.
The majority of the information in this chapter applies to dashboards created with JasperReports Server 6.0 and
later.

If you're working with an earlier version of JasperReports Server, or dashboards created in an earlier version
(regardless of your currently-installed version of JasperReports Server), you'll find information on working with
dashboards at the end of this chapter, in section 2.8, “Viewing Legacy Jaspersoft Dashboards,” on page 47
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This chapter contains the following sections:
• Overview of the Dashboard Designer
• Viewing a Dashboard
• Creating a Dashboard
• Editing a Dashboard
• Tips for Designing Dashboards
• Viewing Legacy Jaspersoft Dashboards

2.1 Viewing a Dashboard
You can view a dashboard if you have the proper permissions. The default location for dashboards is the
/Dashboards folder. The following procedure walks you through opening one of JasperReports Server's samples,
the SuperMart dashboard.

To view the SuperMart dashboard:
1. Log in as user demo, using the password demo.

Passwords are case-sensitive. You must use lowercase when you type demo.

The SuperMart dashboard opens in the dashboard viewer. This dashboard includes five reports and an input
control.

Figure 2-2 SuperMart Dashboard Example

2. In the Country input control dashlet, click the text entry box.
3. Select USA, then click Closeto change the data displayed.

The four reports with Country data update to display data for USA only. the Top 5 report, which does not
contain Country data, does not change.
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4. When done, click View > Repository to go to the repository page.

Keep these points in mind when viewing a dashboard that has input controls:
• An input control may appear as a text field, a drop-down, a check box, a multi-select list box, or a calendar

icon.
• If one of the dashlets in a dashboard does not refer to an input control, that dashlet does not update when

you change that input control’s value. Only reports that use the input control reflect the change.

• If the button appears on the toolbar, then the dashboard was set up to display input controls as a
pop-up window instead of a dashlet. Click the button to view the controls.

If a dashboard does not appear when you click on its name in the repository, it may already be open
in another window or tab of your browser.

2.2 Overview of the Dashboard Designer
The Dashboard Designer is a web-based UI for embedding reports, Ad Hoc views, and other BI objects into a
single, interactive space. You can compile dashboards that include pre-existing elements, such as reports and
views, and create new charts, tables, and crosstabs from your data sources directly from the designer.

Each element on your dashboard is called a Dashlet. Dashlets have unique names and resource IDs, and
editable properties that vary depending on the Dashlet type.

Your permissions to access the repository may limit the content you can add and the location where you can
save the dashboard.

This section includes:
• The Dashboard Designer Interface
• Dashlets and Dashboard Elements
• Dashboard Properties
• Dashlet Properties
• Parameter Mapping

2.2.1 The Dashboard Designer Interface
The following figure shows the basic layout of the Dashboard Designer.
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Figure 2-3 The Dashboard Designer UI

The Dashboard Designer UI includes the following panels:
• Available Content. From here, you can drag content onto the Dashboard Canvas. This panel includes the

following sections:
• New Content, which lists the content elements you can create for your dashboard.
• Existing Content, which lists the Ad Hoc views and reports you can access from the Repository.
• Filters, which lists all filters associated with any resource added to the dashboard.

• Toolbar Buttons. See table below for details.

Icon Name Description

Preview Click to display current dashboard as viewed by the end user.

Save/Save As Hover cursor over icon to open a menu of save options.

Undo Click to undo the most recent action.

Redo Click to redo the most recent undone action.

Undo All Click to revert the dashboard to the most recently saved state.

Parameter Mapping Click to open the Parameter Mapping dialog. See Parameter
Mapping for more information.
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Icon Name Description

Dashboard
Properties

Click to open the Dashboard Properties box. See Dashboard
Properties for more information.

Show/Hide Grid Click to display or hide a grid.

Show/Hide Filter
Dashlet Pop-up

Click to display or hide a filter pop-up window. This button only
appears when you enable filter dashlet pop-ups in Dashboard
Properties.

• Dashboard Canvas. This is where you create and edit your dashboard. It includes the following sections:
• Title Bar, which displays the name of the dashboard (in the figure above, the name is "New

Dashboard").
• Main Creation Area, where you build your dashboard. Drag elements from the Available Content

panel here to get started.

2.2.2 Dashlets and Dashboard Elements
Each element added to your dashboard is called a Dashlet.

To add a Dashlet to your dashboard, simply select a content element and drag it onto the dashboard canvas.

Dashlets can include the following elements, which you can access from the Available Content panel:
• New Content:

• Chart: Allows you to create a chart within the Dashboard Designer.
• Crosstab: Allows you to create a crosstab within the Dashboard Designer.
• Table: Allows you to create a table within the Dashboard Designer.
• Text: A free-form text entry field. Use free text items to add titles and instructional text to the

dashboard.
• Web Page. Any URL-addressable web content. The dashboard can point to web content.
• Image: An image from the repository or that is accessible by a web address URL. For example, you

might include a dashlet that displays your corporate logo. The logo's image file can either be in your
repository or on the server of your corporate website.

• Existing Content: Reports and Ad Hoc views accessible to you.
• Filters: If a report you include on the dashboard is designed to use input controls or filters, you can add

that capability to the dashboard. The server maps input controls to one or more dashlets. Controls can also
be manually mapped to custom URL dashlets.

• Title Bar: You can enable a title bar in the Dashlet Properties dialog box. The title bar includes the
following elements:
• The Dashlet name, as entered in the Dashlet properties.
• Dashlet toolbar, which can contain the following:

Icon Name Description

Maximize Click to open the dashlet as a larger view.
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Icon Name Description

Refresh Click to refresh the dashlet.

For more advanced functionality, you can access dialog boxes that let you edit the overall appearance of your
dashboard, modify the functionality of your dashlets, and create mappings between your dashboard input
controls and your dashlets.

2.2.3 Previewing a Dashboard
You can preview your dashboard to see how it will appear when an end-user views it.

To preview a dashboard:

1. Click . The dashboard opens in preview mode.

2. To close the preview and return to the Dashboard Designer, click .

2.2.4 Dashboard Properties
You can view and edit the basic appearance of all dashlets on your dashboard, and determine the refresh
settings, through the Dashboard Properties.

To view and edit the Dashboard Properties:

1. On the dashboard toolbar, click to open the Dashboard Properties window.
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Figure 2-4 Dashboard Properties

2. Edit the Canvas and Dashlet Settings, if needed:
• Show filter dashlet as pop-up: Select when you want the filter dashlet to appear as a pop-up

window instead of a dashlet pinned on the dashboard.
• Show dashlet borders: Select or deselect this to show or hide the thin lines around each dashlet.
• Dashlet outer margin in pixels: Enter the desired width, in pixels, of the margins between dashlets.
• Dashlet inner padding in pixels: Enter the desired width, in pixels, of the padding inside each

dashlet.
• Fixed canvas size in pixels: Select when you want the dashboard to be displayed at a specific width

and height instead of dynamically resizing based on the browser window. Enter the desired width and
height of the dashboard.

3. Edit the Button and Toolbar Settings, if needed:
• Show Export Button: Select or deselect to show or hide the Export button in the dashboard viewer.

4. Edit the Refresh Settings, if needed:
• Auto-refresh dashboard contents: Select or deselect this to enable or disable automatic refresh for

your content.
• Refresh Interval: Enter the number of minutes or seconds between each content refresh, using the text

entry and drop-down menu.
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2.2.5 Dashlet Properties
You can view and edit basic information and appearance for each dashlet on your dashboard using the Dashlet
properties. For some dashlets, you can also create parameters which you can then map to in Parameter Mapping.
The available properties vary based on the type of dashlet you are working with.

To view and edit the Dashlet properties:
1. Right-click on the dashlet and select Properties to open the Dashlet Properties window. The Hyperlinks

tab is available for Ad Hoc-based charts and charts created inside the dashboard.

Figure 2-5 Dashlet Properties

2. Click Apply to view the changes, OK to accept the changes, and Cancel to discard the changes.

Properties for Dashlets containing charts, crosstabs, tables, reports, and Ad Hoc views include:
• Dashlet Name: Editable field for the displayed dashlet name.
• Resource ID: Non-editable ID taken from the original dashlet name.
• Source Data: Non-editable path of the source data.
• Show/Hide Dashlet Elements: Select or deselect to show or hide the title bar, which includes the dashlet

name, refresh button, and maximize button.
• Scale to Fit: Use the drop-down menu to determine how the element is scaled in the dashlet.
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• Refresh Settings: Select or deselect to enable or disable auto-refresh, and use the text entry and drop-
down menu to set the time between each content refresh. This setting overrides refresh properties set at the
dashboard level.

Properties on the Hyperlink tab for Dashlets containing charts include:

The Hyperlinks tab is available for Ad Hoc-based charts and charts created inside the dashboard.

• Enable chart hyperlinks: Select or deselect to enable a hyperlink for the dashlet
• Action: Select link behavior for this dashlet:

• Update dashboard: Select this option to update dashlets linked to this one when a user clicks on a
data point in the chart.

For an example of linked dashlets, open the 2. Performance Summary Dashboard, and click on one of
the bubbles in the Store Segment Performance with Hyperlinks chart.

• Open new page: Select this to have the dashlet open a web page or report, dashboard, or an Ad Hoc
view in the repository when a user clicks on the dashlet.
You can link directly to a web page using http: syntax:

http://en.wikipedia.org/wiki/$P{Customer Country}

A repository URL must begin with repo:, for example,
repo:/public/Samples/Ad_Hoc_Views/05._Unit_Sales_Trend

To find the correct syntax for a path in the repository, hover over the resource name in the Existing
Content panel in the Dashboard Designer or open the resource's Properties dialog from the
repository.

You can add a parameter to a hyperlink for a web page, dashboard, or report. Parameters are not
available for Ad Hoc views. See 2.4, “Specifying Parameters in Dashlets,” on page 39 for more
information about adding parameters to hyperlinks.

• Available parameters: When you add a parameter, use a name in this list to have Parameter Mapping
create the link to the parameter automatically.

• Create Links in Parameter Mapping: When you add a parameter, click this button to save and close the
Dashlet Properties window and open Parameter Mapping. See Parameter Mapping for more information.

Properties for Dashlets containing text include:
• Dashlet Name: Editable field or the displayed dashlet name.
• Resource ID: Non-editable ID taken from the original dashlet name.
• Text: Editable field for the text displayed in the dashlet.
• Scale to Fit: Use the drop-down menu to determine how the text is scaled in the dashlet. This overrides

the specified font size.
• Font: Use the selection lists and buttons to set the font, font size, font style, alignment, and font color for

the text displayed in the dashlet.

Properties for dashlets containing a Web Page include:
• Dashlet Name: Editable field for the displayed dashlet name.
• Resource ID: Non-editable ID taken from the original dashlet name.
• Web Page Address (URL): Editable field for the URL displayed in the dashlet.
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• Show/Hide Dashlet elements: Select or deselect to show or hide the title bar, which includes the dashlet
name, refresh button, and maximize button.

• Show scroll bars: Select or deselect to show or hide scroll bars.
• Refresh Settings: Select or deselect to enable or disable auto-refresh, and use the text entry and drop-

down menu to set the time between each content refresh. This setting overrides refresh properties set at the
dashboard level.

Properties for dashlets containing an image include:
• Dashlet Name: Editable field for the displayed dashlet name.
• Resource ID: Non-editable ID taken from the original dashlet name.
• Web Address/Repository URI: Editable field for the location of the image displayed in the dashlet. This

can include parameters.

To find the correct syntax for a path in the repository, open the resource's Properties dialog from the
repository.

• Show/Hide Dashlet elements: Select or deselect to show or hide the title bar, which includes the dashlet
name, refresh button, and maximize button.

• Scale to Fit: Use the drop-down menu to determine how the image is scaled in the dashlet.

Properties for dashlets containing a filter include:
• Dashlet Name: Editable field for the displayed dashlet name.
• Resource ID: Non-editable ID taken from the original dashlet name.
• Show/Hide Dashlet buttons: Select or deselect to show or hide the Apply button or Reset button.
• Position of dashlet buttons: Use the drop-down menu to select bottom or right.

2.2.6 Parameter Mapping
Parameter Mapping helps you refine your filters by letting you specify which dashlets and which parameters are
affected by a filter.

To open Parameter Mapping:
1. Open a dashboard with filters, such as the Sales Dashboard created in Creating a Dashboard, in the

Dashboard Designer.

2. Click to open Parameter Mapping.
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Figure 2-6 Parameter Mapping for the Sales Dashboard

Parameter Mapping displays the filter-to-dashlet mapping, and includes the following columns and buttons:
• Source Dashlet, the name of the dashlet where the filter originates. Can also display Filter Group

(multiple filters in a single dashlet) or Manually Created Filter (filter created using Parameter Mapping,
as described below).

• Filter/Parameter, the name of the filter.
• Dashlet Affected, with a dropdown menu including all dashlets that can be affected by that filter.
• Filter/Parameter Affected, with a dropdown menu including all parameters associated with the

selected dashlet in the Dashlet Affected column.
• Add button , used to add additional dashlet/parameter combinations to a filter.

• Delete button , used to delete a dashlet/parameter combination.

From Parameter Mapping, you can add, delete, or edit an existing dashlet/parameter combination, and create a
new filter to add to the dashboard.

To add a filter using Parameter Mapping:
1. Open a dashboard with filters, and open Parameter Mapping as described above.

2. In the filter row you want to add the new filter to, click . A row containing new affected dashlet and
filter/parameter dropdown menus appears.

3. Using these new line-items, select the dashlet and parameter combination you want to apply to the
dashboard.

4. Click OK to apply and save or Cancel to discard your changes.

To delete a filter using Parameter Mapping:
1. Open Parameter Mapping.

2. In the filter row you want to delete, click . The filter row disappears from Parameter Mapping.

To create a new filter via Parameter Mapping:
1. Open Parameter Mapping.
2. Click Create New Filter. A new row is added to the manager.
3. In the Filter column, enter a name for the new filter. Click outside the text box to apply the name.

4. Click and select the dashlet and parameter combination you want to apply to the new filter.
5. Click OK to apply and save, or Cancel to discard the new filter.
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To delete a newly-created filter:

1. In Parameter Mapping, click in the filter row you want to delete. The Dashlet Affected and
Filter/Parameter affected dropdown menus disappear.

2. Click again in the row you want to delete. The Filter row disappears.
3. Click OK to apply and save, or Cancel to discard the new filter.

2.3 Creating a Dashboard
This section describes the creation of a simple dashboard.

To add a report or Ad Hoc view to a dashboard, you must have permission to view those elements.

To create a simple dashboard:
1. Click Create > Dashboard. The Dashboard Designer appears, displaying the list of available content and

the canvas.
2. In the Existing Content section of the Available Content panel, find report 16. Interactive Sales Report.
3. Click and drag the report onto the Dashboard Canvas.

Figure 2-7 Dragging report onto Dashboard Canvas

4. In Available Content, find 04. Product Results by Store Type Report.
5. Click and drag the report onto the canvas, until the left half of the Interactive Sales Report turns orange.
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The Product Results by Store Type Report appears on the canvas, next to the Interactive Sales Report. Both
report dashlets are sized to fit side-by-side on the canvas.

6. Right-click the Product Results by Store Type Report and click Properties.
7. Use the Scale to Fit dropdown to select Dashlet.
8. Click OK. The resized Product Results by Store Type Report now displays the entire crosstab in the dashlet.
9. Click and drag the report 05. Accounts Report onto the canvas, until the lower half of the Interactive Sales

Report turns orange.
The Accounts Report is placed under the Interactive Sales Report, and both dashlets are resized to fit on the
right half of the canvas.

10. In the Dashboard Designer toolbar, click to open the Dashboard Properties dialog.
11. Deselect Show dashlet borders and click OK.

In Figure 2-8 you can see how the dashboard canvas looks at this point.

Figure 2-8 Simple Dashboard Canvas with three reports

12. Click to preview the dashboard.
The end user view of the dashboard appears.

13. Click to return to the designer

14. Click , then select Save Dashboard.
15. In the Save As window, change the default name, New Dashboard to Sales Dashboard and locate a

folder, such as the /Dashboards folder.
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16. Click Save.

2.3.1 Adding New Content
In addition to pre-existing reports and Ad Hoc views, you can create content for your dashboard directly from
the Dashboard Designer, including:
• Charts
• Crosstabs
• Tables
• Text
• Web page links
• Images

2.3.1.1 Adding Charts, Crosstabs, and Tables

The Dashboard Designer includes an on-board Ad Hoc Editor, which allows you to create charts, crosstabs, and
tables for your dashboard without leaving the designer environment.

Any chart, crosstab, or table you create within the Dashboard Designer is available only on the current
dashboard; otherwise, they function like standard Ad Hoc Editor-created versions of these elements. They are
saved as an Ad Hoc view and placed in a dashlet on your dashboard.

To add a new chart, crosstab, or table to your dashboard:
1. In the New Content section of the Available Content panel, click and drag the type of element you want

to add to your dashboard (Chart, Crosstab, or Table) onto the dashboard canvas.
The designer's Ad Hoc Editor opens, and the Select Data dialog appears.

2. Browse to or search for the data source you want to use.

• Click for a tree view of the files.

• Click for a list view of the files.
• Use the text search field to locate a specific data source.

3. Depending on your selected data source, the remaining steps may vary. Follow the displayed instructions.
for more information about this process, see 4.1.1, “Ad Hoc Sources: Topics, Domains, and OLAP
Connections,” on page 84.

4. When you complete the data source selection process, click OK. The Ad Hoc Editor opens.
The on-board Ad Hoc Editor works just like the standard editor. For information on working with the
editor, see Chapter 4, “Working with the Ad Hoc Editor,” on page 83.

5. When you finish creating your view, click to save.
6. In the Save to Dashboard dialog, enter a dashlet name and click Save. The dashlet is added to your

dashboard.

2.3.1.2 Adding Text

You can add a text field dashlet for titles and instructional text.

To add a text dashlet:
1. In the New Content section of the Available Content panel, click and drag the Text item onto your

dashboard. The Dashlet Text window opens.

36 TIBCO Software Inc.



Chapter 2  Working with Dashboards

2. Enter the text you want to appear on your dashboard.
3. Click OK. The dashlet is added to your dashboard.

Edit the dashlet name and font appearance by opening the Properties dialog. See “Dashlet Properties” on
page 30 for more information.

2.3.1.3 Adding a Web Page

You can add a dashlet to display a web page on your dashboard.

To add a web page dashlet:
1. In the New Content section of the Available Content panel, click and drag the Web Page item onto

your dashboard. The Dashlet URL window opens.
2. Enter the URL you want to appear on your dashboard.
3. Click OK. The dashlet is added to your dashboard.

Edit the dashlet name by opening the Properties dialog. See “Dashlet Properties” on page 30 for more
information.

2.3.1.4 Adding an Image

You can add a dashlet to display an image, such as a corporate logo, on your dashboard.

To add an image dashlet:
1. In the New Content section of the Available Content panel, click and drag the Image item onto your

dashboard. The Dashlet URI window opens.
2. Enter the URI for the image you want to appear on your dashboard. Use the repo: syntax for images in

your repository.
3. Click OK. The dashlet is added to your dashboard.

Edit the dashlet name by opening the Properties dialog. See “Dashlet Properties” on page 30 for more
information.

2.3.2 Adding Controls to a Dashboard
The Interactive Sales Report was designed to be run with input controls. When you add a report that has input
controls to a dashboard, the controls don’t appear until you explicitly add them, one-by-one. The controls can
either be added directly to the dashboard as a dashlet or accessed from the toolbar as a pop-up window. When
the report runs, dashboard users provide input using the control. Data based on the user input appears in the
dashboard. For example, using the input control, you select Mexico. The report on the dashboard shows orders
from Mexican companies.

To add controls as a dashlet:
1. If the Sales Dashboard created in Creating a Dashboard is not open, locate the /Dashboards folder in the

repository. Right-click the dashboard name and select Open in Designer from the context menu.
The Sales Dashboard appears in the designer, as shown in “Simple Dashboard Canvas with three
reports”, and the input controls available appear in the Filters section of the Available Content panel.

2. In the Filters section, expand the 16. Interactive Sales Report folder.
The input controls associated with the Interactive Sales Report appear.

3. Drag the Country input control onto the canvas, and place it above the Product Results by Store Type
dashlet.
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The Country input control and its label appear above the Product Results by Store type report on the
canvas.

4. Drag the Product Family and Product Department controls onto the Country input control dashlet. These
input controls are added to the same dashlet. Resize the dashlets as needed to view all of the input controls.

5. Click and select Save Dashboard, then click to preview the dashboard.
6. Click in the Country text box to display the available countries. In this input control, you have the

following options:
• The three countries: Canada, Mexico, and USA.
• All, which selects all available values in the input control.
• None, which deselects all available values in the input control.
• Invert, which deselects any selected values, and selects the unselected values.

7. Use the options to select Mexico from the values list, and click Apply at the bottom of the dashlet. The
data displayed in the Interactive Sales Report changes, but is not updated in the other reports, as they do
not have an input control named Country.

8. Click to return to the Dashboard Designer.

You can also change the labels, or display names, of individual input controls and filters within a dashlet.

To rename an input control or filter:
1. With the Sales Dashboard open in the Dashboard Designer, right-click Product Family in the input control

dashlet, and select Properties. The Filter Properties dialog opens.
2. Change the Filter Label from Product Family to Type, and click OK.
3. Right-click the Product Department input control and select Properties. Change the Product Department

filter label to Department, and click OK. The input control labels are updated.

Figure 2-9 Parameter Mapping for the Sales Dashboard

To add controls as a pop-up window:

1. With the Sales Dashboard open in the Dashboard Designer, click to open Dashboard Properties.
2. Select Show filter dashlet as pop-up and click OK.

The input controls dashlet disappears from the dashboard and appears on the toolbar. This button is
also displayed when you're viewing the dashboard.
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3. Click and select Save Dashboard, then click to preview the dashboard.

4. Click to view the filter pop-up window.
Like the dashlet, selecting the options in the pop-up changes the data displayed in the Interactive Sales
Report.

5. Click to close the filter pop-up window.

6. Click to return to the Dashboard Designer.

2.3.3 Refining a Dashboard’s Layout
After completing the layout, refine the look and feel of the dashboard.

To refine the dashboard’s layout:
1. If it isn’t open, locate the Sales Dashboard you created in Creating a Dashboard, typically in the

/Dashboards folder.
2. Right-click the dashboard name, select Open in Designer from the context menu
3. When the dashboard opens in the designer, click Preview.

The end user’s view of the dashboard appears.
4. In the Country field, select a new value.

The reports do not update because the dashboard includes the Apply button.
5. Return to the Dashboard Designer and on the Country filter dashlet, right-click and select Properties.
6. Deselect Show Apply button, and select Show Reset button.
7. Click Apply.

The dashlet's Apply button disappears, and the Reset button appears.
8. Reposition the Reset button to the right side of the dashlet using the Position of dashlet buttons drop-

down menu. Click OK.
9. Click Preview. The end user view of the dashboard appears.
10. Change the value in the Country input control. The dashboard reflects the change immediately.
11. Return to the Dashboard Designer and click Save > Save Dashboard. The dashboard is saved to the

repository.

2.4 Specifying Parameters in Dashlets
You can add parameters to dashlet names, text dashlets, web page dashlets, and hyperlinks in chart dashlets.
When you add a parameter, you must map a filter in the dashboard to the parameter. See Mapping parameters
in Parameter Mapping for more information.

Simple parameters:

For text dashlets, web links, and dashboard names, use the syntax $P{parameter_name} to directly pass the
parameter value to the web page. Examples:
• In a text dashlet, enter the parameter in the Text box:

Product Family: $P{Product Family}
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• In a web page dashlet or a web link in a chart dashlet hyperlink, enter the parameter in the Web Page
Address (URL) text box:

http://en.wikipedia.org/wiki/$P{Customer Country}

• In a repository or web URI for an image dashlet, enter the parameter, enter the parameter in the Web
Address/Repository URI text box:

repo:/public/Samples/Reports/$P{Customer Country}/flag.png

• Dashlet name: Enter the parameter in the Dashlet Name box:
Unit Sales for $P{Product Family}

For repository hyperlinks in a chart dashlet, use the syntax ?filter_in_target=$P{dashlet_param}. For
example, the following link sets the c_country_1 input control in the 05. Unit Sales Trend report to the value of
a Store Country parameter in the dashlet.

repo:/public/Samples/Reports/05._Unit_Sales_Trend?c_country_1=$P{Store Country}

To find the correct name for a filter in a target resource, open the Dashboard Designer in a new
window, and add the resource to the canvas. Then expand the resource's folder in the Filters panel
and hover over the filter whose name you want to see.

Parameters in multi-valued input controls:

For multi-valued input controls, you can define a separator for the input control values:
• For text dashlets, web links, and dashboard names, use the syntax $P{parameter_name ? "separator"}. The

following example in a text box displays results like Product Family: Drink + Food:
Product Family: $P{Product Family ? " + "}

• For repository links in a chart or image dashlet, use the syntax ?$P{"filter_in_target=", dashlet_
param, ? "&"}. For example, the following link allows multi-select with the c_country_1 input control in
the 05. Unit Sales Trend report:

repo:/public/Samples/Reports/05._Unit_Sales_Trend?$P{"c_country_1=", Store
Country, "&"}

When Mexico and USA are selected, this expands to the following link:
repo:/public/Samples/Reports/05._Unit_Sales_Trend?c_country_1=Mexico&c_country_1=USA

2.4.0.1 Mapping parameters in Parameter Mapping

After you have created a parameter, create a mapping for it as follows:

Mapping parameters in dashboard names and text, image, or web page dashlets:

1. In the Dashboard Designer, click to open Parameter Mapping.

2. In the filter row where you want to add the new filter, click . A row containing new affected dashlet and
filter/parameter dropdown menus appears.

3. Using these new line-items, select the dashlet where you added a parameter, then select the parameter.
4. Click OK to apply and save or Cancel to discard your changes.

Mapping parameters in chart hyperlinks:

To have JasperReports Server create a parameter mapping automatically:
1. In the Dashlet Properties dialog box for your chart, use one of the names in the Available parameters list as

the name of your parameter.
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2. Click OK to close the dialog box and create the mapping.

To create a mapping in Parameter Mapping:
1. In the Dashlet Properties dialog box for your chart, click Create Links in Parameter Mapping... to open

Parameter Mapping.

2. In the filter row where you want to add the new filter, click . A row containing new affected dashlet and
filter/parameter dropdown menus appears.

3. Using these new line-items, select the dashlet where you added a parameter, then select the parameter.
4. Click OK to apply and save or Cancel to discard your changes.

2.4.1 Creating a Web Page Dashlet
When working with Web Page dashlets in the Dashboard Designer, you can include a parameter reference in the
dashlet's URL. The parameter references an existing filter in another dashlet, and uses that filter to display a
specific web page relevant to the filtered information.

The following example takes you through the steps for creating a simple dashboard in the Dashboard Designer,
adding a sample chart with geographic filters, and creating a Web Page dashlet that displays a Wikipedia page
for the country the sample chart is filtered on.

First, create the simple dashboard:
1. 1. Log in to JasperReports Server as superuser.
2. Click Create > Dashboard.

The Dashboard Designer appears, displaying the list of available content and the canvas.
3. In the Existing Content section of the Available Content panel, find report 06. Sales Mix by Gender.
4. Click and drag the report onto the Dashboard Canvas. Note that the Filters section now includes the Sales

Mix by Gender chart.

Next, add the filter input control to the dashboard:
1. In the Filters section, expand the 06. Sales Mix by Gender folder.

The input controls associated with the Sales Mix by Gender Report appear.
2. Drag the Customer Country input control onto the canvas.

Now, add the Web Page dashlet with the parameter reference and add it to the filter:
1. In the New Content section of the Available Content panel, click and drag the Web Page item onto

your dashboard.
The Dashlet URL window opens.

2. Enter the following URL:
http://en.wikipedia.org/wiki/$P{Customer Country}

3. Click OK.
4. Right-click the dashlet and select Properties.
5. Change the Dashlet Name to Wiki.

6. Click to open Parameter Mapping.

7. In the Customer Country filter, click .
A row containing the new affected dashlet and filter/parameter dropdown menus appears.
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8. In the Dashlet Affected column, select wiki from the new Select dashlet... dropdown menu.
9. In the Filter/Parameter Affected column, select Customer Country from the new Select parameter...

dropdown menu.
10. Click OK.

Finally, preview the new dashboard functionality:

1. Click to preview the dashboard.
2. Click in the Customer Country text box to display the available countries.
3. Select Mexico from the values list, and click Apply at the bottom of the dashlet. The data in the Sales Mix

by Gender report is updated to display only information about Mexico, and the wiki dashlet displays the
Wikipedia page for Mexico.
In Figure 2-10 you can see how the dashboard canvas looks at this point:

Figure 2-10 Dashboard with web page parameters

4. Click to return to the Dashboard Designer.

5. Click , then select Save Dashboard.
6. In the Save As window, change the default name, New Dashboard to Sales by Gender Dashboard and

locate a folder, such as the /Dashboards folder.
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7. Click Save.

2.4.2 Adding a Hyperlink to a Chart Dashlet
When working with chart dashlets in the Dashboard Designer, you can specify a link that opens when a user
clicks the dashlet. You can optionally include a parameter which references an existing filter in another dashlet,
and uses that filter to display a specific web page relevant to the filtered information.

The following example takes you through adding a hyperlink to the chart dashlet in the Sales by Gender
dashboard created in 2.4.1, “Creating a Web Page Dashlet,” on page 41. The example also shows how to add
a parameter to a hyperlink.

First, open the dashboard:
1. If the Sales by Gender dashboard created in 2.4.1, “Creating a Web Page Dashlet,” on page 41 (above) is

not open, locate the /Dashboards folder in the repository. Right-click the dashboard name and select Open
in Designer from the context menu.
The Sales by Gender Dashboard appears in the designer.

Create a chart hyperlink:
1. Right-click on the Sales Mix by Gender dashlet and select Properties....

The Dashlet Properties dialog box opens.
2. Click the Hyperlinks tab.

Figure 2-11 Hyperlinks tab in Dashlet Properties

3. Click Enable chart hyperlinks to select it.
4. Choose Open new page from the Action menu.

The Web Address/Repository URI entry bar is displayed.
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5. Enter repo:/public/Samples/Reports/04._Product_Results_by_Store_Type_Report for the Web
Address/Repository URI.

To see the report's path, hover over the report's name in the Existing Content pane.

6. Click OK.

Preview the new dashboard functionality:

1. Click to preview the dashboard.
2. Click the chart dashlet.

The 04. Product Results by Store Type Report opens in a new tab.

3. Click to return to the Dashboard Designer.

Add a parameter:
1. Right-click on the Sales Mix by Gender dashlet, select Properties..., and click the Hyperlinks tab.

The Available Parameters area shows the parameters available in the chart.
2. Modify the URL to add a parameter that provides a value for an input control in the target report:

• You need to know the correct name of the input control in your target report. In this case it is sales__
store__store_contact__store_country_1 in the 04. Product Results by Store Type Report.

• Create a parameter. If you create a parameter name, it is helpful to use a name that is not used in
Parameter Mapping. In this example, use LinkCountry. For more information about parameters, see 2.4,
“Specifying Parameters in Dashlets,” on page 39.
The link is as follows:
repo:/public/Samples/Reports/04._Product_Results_by_Store_Type_Report?sales__
store__store_contact__store_country_1=$P{LinkCountry}

If you use one of the names in the Available Parameters list, the mapping to the parameter is created for
you. In this example, if you use Store Country instead of LinkCountry, you do not need to create links
in Parameter Mapping.

This example does not show how to add support when more than one country is selected. For more
information, see 2.4, “Specifying Parameters in Dashlets,” on page 39.

3. Click Create Links in Parameter Mapping. Click Yes when prompted.
Parameter Mapping is displayed.
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Figure 2-12 Parameter Mapping

4. In the Customer Country filter group, click .
A new row with affected dashlet and filter/parameter drop-down menus appears.

5. In the Dashlet Affected column, select 06. Sales Mix by Gender from the new Select dashlet... drooping
menu.

6. In the Filter/Parameter Affected column, select LinkCountry from the new Select parameter... dropdown
menu.

7. Click OK.

Finally, preview the new dashboard functionality:

1. Click to preview the dashboard.
2. Click in the Customer Country text box to display the available countries.
3. Select Mexico from the values list, and click Apply at the bottom of the dashlet.
4. Click the chart dashlet.

The 04. Product Results by Store Type Report opens in a new tab.

5. To verify that the parameter has been passed correctly, click in the 04. Product Results by Store Type
Report.
The Input Controls dialog box opens, with Mexico set.

6. Return to the tab that contains your dashboard.

7. Click to return to the Dashboard Designer.

8. Click , then select Save Dashboard.

2.5 Editing a Dashboard
You can edit a dashboard if you have the proper permissions.
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To edit a dashboard:
1. Select View > Repository and search or browse for the Dashboard you want to modify.

By default, the repository includes the /Dashboards folder where you can store dashboards.
2. Right-click the dashboard and select Open in Designerfrom the context menu. The designer appears,

displaying the dashboard.
3. Edit the dashboard by adding, removing, resizing, or dragging content.

For more information about working with dashboard content, see “Creating a Dashboard” on page 34.

4. When you are satisfied with the dashboard, hover your cursor over and select Save Dashboard. To
create a new version of the dashboard, select Save Dashboard As and specify a new name.

2.6 Exporting a Dashboard
You can create a snapshot of a dashboard and save it on your computer. Exporting a dashboard requires the
following:
• The export button has been enabled for the dashboard. See “Dashboard Properties” on page 28 for more

information.
• PhantomJS is installed on the computer hosting JasperReports Server. For information on configuring

PhantomJS for dashboards, see the System Configuration chapter in the JasperReports Server Administrator
Guide.

To export a dashboard:
1. Select View > Repository and search or browse for the Dashboard you want to export.
2. Click the link to open the dashboard.

3. Hover your cursor over and select the export format from the drop-down list.
The available formats are:
• PNG
• PDF
• DOCX
• ODT

4. Save the dashboard in the export file format, for example PDF, or open it in the application.

If you export a dashboard while a dashlet is reloading its content, the dashlet will appear as a grayed-out
box in the exported file.

2.6.1 Localizing Controls
You can design dashboard controls to accommodate different languages. First, use the $R syntax to define
prompts and static lists of values. Next, attach resource bundles to the report that contain translations of the
prompts and lists of values. Finally, add the report to the dashboard. For more information about how to localize
input controls, see “Localizing Reports” on page 184.
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2.7 Tips for Designing Dashboards
Charts and small crosstabs are best suited to dashboards. However, you can design table reports that work well
in the dashboard. Such reports tend to be very narrow and are typically used with input controls to limit the
number of rows they return.

Keep reports small because dashboards typically contain more than one. In particular, reports shouldn’t be too
wide, as horizontal room is always at a premium in a dashboard. The server strips margins from an Ad Hoc
report when displaying the report on a dashboard.

2.7.1 Input Control Tips
When designing input controls for a dashboard, keep these guidelines in mind:
• To pass a value to an external URL, the URL Parameter Name you give to the input control must match

the name of a parameter that the URL can accept. The value of the input control must also be a value the
URL can accept. The target URL is likely to have additional requirements and limitations. For example, the
name of the parameter may be case-sensitive; in this case, the value you enter in the URL Parameter
Name field is also case-sensitive.

The input control must pass data that the URL can accept. Otherwise, the server may be unable to retrieve the
correct data from the external URL.

2.8 Viewing Legacy Jaspersoft Dashboards

This section refers to legacy dashboards, those created in JasperReports Server version 5.6.2 and
earlier.

Dashboards created prior to JasperReports Server version 6.0 open in their respective versions of the Dashboard
Designer. The following procedure shows you some of the features of legacy dashboards. For more information
about the features available for legacy dashboards, see the edition of the JasperReports Server User Guide
corresponding to the version of JasperReports Server where the dashboards were created.

To view a legacy dashboard:
1. Open your dashboard for viewing. This example uses the SuperMart Performance dashboard, one of the

samples in an earlier version of JasperReports Server. Although this dashboard may not be available in your
version of JasperReports Server, other legacy dashboards are similar.
The SuperMart dashboard includes three reports:
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Figure 2-13 SuperMart Dashboard Example

2. When you hover over a report, controls appear for that report: Click Refresh to refresh the report
content, and click Open in a new window to open the report in a new window.

3. Select new values from the Start Month and End Month drop-downs and click Submit to change the data
displayed. All three reports update to display data for the months you indicate.

4. Click Reset to set the input controls to the last values saved and return the dashboard to its initial view.
5. When done, click View > Repository to go to the repository page.

Keep these points in mind when viewing a dashboard that has input controls:
• An input control may appear as a text field, a drop-down, a check box, a multi-select list box, or a calendar

icon.
• If one of the frames in a dashboard does not refer to an input control, that frame does not update when you

change that input control’s value. Only reports that refer to the input control reflect the change.

If a dashboard includes a Print View button, click it to display the dashboard without JasperReports
Server's header and footer. Depending on your web browser, this may also open your browser's Print
window.
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JasperReports Server makes it easy to run reports. When you run a report, it opens in the interactive Report
Viewer. With the Viewer, you can personalize and refine the displayed report data. If the report has input
controls, you run the report with one set of data and then another. Using the report scheduler, you can run
reports repeatedly and unattended during off hours or at other times.

This chapter contains the following sections:
• Overview of The Report Viewer
• Running or Creating a Simple Report
• Running a Flash Chart
• Running a Report with Input Controls or Filters
• Scheduling Reports
• Event Messages

The tutorials in this chapter and throughout this guide assume you’ve installed the sample data provided with
the server.

3.1 Overview of The Report Viewer
The Report Viewer allows you to view a report, export content to various output formats, and apply formatting,
sorting, and filters to control how the data is displayed.

This section describes the functions available in the Report Viewer. You can find more detailed information
about using this functionality throughout this chapter.

To open a report in the Report Viewer:
1. Locate your report in the library or repository.
2. Click the report name, or right-click the report name and select Run. In the repository, you can also click

the report row and select Run from the tool bar. The report opens in the Report Viewer.

3.1.1 The Report Viewer Tool Bar
The Report Viewer tool bar contains a number of controls for working with your report. These controls are
described in Table 3-1.
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Icon Name Description

Refresh
report with
latest data

Click to refresh the report data from the data source.

First Click to jump to the first page of the report.

Previous Click to go to the previous page in the report

Current
Page

Shows the number of the currently displayed report page.

Next Click to go to the next page in the report.

Last Click to jump to the last page of the report.

Zoom Out Click to zoom out on the report.

Zoom In Click to zoom in on the report

Zoom
Options

Click this icon to open the Zoom Options drop-down menu.

Search Enter your search term here to find a text string in your report. Click the
drop-down menu to toggle search preference settings.

Search
Previous

Click to jump to the previous instance of the search term.

Search Next Click to jump to the next instance of the search term.

Back Exits the Report Viewer and takes you to the previous screen.

Table 3-1 Report Viewer Tool Bar Icons

50 TIBCO Software Inc.



Chapter 3  Running Reports and the Report Viewer

Icon Name Description

Save Place the cursor over this icon to open a menu of save options.

Export Click to export the View into one of the available formats.

Undo Click to undo the most recent action.

Redo Click to redo the most recently undone action.

Undo All Click to revert the report to its most recently saved state.

Input
Controls

Click to see the input controls applied to this report. For more
information, refer to “Simple Input Controls” on page 65.

Bookmarks Click to display the Table of Contents pane. This pane is available only
on reports with enabled Bookmarks.

3.1.2 Column Menu
Reports that contain table components are enabled for user interactivity. Table components are defined in
Jaspersoft Studio or from Ad Hoc Views. When a table is enabled for interactivity, column formatting, filtering,
and sorting are managed from a menu displayed by clicking the column you want to apply changes to. These
menu icons are described in Table 3-6.

Icon Name Description

Formatting/Show column/Hide column Select Formatting to open the Format Column box.

Select Show column or Hide column.

Table 3-2 Column Formatting Icons
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Icon Name Description

Column filters Click to open the Filter column box.

Sort ascending Click to sort fields in the selected column in ascending
order.

Sort descending Click to sort fields in the selected column in ascending
order.

Column size Click and drag this icon to make columns wider or
narrower.

3.1.3 Data Snapshots
Some reports have an optional data snapshot feature enabled. A data snapshot is a cached copy of the data
included in a specific report. Data snapshots allow you to access a report's data (including input control
settings) without having to retrieve it from the data source, which in some cases can save a significant amount
of time.

When a report is opened in the Report Viewer, data is retrieved from the data snapshot. If the snapshot does not
exist, then a live query is made to the data source. A snapshot is created when a report is saved from the viewer,
or via the scheduler. The Report Viewer UI displays a date and time stamp that indicates when the report data
was last refreshed with live source data.

The system administrator can enable or disable the data snapshot feature.

It should be noted that a report can have only one snapshot. For instance, if you edit and save a report that
already has a snapshot associated with it, a new snapshot overwrites the previously-created snapshot.

3.2 Running or Creating a Simple Report
You can view and work on a report in the Report Viewer in a number of ways:
• Running an instance of an existing report
• Creating a new report from an existing Ad Hoc view

3.2.1 Running a Simple Report
This section describes how to run a tabular report that lists account data.

To run a report:
1. Log into the server as an administrator, such as jasperadmin.
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2. On the Home page, click View list in the Reports block.
The search results appear, listing your own files and other files that your user account has permission to
view. If you log in as jasperadmin, 05. Accounts Report appears in the search results.

Figure 3-1 Search Results Listing

3. To run a report, click the name of a report in the repository. For example, click 05. Accounts Report. The
report appears, as shown in Figure 3-2.

Figure 3-2 Output of the Accounts Report

If you are running a report with multiple pages, the first page of the report appears before the entire report
is loaded. You can begin scrolling through report pages as they load, as indicated in the pagination
controls in the upper left corner of the Report Viewer.

If you want to cancel loading the report before it is complete, click the Cancel Loading button that appears
next to the pagination controls.

3.2.2 Creating a Report
You can create a report directly from the Jaspersoft Server Home page. This method allows you to select an
existing Ad Hoc view and generate a report from it, without going through the Ad Hoc Editor.

To create a report from the Home page:
1. On the Home page, click Create in the Reports block. The Create Report wizard opens.
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2. Select the Ad Hoc view you want to use as the basis for your report.
3. Select a report template. To use a template other than the default, select Custom Report Template, click

Browse and select the desired template. See 3.2.3, “Report Templates,” on page 54 for more information.
4. Click OK. If asked, enter the input controls needed. See “Using Input Controls” on page 143.

You can now begin working with your report.

3.2.3 Report Templates
When you create a report, the Create Report wizard displays layout options for generating and exporting the
report:
• Default Report Template applies basic layout options to your report. This is usually the Actual Size

template.
• Custom Report Template allows you to browse to an existing template. JasperReports Server includes a

number of templates are available by default, including:
• A4 Landscape
• A4 Portrait
• Actual Size
• Letter Landscape
• Letter Portrait.
Other report templates may be available. Report templates can be created in Jaspersoft Studio and uploaded
to JasperReports Server.

• Report Generator allows you to create a highly customized report design. This option is not often
enabled. See your JasperReports Server administrator for more information.

Most commonly, you will choose Default Report Template.

3.2.3.1 Using Report Templates for PDF

If you are exporting your report to PDF, choose your option based on the size of the output.
• For most PDF exports, you can use Actual Size, which supports a maximum size of 14400px by 14400px.
• For reports with an output height exceeding 14400 px, use a paginated report template that is wide enough

for your report. For example, if you have a long report with width less than 842px, you can use the
paginated A4 Landscape theme. A report designer can create additional custom templates in Jaspersoft
Studio. contact your administrator for more information.

• Reports with output width exceeding 14400 px will be truncated in PDF. Redesign your report or use a
different export format.

3.3 Getting New Perspectives on Data
The report shown in Figure 3-2 was created using the Ad Hoc Editor. As this type of report runs, you can
interact with it in the Report Viewer to visualize the data in different ways. Column formatting allows you to
highlight certain columns and fields, and filtering and sorting report output on-the-fly can provide timely views
of the data that answer your questions. For example, suppose you’re running the Accounts Report and want to
know how many accounts have offices nearby. Highlighting the phone number column with red text and
filtering it to show only accounts in your area code would reveal this data.
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3.3.1 Column Formatting
You can customize the basic formatting of column headings and fields, using the Format Column dialog. Hover

over and click Formatting... The Format column dialog appears.

Figure 3-3 Format Column Dialog

You can alter a column’s basic formatting or apply conditional formatting to a column.

In longer reports, columns have floating headers. If your report extends past your browser frame, use the
vertical scroll bar to move up and down the list. If you do not see a vertical scroll bar, try increasing the
width of your browser window.

This section discusses how to apply formatting to column headings and values. For information on conditional
formatting, see “Conditional Formatting” on page 56.

Column formatting options include:
• Text
• Font type, size, and style
• Background color
• Font color
• Text alignment

To customize your column formatting:
1. Run your report, so it opens in the Report Viewer.
2. Click the column you want to format.

3. Hover over and click Formatting...
4. Click the Basic Formatting tab, and change the following options if needed:

• Apply to – Select the part of the column you want to apply the formatting to.
• Heading text – Type new heading text to replace the current text.
• Font – Scroll through the menu to select a font.
• Size – Scroll through the menu to select a font size.
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• Style – Click to select Bold, Italic, or Underlined text.
• Background Color – Click to open the background color picker, then click to select the background

color.
• Font Color – Click to open the font color picker, then click to select the text color.
• Alignment – Click to select Left, Center, or Right alignment.

5. If needed, click Previous Column or Next Column to change the formatting for an adjacent column.
6. Click OK.

3.3.2 Conditional Formatting
The Report Viewer allows you to format column headings and fields, to highlight data that meets specific
criteria. For instance, if you want to call out fields for store sales above $100,000, you can do so by applying
text and background formatting to those stores that meet those numbers.

With conditional formatting, you can apply the formatting options listed in “Column Formatting” on page 55.
However, it is a slightly more complex process than applying formatting options to entire columns. This section
describes those complexities, including:
• Condition hierarchy
• Condition button states
• Applying conditional formatting

3.3.2.1 Condition Hierarchy

If you have multiple conditions applied to a single field, their order will affect how they function. Conditions
are read and applied from bottom to top, and the topmost condition overrides the one(s) below.

For example, imagine you have more than one condition applied to the same format element: red text for all
stores over 20,000 square feet, and blue text for all stores over 30,000 square feet. As shown in “Condition
Hierarchy Example” on page 57, placing the formatting rule for stores over 20,000 above the rule for stores
over 30,000 causes the topmost rule to override the one below:
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Hierarchy Result

Figure 3-4 Condition Hierarchy Example

3.3.2.2 Condition Button States

Because conditions higher up in the hierarchy can affect those below, the font style selection buttons each have
three states:
• Unchanged, which means it inherits the previous condition-based style, if any.
• Set, which means the style is applied to text that meets the condition.
• Not Set, which means the style is not applied to the text that meets the condition, and is removed if a

conflicting condition lower in the conditional formatting hierarchy has marked that style as “Set”.

By default, the buttons are in the “Unchanged” state. Clicking the buttons toggles you through the three states.

See “Style Button States” for examples of the style button states.

Unchanged Set Not Set

Bold

Italic

Underline

Table 3-3 Style Button States
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The background and font color pickers have buttons for similar states, but these states behave slightly
differently:
• Unchanged, which means the field inherits the previous condition-based color, if any.
• Set, which means the color is applied to text or background of the field that meets the condition.
• No Fill (background only), which means no color is applied to the background that meets the condition.

Regardless of conditions lower in the hierarchy, the background inherits the table’s default color.

Both have two buttons at the top of the window, along with the color selection boxes.

You control these states through the background color picker and the font color picker windows, using the
following buttons:
• No Fill (background only), which applies the No Fill state described above.
• Reset, which returns the text or background to the Unchanged state.
• The color selection boxes, which apply the Set state.

See “Color Picker Button States” for examples of the color picker button states.

Unchanged Set No Fill

Background Color

Text Color N/A

Table 3-4 Color Picker Button States

3.3.2.3 Applying Conditional Formatting

You apply conditional formatting much like you do standard column formatting, as described in “Column
Formatting” on page 55 with the extra step of creating the condition by which the formatting is applied.

To create a condition:
1. Run your report, so it opens in the Report Viewer.
2. Click the header or field of the column you want to format.

3. Move your mouse over and click Formatting...
4. Click the Conditional Formatting tab. The Conditional Formatting options appear:
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Figure 3-5 Conditional Formatting Tab

5. In the Apply to box, select the part of the column you want to apply the formatting to.
6. Click Add. This adds a line item in the Conditions List.
7. Fill in the following information:

• Operator: Use the drop down menu to define how the condition is compared to the column data.
• Condition: Enter the condition criteria.
• Format: Select the formatting applied to fields meeting the defined condition. Take care setting the

button states, as described in “Condition Button States” on page 57.
8. Repeat if needed to add multiple conditions to a column.

If you have multiple conditions, you may want to reorder them, to ensure they do not conflict with each

other. Use the and to move conditions in the hierarchy.
9. If needed, click Previous Column or Next Column to change the conditional formatting for an adjacent

column.
10. Click OK. The condition is applied to the column.

3.3.3 Interactively Filtering Report Output
If the report output contains more information than you want, interactively filter it to display just what you
need. You conditionally filter report output by first selecting the column to use as a basis for filtering. Next,
you enter a filter condition, then a value for comparison. The server compares each field of the column to the
value that meets the condition. In Table 3-5 you can see the conditions available for each type of column:
numeric, date, and text.

Numeric Date Text

Equals Equals Equals

Does not equal Is not equal to Is not equal to

Greater than Is between Contains

Greater than or equal to Is not between Does not contain

Less than Is on or before Starts with

Table 3-5 Interactive Filtering Conditions
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Numeric Date Text

Less than or equal to Is before Does not start with

Is between Is on or after Ends with

Is not between Is after Does not end with

To interactively filter report data:
1. As you run the type of report shown in Figure 3-2, click the column you want to use for filtering the

report. Continuing with the example in “Running or Creating a Simple Report” on page 52, click the
Phone column in the Accounts report.

2. Click the .
The Filter column dialog appears, as shown in Figure 3-6. By default, Show all rows is selected.

3. To build your filter, click the radio button to select Show only rows where.
the comparison operator drop-down and value entry box become active.

4. Select a comparison operator from the drop-down. For example, select Starts with to compare phone
numbers starting with certain numbers.

5. Enter a value for comparison with the data in the column. For example, enter the area code: 408-

Figure 3-6 Filter Column Dialog

6. Click OK.
The view of the report changes to show the filtered output. For example, now the Accounts Report only
shows accounts in the 408 area code.

Figure 3-7 Filtered Report Shows Only Accounts in Area Code 408

60 TIBCO Software Inc.



Chapter 3  Running Reports and the Report Viewer

A small star icon appears in the heading of the filtered column, to the right of the heading text.
7. To clear the filter indicator and once again display all the accounts, reopen the Filter column dialog and

select Show all rows, then click OK.

3.3.4 Interactively Sorting a Report
You can also sort data in report output interactively. For example, you can sort the data alphabetically in
ascending or descending order within each city listed in the Accounts Report.

To interactively sort report output:
1. As you run the type of report shown in Figure 3-2, click the column you want to use for sorting the report.

For example, click the Name column in the Accounts report.

2. Click (sort ascending) or (sort descending). The report refreshes, and data appears sorted by the

selected column in the selected order. In this example, for instance, if you select , the grouped rows of
data are sorted alphabetically in ascending order within each group. Row 1 of the Burnaby, Canada group
is now D & Z McLaughlin Electronics, Ltd and row 1 of the Cliffside, Canada group is Abbott-Liff
Electronics Holdings.
The heading text in the column used to sort report data appears red, and the up or down arrow icon in the
column header indicates that report output now appears in ascending or descending order, respectively.
To change the sort order of the groups themselves, you have to modify the report query.

3.3.5 Moving, Resizing, and Hiding Columns
Columns are easily moved, resized, and hidden in your report.
• To move a column, click the column you want to move, then drag the column left or right into the new

position. The indicates where the column is placed.

• To resize a column, click the column you want to resize, then drag the until the column is the size
you want.

• To hide a column, click the column you want to hide, then move your mouse over the and select
Hide column.

3.3.6 Setting Output Scale
You can determine the display size for any report by using the report scaling options, located in the Report
Viewer tool bar.

• Click to zoom in on the report.
• Click to zoom out on the report.

• Click to open the Zoom Options drop-down menu, and select the percentage by which you
want to increase or decrease the size of the displayed report.
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3.3.7 Using the Bookmarks Panel
When working with a report that contains bookmarks, they are displayed in a floating panel. Using this panel,
you can jump to designated sections of the report.

Figure 3-8 The Bookmarks Panel

• To display the Bookmarks panel, click in the Report Viewer tool bar.
• To jump to a bookmarked section of the report, click the name of the section in the Bookmarks panel.

3.4 Navigating the Report
If your report has multiple pages, you can use the pagination controls to move through the report quickly.

To navigate the published report:

• Use at the top of the Report Viewer to navigate to the previous page.

• Use to navigate to the next page.

• Use to go to the end of the report.

• Use to go to the beginning of the report.
• If you know the number of the page you want to view, enter the page number in the Current Page indicator

box.
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3.5 Exporting the Report

To export the report:
1. To view and save the report in other formats, click the Export button.
2. Select an export format from the drop-down. The export options are listed in Table 3-6.

Option Format Name Usage

PDF Adobe Acrobat Choose a report template based on report size. Use the
Actual Size report template for reports with dimensions less
than or equal to 14400px by 14400px. See 3.2.3, “Report
Templates,” on page 54 for more information.

Excel (Paginated) XLS Not recommended for exporting most tables or crosstabs.
Repeats headers and footers on each page.

Excel XLS Ignores page size and produces spreadsheet-like output.

CSV Comma Separated Values Characters outside the Latin 1 character set can cause the
Excel spreadsheet to look unacceptable. Try saving the file
and importing it using Excel's Import functionality.

DOCX Word Do not export reports having more than 63 columns. In
Microsoft Word, you cannot create tables having more than
63 columns.

RTF Rich Text Format Creates a large output file and, therefore, takes longer to
export than PDF, for example.

ODT OpenDocument Text For best results, minimize the number of rows and columns
and make sure they don’t overlap.

ODS OpenDocument
Spreadsheet

Same as ODT.

XLSX (Paginated) Microsoft Open XML Format
Spreadsheet

Not recommended for exporting most tables or crosstabs.
Repeats headers and footers on each page.

XLSX Microsoft Open XML Format
Spreadsheet

Ignores page size and produces spreadsheet-like output.

PPTX Microsoft PowerPoint
Presentation

Each page of report becomes a slide in the PowerPoint
presentation.

Table 3-6 Export File Types

3. Save the report in the export file format, for example PDF, or open the report in the application.
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3.6 Running a Flash Chart
The JasperReports Server commercial editions support Flash charting, and include the Maps Pro, Charts Pro, and
Widgets Pro component libraries.

Using the libraries, you can create visually appealing, animated, and interactive reports:
• Maps Pro – Color-coded maps covering all countries and regions of the globe.
• Charts Pro – Standard and stacked charts with animation and interactivity.
• Widgets Pro – Non-standard charts such as gauges, funnels, spark lines, and Gantt charts.

These components are based on Fusion libraries and generate Flash output that is embedded in the HTML and
PDF output. When a report containing a Maps, Charts, or Widgets Pro element is exported in a format other
than HTML or PDF, the space used by the element remains blank.

To view a Maps, Charts, or Widgets Pro element in the server, install Flash Player. You might need to install
plug-ins or enable Flash on the browser. To view Flash elements in PDF output, use a Flash-enabled PDF viewer
such as Adobe Reader.

You can configure the server to default to HTML5 when rendering Pro Charts. See the JasperReports Server
Administrator Guide for more information.

Flash charts are created in Jaspersoft Studio Professional as JRXML reports and uploaded to the repository as a
report unit. JasperReports Server cannot create Flash charts. The sample report 14. Performance Summary
includes flash elements.

To find and run a Flash chart example:
1. In the repository, locate the sample report 14. Performance Summary.
2. Click the report name to run the report, which launches as part of the Performance Summary Dashboard.

Figure 3-9 Performance Summary Dashboard with Flash Map
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Note the Sales Trend map in the center of the dashboard.
3. To interact with the map, mouse-over any of the countries to see the full country name and, when data

exists, the value for that country.
4. On the Sales Trend map, click Canada to launch the Interactive Sales Report, displaying the information

for Canada only. From there, you can modify the underlying report as needed.

To upload JRXML reports, see “Adding Reports Directly to the Repository” on page 157.

3.7 Running a Report with Input Controls or Filters
The server filters the data in the report output when you run a report with an input control. The perfect input
control limits the data to what you want to see—and nothing more. When you run a report based on a Domain
Topic that defines a filter, the server can render the filter as an input control.

If your system administrator has enabled the data snapshot feature (described in “Data Snapshots” on page 52),
it is important to note that the default input controls - that is, the input controls as defined when the original
Jaspersoft Studio- or Ad Hoc View-based report is run - will overwrite any changes made to them the next time
you run a report. For instance, suppose you run a report, update the input controls, then save the report. At a
later date, you run a report from the Jaspersoft Studio or Ad Hoc View source again. That new report will
replace the report you ran earlier, and your input control changes will be lost.

To avoid this, save your updated report with a different name than the default. That way, when subsequent
reports are run from the same source, they will not overwrite your report (unless they are given an identical
name when saved).

3.7.1 Simple Input Controls
The 16. Interactive Sales Report example has three input controls:
• Country
• Request Date
• Order ID

Using input controls, you run the report with one set of data and then another. When saved, an instance of the
report with alternate input controls is called a Report Version, and is labeled as such in the repository.

To run a report with simple input controls:
1. In the repository, locate and run the report 16. Interactive Sales Report.
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Figure 3-10 Interactive Sales Report

2. In the Filters panel, use the Country menu to select USA only.

Figure 3-11 Input Control Selection - Country

3. Click Close, then click Apply at the bottom of the panel. The report shows data for the USA only.

4. Click , then select Save As. You are prompted to name the new report.
5. Enter a new name, then click Save.

3.7.2 Multi-select Input Controls
The 1. Geographic Results by Segment Report has an example of a multi-select input control for Yearly Income.

To run a report with a multi-select input control:
1. In the repository, locate and run the report 1. Geographic Results by Segment Report.
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Figure 3-12 Geographic Results by Segment Report

2. On the tool bar, click .
3. Scroll to the bottom of the Input Controls dialog to view the Product Name input control.
4. Enter chicken in the Search list .

Only products containing "chicken" are shown.
5. Click the first item in the list, then scroll down and Shift-click to select all the items with "chicken".
6. Click in the Search list again and delete the word chicken.

All items are displayed, with ones that include "chicken" selected.
7. Click the Selected tab to see that only items that are selected are displayed. Then click the Available tab

to view all the items.
8. Click Invert to invert the selection.

Now all items are selected except those items that contain "chicken".
9. Click OK at the bottom of the panel. The report shows data for products that do not contain the word

"chicken" only.
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Figure 3-13 Multi-Input Control Selection

3.7.3 Cascading Input Controls
Cascading input controls in a report reduce a large number of choices to a manageable number. A single value
chosen for a cascading input control determines which other values appear as choices for input. For example, the
choice of a country determines which states or regions are listed as choices. For more information, see
“Selecting a Data Source for Running the Complex Report” on page 180.

To run a report with cascading input controls:
1. In the repository, locate and run the report 16. Interactive Sales Report.

The report runs, and appears with the Filters panel open on the left side of the Report Viewer
2. In the Filters panel’s Country multi select drop-down, select a different country, for example Canada.

The other drop-downs in the Filters panel are automatically updated with Canadian data.

Cascading input controls are implemented as queries that access the database to retrieve the new
values. The server displays an activity monitor while the query is running, and in the case of long
queries, you can click Cancel and select different values.

3. In the Product Name section, select a product to display in the report.
4. Click Apply to run the report with the chosen values.
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As with simple input controls, you can save these Options settings as a new Report Version. Click , then
select Save As.

3.8 Running a Report Book
Report books are multiple reports bundled into a single object, created in Jaspersoft Studio. You can run and
view report books from the Library page or the repository, much like you would a standard report. However,
report books contain some elements that are not found in standard reports.

To run a report book in the Report Viewer:
1. In the repository, click the name of the report book you want to run. For example, click the sample 17.

Report Workbook. The report appears, as shown below.

Figure 3-14 Sample report book as seen in the Report Viewer.

The sample report book contains three bundled reports:
• Distribution by Country, a chart-type report.
• Customer Education, a crosstab-type report.
• Customers List, a table-type report.
Each of these reports can be accessed by a tab, along with the Table of Contents page, located at the top of
the Report Viewer.

2. Click the Chart tab to open the Customer Distribution by Country report. Note that you can interact
with this report as you would with a standard chart-based report in the viewer.

3. Click the TocReport tab to return to the table of contents page.
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4. Scroll down and click the Acapulco entry in the table of contents. The first page of the Acapulco table
entries is displayed.

5. Click to open the bookmarks pane.
6. Click the Customer Education entry in the bookmarks pane. The Customer Education crosstab report

opens in the viewer.
7. Close the bookmarks pane by clicking the x in the upper right corner of the pane.

3.9 Scheduling Reports
Using the report scheduler, you set up a schedule with report parameters, output options, and notifications:
• Schedule – When to run the scheduled report, and how often
• Parameters – If the report was designed with input controls, which parameters the scheduled report will use
• Output Options – The name of the output file, the output format and locale, and where the output file is

stored
• Notifications – Email options for sending the report output to recipients and for sending administrative

messages

Scheduled reports run in the background to reduce the performance impact on the server. You can view a list of
scheduled reports on the View > Schedules page.

The permissions of the user who schedules a job determine the data that the report exposes. For example, Gloria
only has access to inventory data from the Southeast US region. A report that she schedules only shows data
from that region, even when the report is viewed by users in other regions. Other users schedule the report
themselves to see the data for their own regions.

Sensitive data could be exposed to unauthorized users if you schedule a job as an administrative user
with no data restrictions because the report will contain all requested data in the data source. Any user
who receives the report can view all the data regardless of the user’s access restrictions.

3.9.1 Creating a Schedule

To create a schedule:
1. Locate the report you want to schedule in the repository.
2. Right-click the report and select Schedule... from the context menu, or if the report already has a schedule,

click the schedule icon . The Scheduled Jobs page appears.

Figure 3-15 Scheduled Jobs Page

3. Click Create Schedule. The Schedule tab of the scheduler appears.
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Figure 3-16 New Schedule Tab

4. Set a start date, choosing whether to run immediately or on a specific date. If a specific date is selected,
click the calendar icon to select a start date and time.

5. Specify the time zone for the schedule. The default time zone is the time zone of the server, the time zone
you entered at log in. If you’re in a different time zone, set this field accordingly.

6. Choose a recurrence setting, as described in “Running a Job Repeatedly” on page 78. If you select Simple
or Calendar Recurrence, additional controls appear on the page.
• None: Run the report once.
• Simple: Schedule the job to recur at a regular interval, specified in minutes, hours, days, or weeks.
• Calendar: Schedule the job to recur on days of the week, days of the month, specific dates, or date

ranges.

If you set up a job with simple recurrence to start immediately, the job schedule will change after
export/import or a server restart. This happens because the job does not retain the previous run
history and therefore starts immediately after import or restart. If you have a lot of scheduled reports,
all scheduled reports with simple recurrence will attempt to start at the same time after export/import
or restart. This can impact server performance. In addition, some scheduled reports may be locked
out and they will continue to try to run.

To ensure a recurring schedule does not change after export/import or restart, either use simple
recurrence with a specific start time, or set up calendar recurrence.

7. If the report you are scheduling has input controls that prompt for user input, click the Parameters tab.
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Figure 3-17 Set the Parameter Values Page for Scheduling a Report

Saved values, if there are any, appear in a drop-down list at the top of the page, as shown in Figure 3-17. In
the Use saved values drop-down, you can set the input controls defined for the report you’re scheduling.
You can set the input values for the scheduled report, and click Save Current Values to save the input
value as a named set of values.
For more information about using saved values and saving input values, see “Running a Report with Input
Controls or Filters” on page 65.

8. Choose a set of saved values, or set the input controls.
9. Click the Output Options tab and set the output format and location, as described in Setting Output

Options.
10. Click the Notifications tab and set up email notifications, as described in Setting Up Notifications
11. Click Save. The Save As dialog box appears.
12. In the Scheduled Job Name field, enter a name for the job, for example, Weekly Report. The description

is optional.
13. Click Save to save the schedule. The job appears in the list of saved jobs for this report.

3.9.2 Setting Output Options
On the Output Options tab, you can change these settings:
• File name – The base name for the output file in the repository. This name must be unique; if you attempt

to create a schedule with the same file name as an existing schedule, you will not be able to save.
• Description – The optional description of the file that appears to users who view the repository.
• Time Zone– The output time zone for generating the report.
• Output Locale – The locale settings for generating the report.

The report must support locales, for example a report based on a Domain with language bundles (see
“Security and Locale Information for a Domain” on page 268).

• Formats – The available output formats. Select one or more formats; the default format is PDF. When you
select more than one, each format is stored as a separate file in the selected output destination.
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• File Handling – Select one or more checkboxes to specify handling for multiple output files with the same
name:
• Overwrite Files – Overwrites old output files with newer ones of the same name.
• Sequential File Names by Timestamp – Appends a timestamp to the names of files created by the

job. Useful for the output of recurring jobs or for time-sensitive reports where the output must be dated.
When the timestamp is used, the output filename is <basename>-<timestamp>.<extension>. Note
that, depending on the frequency of the schedule and the format of the timestamp, it may be possible to
have two output files with the same name; in this case, modify the timestamp or use the Overwrite
Files checkbox to specify the behavior you want.

• Timestamp Pattern – When Sequential File Names by Timestamp is selected, a required pattern
for the timestamp, based on the java.text.SimpleDateFormat is required. Valid patterns for report
output files can contain only letters, numbers, dashes, underscores, and periods. The default pattern is
yyyyMMddHHmm, for example 200906150601.

• For more information about the valid patterns for this field, refer to:
http://download.oracle.com/javase/6/docs/api/java/text/SimpleDateFormat.html

Figure 3-18 Output Page for Scheduling a Report – Output File Options

• Output Destination – To save the output file, select one or more checkboxes to specify the output
location. If you do not want to save the report output (for example, if you only want to email the report)
leave all checkboxes blank.
• Output To Repository – If checked, saves the report output to the specified location in the repository.

You must have write permission to the output folder.
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• Output To Host File System – If checked, saves the report output to the specified folder on the
Server host machine; check with your administrator for the correct location to enter. Output To Host
File System must be configured by an administrator; if the check box is grayed out, saving to the host
file system has not been enabled for your system. See the JasperReports Server Administrator Guide for
more information

• Output To FTP Server – If checked, saves the report output to the specified FTP server. You must
have write permission to the selected directory on the FTP server. Enter the following properties of your
FTP server:
• Server Address – The host, IP address or URL of the FTP server.
• Directory – The directory on the FTP server where the report output is saved.
• Username – The username for access to the FTP server.
• Password – The password for the username.
• Enable FTPS – If checked, specifies that server uses the FTPS file transfer protocol.
• Port – Specifies the FTP connection port. For FTP, the default port is 21; for FTPS, the default port

is 990.

Figure 3-19 Output Page for Scheduling a Report – Output Destination

When you click Submit, the job appears in the list of scheduled jobs.

3.9.3 Setting Up Notifications
On the Notifications page, you can set up email notifications to the report recipients and to administrators.

Notifications are sent to all users with the organization ROLE_ADMINISTRATOR role, who belong to the same
organization as the user who creates the report job.

74 TIBCO Software Inc.



Chapter 3  Running Reports and the Report Viewer

Send report when scheduler runs:

Enter one or more email addresses to send the report to recipients after the job has run. You can configure the
following:
• To – One or more email addresses separated by commas for sending email notification.

By default, the mail server is not configured by the JasperReports Server installer. To send email
notifications, the administrator must configure the mail server, as described in the JasperReports
Server Installation Guide.

• CC – One or more email addresses separated by commas for sending email notification on the CC line.
• BCC – One or more email addresses separated by commas for sending blind carbon-copy email

notification; the addresses in this field are not revealed to the other recipients.
• Subject – The subject line of the notification email.
• Message – Content of the notification email.
• Choose one of the radio buttons to specify how email recipients access the report:

• Include reports as repository links in email body – Sends a link to the report output in the
repository. Not available unless Output to Repository is selected on the Output Options tab.

• Include report files as attachments – Sends the report output as attachments to the notification
email. If you have selected multiple output formats, each output is attached as a separate file to the
email notification.

• Include report files as ZIP attachment – Zips all report outputs into a single archive file before
attaching to the email.

• Include HTML report in email body – Displays the report directly in the email body. This option is
available only when Include report files as attachments or Include report files as ZIP
attachment is checked and HTML is selected as one of the options on the Output File Options page.
When this option is selected, you cannot include a message in the email body.

Be careful when sending reports containing sensitive data by email, either in the email body or as an
attachment.

• Do not send emails for empty reports – A check box option that, if checked, prevents the server from
attaching empty report output files to email notifications. This applies to parametrized reports where there is
no data that matches the parameters.

Send job status notifications:
Enter one or more email addresses to send notification of job success or failure to administrators:
• To – One or more email addresses separated by commas for sending email notification.

By default, the mail server is not configured by the JasperReports Server installer. To send email
notifications, the administrator must configure the mail server, as described in the JasperReports
Server Installation Guide.

• Subject – The subject line of the notification email.
• Send success notification – Check box option that, when checked, sends a notification when the

scheduled report runs.
• Success Message – The message in the body of the notification email sent on success.
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• Send failure notification – Check box option that, when checked, sends a notification when the
scheduled report fails to run.
• Failure Message – The message in the body of the notification email sent on failure.

• Include report job information – A check box option that, if selected, includes the report label, ID,
description, and report job status in the notification email.

• Include stack trace – A check box option that, if selected, includes the stack trace for failed jobs in the
body of the email.

Figure 3-20 Notifications Page for Scheduling a Report

3.9.4 Viewing the List of Scheduled Jobs

View a list of all scheduled jobs:

All scheduled jobs that the user has defined appear on the Click View > Schedules page.

Figure 3-21 The Scheduled Jobs Page for a Report
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Typical users see only the jobs they have defined; administrators see the jobs defined by all users. In Figure 3-
21, jasperadmin has scheduled two jobs for the Geographic Results by Segment report.

You can use the Schedules page's search field to find the scheduled job you want.

The Schedules page shows the name of the scheduled report, the repository URI of the report, the internal ID
number of the job, the user (owner) who created the job, and the state of the job. Job states are:
• NORMAL – The job is scheduled.
• EXECUTING – The server is generating the report output.
• COMPLETE – The server has finished running the job and placed output to the repository.
• PAUSED– The job has been disabled. Click Enabled to resume the schedule.
• ERROR – The scheduler encountered an error while scheduling or triggering the job. This doesn’t include

cases where the job is successfully triggered, but an error occurs while it runs.
• UNKNOWN – The scheduler encountered an error with the job trigger.

The Schedules page includes these controls:
• Enabled checkbox – When checked, the job will run at the scheduled times. When unchecked, the job is

paused.

• – Edits the schedule.

• – Deletes the scheduled job.
When the server receives a request to delete a job that is running, the server completes running the job
before deleting it.

View scheduled jobs for an individual report:

Scheduled jobs appear in the repository with a icon beside the report name. To view the list of scheduled

jobs for a report, locate a report in the repository, click on the icon or right-click the report, and select
Schedule from the context menu. The Scheduled Jobs page appears for the report. The Scheduled Jobs display
information on the report that's similar to the Schedules page.

You can filter search results for scheduled reports in the repository using the following options: Any
schedule (scheduled and unscheduled reports), Scheduled, Scheduled by me, or Not scheduled. See
1.5.2, “Filtering Search Results,” on page 18 for more information.

Buttons on the Scheduled Jobs page include:

Button Description

Back Returns to the list of reports.

Schedule Job Opens the Schedule tab to define a new job.

Run Now Opens the scheduler and allows you to run the job immediately. See “Running a Job in
the Background” on page 81.

Refresh List Refreshes the list of jobs, for example to see if a job has finished running.
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3.9.5 Changing Schedules
If the start date for a schedule has not yet passed, you can edit the schedule. Once the start date for a schedule
has passed, create a new schedule rather than changing the start date.

To edit a schedule:
1. Click View > Schedules.

2. Click in the row of the job you want to change.
3. Make the changes on the Schedule, Parameters, Output, and Notifications pages.
4. Click Save. The update occurs immediately.

3.9.6 Pausing a Job
To stop a job from running without deleting it, disable the job.

To pause a scheduled job:
1. Click View > Schedules.
2. In the row of the job you want to stop, make sure Enabled is unchecked.

To resume a paused job:
1. Click View > Schedules.
2. In the row of the job you want to resume, make sure Enabled is checked. When a stopped job is re-

enabled, it waits until the next scheduled time to run.

3.9.7 Deleting a Job

To delete a scheduled job:
1. Click View > Schedules.
2. In the row of the job you want to delete, click .

3.9.8 Running a Job Repeatedly
To run reports automatically on a regular basis, select simple or calendar recurrence on the Schedule tab:
• Simple recurrence repeatedly runs the job at a regular interval set in minutes, hours, days, or weeks.
• Calendar recurrence involves more settings: time of day, days of the week, or days of the month, and

months of the year.

In Figure 3-22 you can see an example of how to set simple recurrence.
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Figure 3-22 Simple Recurrence Settings

Simple recurrence options are:
• Repeat every – The interval between jobs, in minutes, hours, days, or weeks.
• Run a set number of times – Runs the specified number of times.
• Run until a specified date – Runs until a calendar date is reached. Click the calendar icon, , to

select the date.
• Run indefinitely – Runs at the specified times until you delete the job.
• Holidays – A holiday calendar specifies a list of days when the scheduled report will not run. To use a

holiday calendar, select it from the drop-down list. Only one holiday calendar can be selected at a time.
Holiday calendars are configured by an administrator; if no calendars are available in this list, this
option has not been configured for your system.

If your server recognizes Daylight Savings Time (DST), jobs scheduled using simple recurrence may
seem to occur one hour later (when DST ends) or one hour earlier (when DST begins). If you want
jobs to recur at the same time of day and respect DST adjustments, use calendar recurrence.
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If you set up a job with simple recurrence to start immediately, the job schedule will change after
export/import. This happens because the imported job does not retain the previous run history and
therefore starts immediately after successful import. To ensure a recurring schedule does not change
after export/import, either use simple recurrence with a specific start time, or set up calendar
recurrence.

In Figure 3-23 you'll see an example of calendar recurrence settings.

Figure 3-23 Calendar Recurrence Settings

Calendar recurrence options are:
• Months – The months during which the report runs.

• Every Month
• Selected Months
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• Days – The days when the report runs.
• Every Day
• Selected Days
• Dates in Months – Enter dates or date ranges separated by commas, for example: 1, 15.

• Times – The time of day in minutes and hours when the job should run. The hours use 24-hour format.
You can also enter multiple minutes or hours, and ranges, separated by commas. For example, entering
0,15,30,45 for the minutes, and 9-17 for the hours, runs the report every 15 minutes from 9:00 a.m. to
5:45 p.m. Enter an asterisk (*) to run the job every minute or every hour.

• End Date – Calendar recurrence runs until a calendar date is reached. Click to select the date.
• Holidays – A holiday calendar specifies a list of days when the scheduled report will not run. To use a

holiday calendar, select it from the drop-down list. Only one holiday calendar can be selected at a time.
Holiday calendars are configured by an administrator; if no calendars are available in this list, this option
has not been configured for your system.
Administrators see the chapter on scheduling in the JasperReports Server Web Services Guide for more
information on configuring calendars.

3.9.9 Running a Job in the Background
Running a job in the background generates a report, potentially long-running, without interrupting your
workflow. You can keep working in the server as the job runs. When the job completes, you can export the
report directly to any format and save it in the repository. You can share a report with others by sending the
generated report by email.

Running a job in the background is equivalent to scheduling the report to run immediately without recurrence.

To run a job in the background:
1. On the Home page, click View Your Reports; or from any page, click View > Reports.
2. Use the search field or Filters to find the report you want to run.
3. Right-click the report and select Run in Background from the context menu.

The Output page appears as shown in Figure 3-18.
4. Set the output format and location, as described in Setting Output Options. By default, the report output is

saved in the repository.
5. (Optional) If the report you are running has input controls that prompt for user input, click the Parameters

tab. Choose a set of saved values, or set the fields one at a time.
6. (Optional) Click the Notifications tab and set up email notifications, as described in Setting Up

Notifications
7. Click Save. The report begins to run immediately.

3.9.10 Event Messages
When an event occurs (for example, a scheduled report returns errors), JasperReports Server sends the owner of
the report a notification message. You can browse these messages to troubleshoot report scheduling problems in
the server. For example, you can determine that a report fails because its data source configuration uses incorrect
credentials.
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A common cause of the error message indicating that the report failed to execute is an incorrectly
configured mail server. The mail server must be manually configured after installation in order for users to
send email notifications.

The Messages page displays the list of events logged for the current user.

To open the Messages page:
1. On any page, click View > Messages. The Messages page appears.
2. To view a message, click its name. The message opens in the Event Details page.
3. To activate the buttons on the Messages page, click in a blank area of the message row that you want to

manage. The buttons appear.

Figure 3-24 Message Management Buttons

4. Use the buttons on the Messages page to manage the list of messages.
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This section describes functionality that can be restricted by the software license for JasperReports Server.
If you don’t see some of the options described in this section, your license may prohibit you from using
them. To find out what you're licensed to use, or to upgrade your license, contact Jaspersoft.

The Ad Hoc Editor is the interactive designer for creating and editing an Ad Hoc view, where you can explore
and analyze data from your Topic, Domain, or OLAP data source. Ad Hoc views can also be used to create
content for reports.

This chapter discusses the Ad Hoc Editor and Ad Hoc views, and includes the following sections:
• Overview of the Ad Hoc Editor
• Working with Tables
• Working with Charts
• Working with Standard Crosstabs
• Working with OLAP Connection-based Crosstabs
• Calculated Fields and Measures
• Using Filters and Input Controls
• Creating a View from a Domain
• Working with Topics

After you create an Ad Hoc view, you - and other users with the proper permissions - can run the report, then
further refine the displayed information and personalize the look of the report in the report viewer. For more
information on that process, see “Running Reports and the Report Viewer” on page 49.

4.1 Overview of the Ad Hoc Editor
The Ad Hoc Editor supports the creation of views for various types of reports: tables, crosstabs, and charts. You
intuitively interact with the editor to create these views by simply dragging and dropping elements. You can
add and summarize fields, define groups, label and title the report, and format data for each field. You can also
use the editor to explore and analyze data interactively.

To open the Ad Hoc Editor:
1. Click Create > Ad Hoc View. This opens the Select Data dialog.
2. Choose your data source from the list and click OK.
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Figure 4-1 List of Data Sources in the Select Data Dialog

The Ad Hoc Editor contains the following panels, from left to right:
• Data Source Selection, which contains the fields, dimensions, and measures available in the source

Domain, Topic, or OLAP connection.
• Ad Hoc View, the main view design panel.
• Filters, which defines a subset of data to retrieve from the data source.

We’ll discuss how to use these panels to create an Ad Hoc view later in this section.

4.1.1 Ad Hoc Sources: Topics, Domains, and OLAP Connections
The following repository objects provide a prepared connection to a data source for Ad Hoc view creation:
• Topics, JRMXL files created externally and uploaded to JasperReports Server as a basis for Ad Hoc views.
• Domains, virtual views of a data source that present the data in business terms, allow for localization, and

provide data-level security.
• OLAP Connections, multi-dimensional views of data that allow users to analyze a large number of

aggregate data levels.

You can also open and edit an existing Ad Hoc view to create a new Ad Hoc view.

4.1.1.1 Topics

Generally, an administrator or Jaspersoft Studio user creates a Topic as a JRXML file. The JRXML topic is then
associated with a data source in the server. A Topic can also be created from a Domain in the server. Both types
of topics appear in the Select Data wizard when you create an Ad Hoc view.

Using a Topic as your source generates an empty view, which allows you to begin adding data to your view
right away, without choosing, pre-filtering, or changing display names of the data (all of which are required
steps when creating a Domain-based view).
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To begin designing a Topic-based view:
1. Launch the Ad Hoc Editor by clicking Create > Ad Hoc View.

2. In the Select Data wizard, click and navigate to Ad Hoc Components > Topics.
3. Expand the Topics folder and select a topic.
4. Select the type of view you intend to create: table, chart, or crosstab. For an overview of view types, see

“Ad Hoc View Types” on page 86.

You can now begin working on your view in the Ad Hoc Editor.

4.1.1.2 Domains

Administrators create Domains that typically filter the data, create input controls, and manage the list of
available fields and measures. A Domain specifies tables in the database, join clauses, calculated fields, display
names, and default properties, all of which define items and sets of items for creating Ad Hoc views.

To begin designing a Domain-based view:
1. Launch the Ad Hoc Editor by clicking Create > Ad Hoc View.

2. In the Select Data wizard, click and navigate to Domains.
3. Expand the Domains folder and select a domain.
4. Click Choose Data..., and click the options on the left of the window to perform the following tasks:

• Click Fields to select fields of data to use in the view.
• Click Pre-filters to create filters to limit the data available in the Ad Hoc Editor.
• Click Display to change the fields’ display names.
• Click Save as Topic to save the customized topic for later use.

5. Select the type of view you want to create: table, chart, or crosstab. For an overview of view types, see “Ad
Hoc View Types” on page 86.

You can now begin working on your view in the Ad Hoc Editor.

4.1.1.3 OLAP Connections

Administrators create OLAP client connections that expose transactional data and define how the data can be
seen as a multidimensional cube. An OLAP connection can expose multiple cubes in a single OLAP
connection.

With OLAP connections, you can create chart and crosstab views only.

To begin designing an OLAP connection-based view:
1. Launch the Ad Hoc Editor by clicking Create > Ad Hoc View.

2. In the Select Data wizard, click and navigate to Analysis Components > Analysis Connections
and select a sample project and a connection.

You can now begin working on your view in the Ad Hoc Editor.

For more information about OLAP-based view functionality, refer to the following sections:
• “Working with OLAP Connection-based Crosstabs” on page 115
• “Working with Topics” on page 151
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4.1.2 Ad Hoc View Types
The Ad Hoc Editor allows you to select from three view types:
• Tables, which are used to view values in the database and to summarize the values in columns.
• Charts, which compare one or more measures across multiple sets of related fields.
• Crosstabs, which aggregate data across multiple dimensions.

This section provides an overview of each view type. The design and content tasks for working with each type
of view are discussed in more detail in the following sections:
• For more information on table views, see Working with Tables.
• For more information on chart views, see “Working with Charts” on page 97.
• For more information on crosstab views, see “Working with Standard Crosstabs” on page 112.

4.1.2.1 Tables

The architecture of a table view consists of columns, rows, and groups.

Columns in a table correspond to the columns in the data source. They are included by adding fields or
measures to the table in the Ad Hoc view.

Rows correspond to rows in the database. The information in each row depends on what columns are included
in the table.

Using groups, rows can be grouped by identical values in any field with intermediate summaries for each
grouped value. For example, a table view of product orders might contain columns to show the dates and
amounts of each order, and its rows might be grouped by city and product.
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Date Placed Date Filled Payment Received

City A

Product 01

Date Date Amount

Date Date Amount

Product 01 totals: Count Sum

Product 02

Date Date Amount

Date Date Amount

Product 02 totals: Count Sum

Product 03

Date Date Amount

Date Date Amount

Product 03 totals: Count Sum

City A totals: Count Sum

City B

Product 01

Date Date Amount

Date Date Amount

Date Date Amount

... ... ...

For more information on working with tables, see “Working with Tables” on page 92.

4.1.2.2 Charts

Charts summarize data graphically. Types of charts include bar chart, line chart, and pie chart, among others.
With the exception of time series and scatter charts, each type of chart compares summarized values for a group.
For example, the Chart tab might show the data in a bar chart that compared the sum of Payments Received for
each of the products in each of the cities.
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Total Payments Received

City A City B City C

Time series and scatter charts use time intervals to group data.

For more information on working with charts, see “Working with Charts” on page 97.

4.1.2.3 Crosstabs

Crosstabs are more compact representations than tables; they show only aggregate values, rather than individual
database values. Columns and rows specify the dimensions for grouping; cells contain the summarized
measurements. For instance, the example above could be displayed in a crosstab with columns grouped by sales
manager and year.
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Tom Harriet Manager
Totals

2012 2013 Year Totals 2012 2013 Year Totals

City A Product 01 Payment
Received

Payment
Received

Payment
Received

Payment
Received

Payment
Received

Payment
Received

Payment
Received

Product 02 Payment
Received

Payment
Received

Payment
Received

Payment
Received

Payment
Received

Payment
Received

Payment
Received

Product 03 Payment
Received

Payment
Received

Payment
Received

Payment
Received

Payment
Received

Payment
Received

Payment
Received

Product
Totals

Payment
Received

Payment
Received

Payment
Received

Payment
Received

Payment
Received

Payment
Received

Payment
Received

City B Product 01 Payment
Received

Payment
Received

Payment
Received

Payment
Received

Payment
Received

Payment
Received

Payment
Received

... ... ... ... ... ... ... ...

City Totals Payment
Received

Payment
Received

Payment
Received

Payment
Received

Payment
Received

Payment
Received

Payment
Received

For more information on working with crosstabs, see “Working with Standard Crosstabs” on page 112.

OLAP connection-based crosstabs behave differently than those created from Topics or Domains. See “Working
with Topics” on page 151.

4.1.3 The Data Source Selection Panel
The Data Source Selection panel contains a list of available fields in the chosen Topic or Domain. If you are
using a Domain, fields may appear in nested sets. Use the arrow beside the set name to expand or collapse a set
of fields.

Available fields may be divided into two sections in the panel, Fields and Measures. You can use the search
field in each section to locate a specific field or measure.

To hide this panel, click the icon in the top left corner; this is helpful when arranging content in a large Ad
Hoc view. Click the same icon on the minimized panel to expand it.

For more information on working with fields, see “Using Fields in Tables ” on page 92, “Using Fields and
Measures in Charts” on page 97, and “Using Fields in Crosstabs” on page 112.

4.1.4 The Ad Hoc View Panel
The Ad Hoc View panel provides tools that allow you to control what data is included in a view, and how it is
organized.

Along the top of the panel, there is a tool bar and two drop-down menus.

The first drop-down menu allows you to reset the view type. Use this menu to select Table, Chart, or
Crosstab. You can change the view type in the Ad Hoc Editor during the design or when you reopen the
design for editing.

The next drop-down menu contains options for displaying a subset of the available data (Sample Data), all
available data (Full Data), or none of the available data (No Data) in the view. Using the sample data can
make the design process quicker by loading less data. Use the subset for initial design; use the full set for
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refining layout elements such as column width. This drop-down menu is not available for charts, which use all
available data.

By default, the editor displays only a smaller, sample set of the data in the table. Use the drop-down menu to
select Full Data to view the full set of data.

Depending on its configuration, JasperReports Server may load a Topic, Domain, or OLAP connection’s
entire result set into memory when you edit the view, or run a report from it. If the data policies and other
options that control JasperReports Server’s memory are disabled, ensure that each Topic, Domain, or
OLAP connection returns a manageable amount of data, given the environment’s load capacity.
Alternately, you can change the server’s configuration.

The tool bar at the top of the panel provides access to many functions of the Ad Hoc Editor. The toolbar is
described in Table 4-1 on page 90.

Icon Name Description

Display
Mode

Click this icon to hide the editor interface. This mode provides a subset of the
editor’s full feature set.

Save Place the cursor over this icon to open a menu of save options.

Export Place the cursor over this icon to open a menu of export options.

Undo Click this icon to undo the most recent action.

Redo Click this icon to redo the most recently undone action.

Undo All Click this icon to revert the view to its state when you last saved.

Switch Group Click this icon to change the way groups are displayed. For more information, refer
to “Creating a View from a Domain” on page 146.

Sort When working with tables, click this icon to view the current sorting and to select
fields for sorting data. For more information, refer to “Sorting Tables” on page 95

Input
Controls

Click this icon to see the input controls applied to this view. For more information,
refer to “Using Input Controls” on page 143.

Page
Options

Place the cursor over this icon to open a menu of page-level options. You can:

• Change whether to display the Layout Band.
• Change whether to display the title area.
• In tables, you can also hide or show the detail rows when the data is

summarized. This option is available only if the table includes grouped columns.
• In crosstabs, you can merge or unmerge cells with the same data.

Table 4-1 Ad Hoc Editor Tool Bar Icons
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Icon Name Description

View
SQL/MDX
Query

For more information on viewing SQL queries, see “Viewing the SQL Query” on
page 91

For more information viewing MDX queries, see “Viewing the MDX Query” on
page 117

4.1.4.1 The Layout Band

Directly beneath the tool bar is the Layout Band. Here there are two fields. These fields have different labels
and functions, depending on the type of view you are creating:
• For tables, these fields are Columns and Groups.
• For charts, these fields are Columns and Rows.
• For crosstabs, these fields are Columns and Rows.

You can drag and drop fields and measures into these boxes to populate your view.

4.1.4.2 Managing Canvas Options

When working with a table or chart view, the Canvas Options selector appears below the Layout Band, to the
left of the view title. This tool allows you to control the level of detail displayed in your table or chart. Click

to display the options available for your Ad Hoc view type.

For tables, the Canvas Options selector includes the following options:
• Detailed Data displays table detail only.
• Totals Data displays table totals only.
• Details and Totals displays both details and totals.

For charts, the Canvas Options selector includes the following options:
• Chart Types displays the available chart types.
• Chart Format displays formatting options.

4.1.4.3 Viewing the SQL Query

You may want to look at the SQL query for your view, to verify what data users are hitting. If you have the
proper permissions, you can do this in the Ad Hoc Editor with the View Query button.

The query is read-only, but can be copied onto a clipboard or other document for review.

To view the SQL query:

• In the tool bar, click .

The View Query window opens, displaying the SQL query.

4.1.5 The Filters Panel
The Filters panel displays any filters defined for the view. You can set the filter values and see the resulting
change in the Ad Hoc View panel. To hide the Filters panel, click the icon in the top left corner of the panel.
Click the same icon on the minimized panel to expand it again.

For more information on working with filters, see “Using Filters and Input Controls” on page 139.
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4.1.6 Saving an Ad Hoc View, Previewing and Creating a Report
After you create a compelling table, chart, or crosstab, you can save the view in the repository for future use.

To save an Ad Hoc view:

1. Hover your mouse over .
2. Select Save Ad Hoc View or Save Ad Hoc View As.
3. Name the view as needed, and click Save. The view is saved in the repository.

You can also save an Ad Hoc view as a report. Typically, a report is created when you want to:
• See data in the interactive report viewer.
• Perform additional formatting of the table data.
• Embed the data content in a dashboard.

Create a report from the view by selecting Save Ad Hoc View and Create Report; you can also create and
run a report directly from the repository. For more information, see “Running or Creating a Simple Report” on
page 52. When you run the report, it is displayed as a JasperReport.

4.1.6.1 Dependent Reports

When you create a report from an Ad Hoc view, the report is considered “dependent” on that view.

When you save an Ad Hoc view its dependent reports are not updated. For example, if you open an Ad Hoc
view in the Editor and add a column to it, that column will not show up in previous reports created from that
view. In such a case, you may want to save the updated view with a different file name to avoid confusion.

4.2 Working with Tables
The following sections explain how to populate, edit, and format your table-type view.

4.2.1 Using Fields in Tables
Insert data into your table by adding fields. All available fields are listed in the Data Source Selection panel,
on the left side of the Ad Hoc Editor.

The available fields are divided into two sections in the panel:
• Fields, which can be added to the table as columns or groups.
• Measures, which are specialized fields that contain data values.

To add fields and measures as columns to a table:
1. In the Data Source Selection panel, click to select the field or measure you want to add to the table. Use

Ctrl-click to select multiple items.
2. Drag the selected item into the Columns box in the Layout Band.

The field is added to the view as a column in the table.

To remove a field or measure from a table:
• In the Layout Band, click the x next to the field or measure’s name.
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4.2.1.1 Groups

Groups allow you to create detailed data rows. For example, if you have a table that lists the suppliers for a
national restaurant chain, you can group the suppliers by the State field. The suppliers’ names are then
rearranged so that all suppliers located in Maine, for instance, are located under a “Maine” header row; suppliers
in Maryland are together under a “Maryland” header row, and so on.

You can use multiple fields to make more specific nested groups. By adding a group based on the “City” field
to the table described above, the restaurant suppliers are arranged by City within the State groups. Under the
“Maine” header row, new header rows for Augusta, Bangor, and Portland are added, and the names of the
Maine-based suppliers appear under their respective cities. Under the “Maryland” header row, header rows for
Annapolis, Baltimore, and Silver Spring are added, and the names of Maryland-based suppliers appear under
those headers, and so on.

Only fields can be applied to a table as a group; measures cannot.

Data is grouped in the table according to the order they have defined. You can change the order by dragging
the groups into position if needed.

To create a group:
1. In the Data Source Selection panel, click to select the field you want to add to the table as a group.
2. Drag the field to the Groups box in the Layout Band.

The Ad Hoc view refreshes and displays the data grouped under a new header row.

You can also add a group to the table by right-clicking a field and selecting Add as Group.

To remove a group:
• In the Layout Band, click the x next to the field’s name in the Groups box.

To move a the grouping order up or down in a table:
• In the Layout Band, drag the name of the group you want to move into its new position.

4.2.1.2 Summaries

You can display summary data for any column in your table. Summary data may be in the form of various
functions, such as:
• Sum
• Count
• Distinct Count
• Average

For example, in a table with a list of stores, grouped by City and Country, you can display the number of stores
in each City, and in each Country, using this function.

By default, the summary function for each field is defined by the data source, OLAP, or domain definition.

To add a summary to a specific column:
• In the table, right-click the column you want to calculate a summary for, and select Add Summary.

The summary information is added to the group header, or is added to the bottom of a column if no groups
are included in the table.
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To remove a summary from a specific column:
• In the table, right-click the column with the summary you want to remove, and select Remove Summary.

The summary information is removed from the table.

To add or remove summaries from all columns:

• Click and select Detailed Data.

4.2.1.3 Column and Header Labels

You can edit a column or header label directly in the Ad Hoc Editor.

To edit a column or header label:
1. On the Ad Hoc view panel, right-click the column or group header you want to rename.
2. Select Edit Label from the context menu. The Edit Label window opens.
3. In the text entry box, delete the existing name and enter the new name.
4. Click Submit.

If space is at a premium, you can remove labels from the view. When you delete a label, it still appears when
you look at the view in the Ad Hoc Editor, but does not appear when you run the report.

To delete a column or header label:
1. On the Ad Hoc view, right-click the column or header label you want to remove.
2. Select Delete Label from the context menu.

To re-apply a label:
1. Right-click the column or header label you want to replace.
2. Select Add Label from the context menu. The Edit Label window opens.
3. Enter the label name, if needed.
4. Click Submit.

4.2.1.4 Managing Column Size and Spacing

You can change the size of, and spaces between, columns to manage the appearance of your table or use space
more efficiently.

To resize a column:
1. In the Ad Hoc View panel, click to select the column you want to resize.
2. Move the cursor to the right edge of the column.
3. When the cursor changes to the resize icon ( ), click and drag the column edge right or left until the

column is the needed size.

Spacers can be added to a table to arrange columns farther apart, or add margins to a table.

To change the spacing between columns:
1. In the Data Source Selection panel, in the Measures section, click Spacer.
2. Drag the spacer into the Columns box in the Layout Band between names of the two columns you want

to move apart.

A spacer column, labeled , appears in the table.
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3. Repeat this action to add space as needed between columns.
4. To remove a spacer, right-click the spacer column and select Remove from Table.

To use spacers to create table margins:
1. In the Data Source Selection panel, click to select Spacer.
2. Drag the spacer into the Columns box in the Layout Band.
3. Repeat until the margins are as wide as needed.
4. Repeat the steps above, adding the spacer to the right edge of the table.

4.2.1.5 Reordering Columns

You can move columns to the right or left to reorder data in your table.

To reorder a column:
1. In the Ad Hoc View panel, right-click the column you want to move.
2. Select Move Right or Move Left from the context menu.

4.2.1.6 Sorting Tables

In the Ad Hoc Editor, you can sort the rows of a table by any field, using a number of different methods.

To sort a table:

1. Click . The Sort window appears. If the table is already sorted, the window shows the fields used.
2. To add a field to sort on, double-click the field in Available Fields. The Available Fields panel now lists

only fields not currently in Sort On.
3. Select one or more fields to sort by. You can also use Ctrl-click to select multiple fields.

4. Click .
5. To arrange the sorting precedence of the fields, select each field in the Sort window and click Move to top,

Move up, Move down, or Move to bottom: , , , and .

6. To remove a field, select it and click .
7. Click OK. The table updates to display the rows sorted by the selected fields.

You can also sort a table using the following methods:
• Right-click a field in the Fields section of the Data Source Selection panel, and select Use for Sorting

from the context menu. In this case, the table is sorted by a field that isn’t in the table; you may want to
note the sorting fields in the title.

• Right-click a column header on the Canvas of the Ad Hoc View panel, and select Use for Sorting from
the context menu.

If a column is already being used and you want to stop using it or change the sorting, right-click the
column and select Change Sorting from the context menu.
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4.2.1.7 Adding a Title
1. Above the table, click the text Click to add a title.
2. Enter the new table title in the text entry box.

4.2.1.8 Changing the Data Format

You can change the formatting for columns containing numeric data, such as dates and monetary amounts.

To change the data format for a column:
1. In the Ad Hoc view, right-click the column.
2. Select Change Data Format from the context menu.
3. Select the format you want to use. These options vary, depending on the type of numeric data contained in

the column.
The data in the column now appears in the new format.

4.2.1.9 Changing the Data Source

You may need to select a new data source for your table. This is a simple task, but you should keep in mind
that all view data and formatting are lost when you select a new Topic, Domain, or OLAP connection. Any
changes to the view are also lost if you navigate to another page using the browser navigation buttons, the main
menu, or the Search field. To preserve changes, accept the current Topic or click Cancel.

To change the table’s data source:
1. At the top of the Data Source Selection panel, click and select Change Source.
2. Select a different Topic, Domain, or OLAP connection.
3. Click Table to apply the new data source.

Click Cancel to return to the editor without changing the Topic.

4.2.1.10 Showing and Hiding Detail Rows

You can simplify or expand the information in your table by hiding or showing detail rows.

To hide detail rows in a table:

1. Place the cursor over .
2. Select Hide Detail Rows to show only the summarized totals for each group.

The Ad Hoc Editor applies a summary to each field depending on its datatype.

To show detail rows in a table:

1. Place the cursor over .
2. Select Show Detail Rows to display the detailed information for each group.

The Ad Hoc Editor displays the complete information in each row.

4.2.1.11 Controlling the Data Set

You can control the data displayed in the grid using the Grid Detail Selector:

Your options are:
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• Detailed Data, which displays table detail only. For instance, in a table listing sales in dollars for all stores
in a region for a given month, the amount sold by each store that month is displayed.

• Totals Data, which displays the table totals only. In the table described above, the total amount of all sales
at all regional stores that month is displayed.

• Details and Totals, which displays both the individual store sales numbers, as well as the total sales
numbers at the bottom of the store sales column.
Click to select the option you want to apply to your table.

4.3 Working with Charts
Ad Hoc charts are a flexible, interactive way to explore your data graphically. You can choose different levels
of aggregation for rows and columns, change a field from a column to a row, pivot the entire chart, hide chart
values, and zoom in to see chart details.

The following sections explain how to populate, edit, and format an Ad Hoc chart. Many tasks related to
working with charts are identical (or very similar) to those for tables and crosstabs. For any tasks not discussed
in this section, see the information in “Working with Tables” on page 92.

4.3.1 Using Fields and Measures in Charts
You must add at least one measure to view a chart. Before any measures are added to the chart, the Ad Hoc
Editor displays a placeholder with the legend displaying a single entry: Add a measure to continue. As you add
measures, the editor displays the grand total of each measure in the chart.

The initial display reflects only the measures you add; it does not change when you add fields or dimensions.
For example, for each measure you add to a bar chart, you see a bar with the total value of the measure,
regardless of how many fields you add. This means you can add, remove, and arrange measures and fields
without waiting for the display to update. Once you have the fields and measures you want, you can use the
sliders on the right to select the level of detail you want. See Figure 4-2 for more information.

All available fields are listed in the Data Selection panel, as either standard fields or measures.
• Standard fields can be added to a column or a row.
• Measures contain summarized values. They are typically numeric fields that determine the length of bars,

size of pie slices, location of points (in line charts), and height of areas. They can be added to rows or
columns, but must all be in the same target — that is, you can add one or more measures to the chart as
columns, or add one or more measures to the chart as rows, but you cannot have one measure as a column
and another as a row in the same chart.

When creating a chart, keep in mind that row and column groups are arranged in hierarchies, with the highest
member of the hierarchy on the left. For an Ad Hoc view based on an OLAP data source, you can change the
order of distinct dimensions by dragging, but you cannot change the order of levels within a dimension. For an
Ad Hoc view based on a non-OLAP data source, you can drag the field headings to rearrange the hierarchy; the
highest level in a group should appear to the left; the lowest level in a group should appear to the right. For
example, it doesn’t make sense to group first by postal code then by country, because each postal code belongs
to only one country.

To add a field or measure to a row or column:
1. In the Data Selection panel, select the field you want to add to the chart as a group. Use Ctrl-click to

select multiple items.
2. Drag the selected item into the Columns or Rows box in the Layout Band.
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4.3.1.1 Setting Levels

When you add a field or dimension to a column or row, a multi-level slider located at the top of the Filters pane
allows you to set the level of aggregation to use for viewing the data. The number of fields or dimensions in the
row or column determines the number of levels on the slider. Measures are not reflected in the slider.

You cannot adjust levels on time series charts.

The following figure shows the effect of the slider on a chart with one level of aggregation for both rows and
columns.

Columns Columns

Rows

Rows

Figure 4-2 Effect of the Slider on a Chart

To recreate this view:
1. Select Create > Ad Hoc View.
2. In the Select Data wizard, select foodmart data for crosstab and click OK.
3. Drag the following from the Fields panel to the Layout Band:

• Store Sales from Measures to Columns. The view changes to show a column with the total. No slider
is added for measures.

• Product Family from Fields to Columns. The Data Level area is shown in the Filters panel, with a
Columns slider added.

• Date from Fields to Rows. A Rows slider is added to the Data Level area in the Filters panel.
4. Use the sliders to see how the view changes.

The sliders help you explore your data visually in a number of ways:
• The slider reflects the hierarchy of the row or column groups, as determined by the order in which fields are

arranged in the Layout Band.
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• Hovering over a setting on the slider shows the name of the field or dimension corresponding to that
setting.

• When you pivot a chart, slider settings are preserved and applied to the new target. For example, if you
have the Row slider set to Month, the Column slider is set to Month when you pivot. See “Pivoting a
Chart” on page 99 for more information.

• When you remove the currently selected level from a row or column, the slider is reset to the total; when
you remove a field that is not selected, the level remains the same. When you add a field or dimension to a
row or column, the number of levels of the slider changes to reflect your addition. When you change the
order of the fields in a row or column, the level on the slider changes to reflect the new level of the field
corresponding to the selection.

4.3.1.2 Changing Date Grouping

If your chart includes data based on a date field, you can change the level of aggregation for the time data. To
select the unit of time to chart:
• Right-click on the date field in the Layout Band and select Change Grouping. Then select the time

period you want from the cascading submenu. The view updates to reflect the new date grouping.

Time Series charts can use only day, or smaller, intervals.

4.3.1.3 Changing the Summary Function of a Measure

You can get a new view of your data by changing the summary function of a measure, for example, from sum to
average. To select a new summary function for a measure:
• Right-click on the measure in the Layout Band and select Change Summary Function. Then select the

function you want from the cascading submenu. The view updates to reflect the new summary function.

4.3.1.4 Pivoting a Chart

You can pivot a chart in two ways:

• Pivot the entire chart by clicking . The row and column groups switch places; slider levels are
maintained. The following figure shows the effect of pivoting a basic column chart.
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Figure 4-3 Effect of Pivoting a Chart

• Pivot a single group:
• To pivot a single row group, right-click it and select Switch To Column Group. You can also move

any field or dimension by dragging. You cannot drag a measure to a different group.
• To pivot a single column group, right-click it and select Switch To Row Group. You can also move

any field or dimension by dragging. You cannot drag a measure to a different group.

4.3.2 Selecting a Chart Type
Choose from multiple chart types to best represent your information, including:
• Column, which compares values displayed as columns.
• Bar, which compares values displayed as bars.
• Line, which compares values displayed as points connected by lines.
• Area, which compares values displayed as shaded areas.
• Spider, which compares three or more values on a series of spokes. Spider charts can use columns, lines, or

areas to display values.
• Dual- and Multi-Axis, which display values using two or more measures.
• Time Series, which compares time intervals displayed as points connected by lines. The Time Series chart

type is only available for non-OLAP charts.
• Scatter, which compares values as individual points arrayed across both axes of a chart.
• Bubble, which compares three measures displayed as circles of varying sizes arrayed across both axes of a

chart.
• Pie, which compares values displayed as slices of a circular graph.
• Range, which displays values as heat and tree maps. Only the Heat Map chart is available for OLAP data

sources.

By default, the Ad Hoc Editor creates a column chart. You can select a different type of chart at any time.

100 TIBCO Software Inc.



Chapter 4  Working with the Ad Hoc Editor

If you recently upgraded to JasperReports Server 5.5 or later you may find that existing scatter charts did
not update, and are incompatible with the newer software. You can use the Ad Hoc views for those scatter
charts to generate new reports, but you can't edit the views for scatter charts created in earlier versions of
JasperReports Server.

To select a new chart type:

1. In the Ad Hoc View panel, click the icon to show the Canvas Options menu.
2. Select Chart Types... from the menu. The Select Chart Type window is displayed.

Figure 4-4 Select Chart Type Window

3. Click the type of chart you want to apply to your report. The selected chart type is outlined in blue.

4. Leave the Select Chart Type window open to rapidly switch between chart types, or click the icon at
the top right to close it.

The following table describes the available chart types, and rules (if any) affecting their use:
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Icon Description Rules

Column charts Column charts compare values displayed as
columns.

Column. Multiple measures of a group are
depicted as individual columns.

Stacked Column. Multiple measures of a group
are depicted as portions of a single column
whose size reflects the aggregate value of the
group.

Percent Column. Multiple measures of a group
are depicted as portions of a single column of
fixed size.

Spider Column. Multiple measures of a group
are depicted as portions of individual "columns"
along a spoked chart.

Bar charts Bar charts compare values displayed as
bars.

Bar. Multiple measures of a group are depicted
as individual bars.

Stacked Bar. Multiple measures of a group are
depicted as portions of a single bar whose size
reflects the aggregate value of the group.

Percent Bar. Multiple measures of a group are
depicted as portions of a single bar of fixed size.

Line charts Line charts compare values displayed as
points connected by lines.

Line. Displays data points connected with
straight lines.

Spline. Displays data points connected with a
fitted curve.

Spider Line. Displays data points connected
with straight lines on a spoked chart.

Table 4-2 HTML5 Chart Types
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Icon Description Rules

Area charts

Area. Displays data points connected with a
straight line and a color below the line; groups
are displayed as transparent overlays.

Stacked Area. Displays data points connected
with a straight line and a solid color below the
line; groups are displayed as solid areas
arranged vertically, one on top of another.

Percent Area. Displays data points connected
with a straight line and a solid color below the
line; groups are displayed as portions of an
area of fixed sized, and arranged vertically one
on top of the another.

Area Spline. Displays data points connected
with a fitted curve and a color below the line;
groups are displayed as transparent overlays.

Spider Area. Displays data points connected
with straight lines and a solid color between the
line and the center of a spoked chart; groups
are displayed as transparent overlays.

Dual- and Multi-Axis
charts

You can compare two or more measures,
using one charting time or multiple charting
types, with the charts listed here.

Column Line. Displays leftmost measures as
bars, last measure as a line.

• Requires two or more
measures.

• Measures must be placed in
the Columns location.

• Fields and dimensions can
be placed only in the Rows
location.

Stacked Column Line. Displays leftmost
measures as stacked bars, last measure as a
line.

• Requires three or more
measures.

• Measures must be placed in
the Columns location.

• Fields and dimensions can
be placed only in the Rows
location.
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Icon Description Rules

Column Spline. Displays leftmost measures as
bars, last measure as a spline.

• Requires two or more
measures.

• Measures must be placed in
the Columns location.

• Fields and dimensions can
be placed only in the Rows
location.

Stacked Column Spline. Displays leftmost
measures as stacked bars, last measure as a
line.

• Requires three or more
measures.

• Measures must be placed in
the Columns location.

• Fields and dimensions can
be placed only in the Rows
location.

Multi-Axis Line. Displays each measure as a
separate axis line.

• Requires two or more
measures.

• Measures must be placed in
the Columns location.

• Fields and dimensions can
be placed only in the Rows
location.

Multi-Axis Spline. Displays each measure as a
separate axis spline.

• Requires two or more
measures.

• Measures must be placed in
the Columns location.

• Fields and dimensions can
be placed only in the Rows
location.

Multi-Axis Column. Displays each measure as
a separate axis column.

• Requires two or more
measures.

• Measures must be placed in
the Columns location.

• Fields and dimensions can
be placed only in the Rows
location.
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Icon Description Rules

Time Series charts Time Series charts illustrate data points at
successive time intervals.

Line. Displays date and time data points
connected with straight lines.

• Requires a single date/time
field in the Rows location.

• Field must be set to the
"day" group function.

Spline. Displays date and time data points
connected with a fitted curve.

• Requires a single date/time
field in the Rows location.

• Field must be set to the
"day" group function.

Area. Displays date and time data points
connected with a straight line and a color below
the line; groups are displayed as transparent
overlays.

• Requires a single date/time
field in the Rows location.

• Field must be set to the
"day" group function.

Area Spline. Displays date and time data points
connected with a fitted curve and a color below
the line; groups are displayed as transparent
overlays.

• Requires a single date/time
field in the Rows location.

• Field must be set to the
"day" group function.

Scatter charts Scatter charts show the extent of correlation
between the values of observed quantities.

Scatter. Displays first measure as the x-axis,
the second measure as the y-axis. Other fields
and dimensions in the column group become
data points.

• Requires exactly two
measures.

• Measures must be placed in
the Columns location.

Bubble charts Bubble charts show the correlation between
three measures, displayed as disks.

Bubble. Displays first measure as the x-axis, the
second measure as the y-axis, and the third
measure determines the size of the disk.

Pie charts Pie charts display values as slices of a
circular graph.

Pie. Multiple measures of a group are displayed
as sectors of a circle.

Dual Pie. Multiple measures of a group are
displayed as sectors of concentric circles.
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Icon Description Rules

Semi-Pie. Multiple measures of a group are
displayed as sectors of a half-circle.

Range charts Range charts display values heat maps.

Heat Map. Individual values represented as
colors.

Non-OLAP:

• One field, followed by one
Measure, required in the
Columns location.

• One field required in the
rows location.

OLAP:

• One Dimension level,
followed by one Measure,
required in the Columns
location.

• One Dimension level
required in the Rows
location.

Time Series Heat Map. Individual values
across dates/times represented as colors.

• One Measure required in
the Columns location.

• One Date/Time field
required in the Rows
location.

• Only available for non-OLAP
data sources.

Dual Measure Tree Map. Displays data as
color-coded rectangles; the size of each
rectangle is proportional to the first measure
and the color represents the second measure.

• Two Measures required in
the Columns location.

• One field required in the
Rows location.

• Only available for non-OLAP
data sources.

Tree Map. Displays data as rectangles; the size
of each rectangle is proportional to the measure
of the data it represents. The tree map displays
nested rectangles when you have more than
one field; the parent rectangle represents the
leftmost measure while the nested rectangles
represent the current level of aggregation. Click
on a parent rectangle to drill down to the nest
rectangles.

• One Measure required in
the Columns location.

• One or more fields required
in the Rows location.

• Only available for non-OLAP
data sources.
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Icon Description Rules

Parent Tree Map. Displays data as nested
rectangles; the size of each rectangle is
proportional to the measure of the data it
represents. The nested rectangles represent the
current level of aggregation while the larger
rectangle represents the parent level in the
hierarchy. Click on a parent rectangle to drill
down to the nest rectangles.

• One Measure required in
the Columns location.

• Two or more Fields required
in the Rows location.

• Only available for non-OLAP
data sources.

4.3.3 Formatting Charts
You can control some aspects of how data points, field names and labels are displayed on your chart, including:
• Whether data points are displayed.
• Showing a measure name on charts including only a single measure.
• Restricting the number of labels displayed.
• Rotating the direction of label text.

JasperReports Server also allows you to edit many of the chart's properties for cases when you want more
control over the appearance of a chart.

4.3.3.1 Displaying Data Points

You can choose whether to display data points in your line, time series, or area chart. Data points can help users
visualize chart data more accurately.

To show data points on a chart:

1. In the Ad Hoc View panel, click the icon to show the Canvas Options menu.
2. Select Chart Format... from the menu. The Chart Format window is displayed.
3. Click the Appearance tab and select Show data points on line charts.
4. Click Apply, then OK. The name appears along the value axis.
5. To remove data points from the chart, open the Appearance tab and deselect Show data points on line

charts.
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Figure 4-5 Chart Format Window

4.3.3.2 Displaying the Measure Name on the Value Axis

By default, in charts that include only a single measure, that measure's name is not displayed. For instance, if
your measure displays the number of employees for each store in the region, that measure's label appears along
the Y- (or value) axis, but the name of the measure ("Number of Employees" or similar) does not. You can,
however, choose to display that measure name to clarify the information on your chart.

To show a measure name on the value axis:

1. In the Ad Hoc View panel, click the icon to show the Canvas Options menu.
2. Select Chart Format... from the menu. The Chart Format window is displayed.
3. Click the Labels tab.
4. Select Show measure name on value axis.
5. Click Apply, then OK. The name appears along the value axis.
6. To remove a measure name, open the Labels tab and deselect Show measure name on value axis.

4.3.3.3 Restricting Label Display

By default, every field included in your chart has a label displayed along either axis. Measures will show up as
numeric values, often along the Y axis, and fields being measured will show up as text along the X axis. On
some charts - especially those with many included fields - these labels may overlap, crowd together, or become
difficult to read. You can alleviate this problem by "stepping," or reducing, the number of labels displayed on
your chart.

To reduce the number of labels on your chart:

1. In the Ad Hoc View panel, click the icon to show the Canvas Options menu.
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2. Select Chart Format... from the menu. The Chart Format window is displayed.
3. Click the Axis tab.
4. In the Interval between X-axis labels numeric entry box, specify how often you want the axis label to

appear. For instance:
• To display every second label, enter 2.
• To display every third label, enter 3, and so on.

5. Repeat this process in the Interval between Y-axis labels numeric entry box.
6. Click Apply, then OK. The labels appear as entered.
7. To display every label, open the Axis tab and enter 1 in the numeric entry boxes.

4.3.3.4 Rotating Label Text

By default, labels on your chart are displayed horizontally. Multiple labels, or very long ones, can be difficult to
read. You can change the direction of these labels, on both the X and Y axes, to improve chart readability.

To rotate label text:

1. In the Ad Hoc View panel, click the icon to show the Canvas Options menu.
2. Select Chart Format... from the menu. The Chart Format window is displayed.
3. Click the Axis tab.
4. In the Rotation of X-axis labels specify the degree of rotation to apply to labels. For instance:

• To rotate labels clockwise 90 degrees, enter 90.
• To rotate labels counter-clockwise 90 degrees, enter -90.
• To rotate labels clockwise 45 degrees, enter 45, and so on.

5. Repeat this process in the Rotation of Y-axis labels entry box for measures along the Y axis.
6. Click Apply, then Close. The labels are rotated.
7. To return the labels to their original, horizontal position, open the Axis tab and enter 0 in the numeric

entry boxes.

4.3.3.5 Changing the Chart's Appearance Using Advanced Formatting

The Advanced tab on the Chart Format window gives you more control over the appearance of an Ad Hoc
chart by allowing you to edit certain chart properties. For example, you can specify a list of colors for the chart,
change the position of the legend, choose whether to display data values in the chart, and much more. You can
find a full list of supported commands by clicking the More Information link on the Advanced tab or
browsing to the Advanced Chart Formatting page on the Jaspersoft Community Site.

To edit the chart's properties:

1. In the Ad Hoc View panel, click the icon to show the Canvas Options menu.
2. Select Chart Format... from the menu. The Chart Format window is displayed.
3. Click the Advanced tab.
4. Click Add New Property.
5. In the Property field, enter the chart property you want to format and then enter the value(s) for the

property. For instance:
• To format the chart's colors, enter colors for the property and a comma-separated list of colors in

brackets for the values, such as ["red", "blue", "green", "magenta", "purple", "black", "yellow"].
• To change the vertical alignment of the legend, enter legend.verticalAlign for the property and "top" or

"bottom" or "center" for the value.
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• To display data values on the chart, enter plotOptions.series.dataLabels.enabled for the property and
true for the value.

Click the More Information link to see a list of the properties you can edit.

The Ad Hoc Designer does not validate the property name or values. The chart will ignore any invalid
property you enter.

6. Click to save the property formatting.
7. Click Apply, then Close. The chart is updated with the new formatting.

8. To remove the formatting, open the Advanced tab and click next to the property you want to remove.

4.3.4 Interacting with Charts
Once you have chosen rows and columns and selected the type of chart you want, you can further explore your
data using interactive features such as brushing an area of the chart to zoom in or clicking on a legend to hide
the members of a group.

4.3.4.1 Zooming

Zooming lets you view a specific area of a chart more closely. Zooming can also be helpful when the labels at
the bottom of a chart are difficult to read, because only the labels corresponding to the selected area are
displayed.

Zoom is a viewing feature of the Ad Hoc Editor. When you save an Ad Hoc view, or create a report from an
Ad Hoc view, the zoom is automatically reset to show the whole chart.

To zoom in on an area of a chart:
• Click and drag or brush the area you want to zoom in on. As you are dragging or brushing a pale blue area

indicates your selection. When you release the mouse button, the view zooms in on the area you selected.

To view the whole chart again:
• Click Reset zoom at the upper right of the canvas.

The following images show a bar chart before and after zooming:
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Figure 4-6 Selecting a Zoom Area

Figure 4-7 Area After Zooming

4.3.4.2 Hiding Group Members

Use the legends below the chart to hide or show group members.
• To hide a group member, click the member name in the legend below the chart. The member is removed

from the chart and the legend is grayed out.
• To unhide a group member that has been hidden, click the grayed-out legend for the member.
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Figure 4-8 Hiding a Group Member

Hidden members are a view feature of the Ad Hoc Editor. When you save an Ad Hoc view, or create a
report from an Ad Hoc view, the chart is automatically reset to show all members.

4.4 Working with Standard Crosstabs

This section describes crosstabs based on Topics and Domains. For information about crosstabs based
on OLAP connections, refer to “Working with OLAP Connection-based Crosstabs” on page 115 and
“Working with Topics” on page 151.

Crosstabs have different data, layout, and format options than tables or charts.

If you selected Crosstab when you created a view, as described in “Ad Hoc View Types” on page 86, the
following sections explain tasks specific to your crosstab development.

4.4.1 Using Fields in Crosstabs
Fields can be added to crosstabs as row groups or column groups. Measures can be added to crosstab rows or
columns as well, but all measures must be included as either a row or a column – that is, you can add one or
more measures as columns, or add one or more measures as rows, but you cannot have one measure as a column
and another as a row in the same crosstab.

4.4.1.1 Crosstab Rows and Columns

When creating a crosstab view, keep in mind that row and column groups are arranged in hierarchies. Drag the
group headings to rearrange the hierarchy; you can also right-click a heading and select a Move option from the
context menu or press the cursor keys. Rearranging the groups may change the preview data in the editor.

To add a field or measure to a crosstab group:
1. In the Data Source Selection panel, click to select the field(s) you want to add to the crosstab as a group.

Use Ctrl-click to select multiple items.
2. Drag your selection into the Columns or Rows box in the Layout Band.
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4.4.1.2 Crosstab Measures

Measure labels are displayed in the crosstab based on their status as a row or column:
• Measures included as rows appear in the crosstab below the Measures heading.
• Measures included as columns appear in the crosstab to the right of the Measures heading.

You can right-click a measure in the crosstab to open a context menu that provides these options:
• Change Summary Function
• Change Data Format
• Remove From Crosstab
• Create Filter
• Move Up or Move Down

Measures are arranged in cells. You can add any number of measures. All the measures appear together in every
cell. To rearrange the measures, drag them in the measure label area.

4.4.1.3 Pivoting

You can pivot a crosstab in two ways:

• Pivot the entire crosstab by clicking . The row and column groups switch places. For more
information, see “Creating a View from a Domain” on page 146.

• Pivot a single group:
• To pivot a single row group, right-click it and select Switch To Column Group.
• To pivot a single column group, right-click it and select Switch To Row Group.

Pivoting removes any custom sorting applied to headings in your crosstab. It does not affect column or
row sorts.

4.4.1.4 Slicing

The slice feature lets you keep or exclude group members in a crosstab. To slice, right-click a group member and
select:
• Keep Only to remove all groups except the selected one from the crosstab.
• Exclude to remove this group from the crosstab.

Use Ctrl-click and Shift-click to select multiple groups to keep or exclude.

You can select multiple row groups or multiple column groups; you can't slice by both row groups and
column groups at once. Compare slice to drill-through, drill to details, and filtering.

For more information about filtering, see “Using Filters and Input Controls” on page 139.

4.4.1.5 Summarizing

All row and column groups are summarized automatically:
• To turn off a group summary, right-click any heading in the group and select Delete Row Summary or

Delete Column Summary from the context menu. To reapply the summary, right-click the heading and
select Add Row Summary or Add Column Summary.

The Delete Summary option is available only for the outermost group on either axis (that is, either the
outermost row group or the outermost column group)
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• To select the summary function and data format for a measure, right-click the measure label and select from
the context menu. Note that you can’t change the summary function on custom fields that calculate percents
(Percent of Total, Percent of Column Group Parent, and Percent of Row Group Parent).

• The summary functions for numeric fields are Sum, Average, Maximum, Minimum, Distinct Count, and
Count All. Distinct Count is the number of different items in the row or column; Count All is the total
number of items. For instance, if there are 3 widgets of type A and 3 widgets of type B, Distinct Count is 2
and Count All is 6.

4.4.1.6 Collapsing and Expanding Members

By default, the editor displays each row and column group of a crosstab in a collapsed state. This means you
can see the totals for the group, but not the measures for its individual members. To see measures for a group’s
members, right-click the group label and select Expand Members.

When a group’s members are expanded, select Collapse Members from the same menu to hide the measures.
Collapsing an outer group also collapses its inner groups. The Expand Members and Collapse Members
options are available only for outermost groups, or for inner groups nested in an expanded outer group.

When you collapse a group, its summary is automatically displayed; this prevents invalid crosstab layouts in
which there is nothing to display for some totals if the summary has been deleted previously.

4.4.1.7 Merging and Unmerging Crosstab Cells

By default, the editor merges cells containing the same data into a larger, single cell to make the crosstab data
easier to read. The following image shows a crosstab with merged cells.

To display all of the individual cells in the crosstab instead of merged cells, hover over and select
Unmerge crosstab cells. The following image shows a crosstab with unmerged cells.

To merge the crosstab cells, hover over and select Merge crosstab cells.

4.4.1.8 Sorting

By default, the rows and columns of crosstabs are sorted in alphabetical order of the group names.

To sort your crosstab:
• Right-click the heading you want to use for sorting and select one of these options:

• Sort Ascending
• Sort Descending
• Don't Sort
The crosstab is updated to reflect your sorting option. A blue dot appears in the context menu next to the
currently applied sort option.

When the crosstab includes more than one row group or more than one column group, the inner groups are also
sorted according to your selection. Only one measure can be used for sorting at any one time; changing the sort
order for another measure resets all others to the default.

To filter top or bottom N values:

You can filter the numeric data shown in a crosstab to show only the rows with the top or bottom N values,
where N is a number that you specify. For example, you can filter a crosstab to display only the top 10 values
in a column.
1. Right-click the heading you want to use for filtering and select one of these options:
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• Filter Top N Values
• Filter Bottom N Values
• Don't Filter Values

2. Enter the number of values you want to show in the crosstab.
3. Select whether to show an aggregate of the unranked values in the crosstab.
4. Select whether to apply the filter across all row groups.
5. Click OK.

The crosstab is updated to reflect your filter option. The icon appears in the heading when filtering a
column for the top N values, while the icon appears when filtering for the bottom N values. A blue dot
appears in the context menu next to the currently applied filter option. Only one measure can be used for
filtering at any one time; changing the filtering or sort order for another measure resets the filtered column.

4.4.1.9 Resizing and Layout

Many of the layout and formatting options that are set manually in tables are set automatically in crosstabs. In
particular, row and column sizes are fixed and no spacer is available.

4.4.1.10 Drilling Through Data

Drill-through functionality is available for crosstab data. A drill-through table displays the supporting details for
the selected roll-up value.

To view the drill-through table for a value in your crosstab:
• Click hyperlinked data to display additional columns from that specific fact data.

By default, the drill-through table opens in its own window or tab, depending on your browser settings.

4.5 Working with OLAP Connection-based Crosstabs
An OLAP connection is a definition for retrieving OLAP data for use in Ad Hoc views and reports. An OLAP
connection is either a direct Java connection (Mondrian connection) or an XML-based API connection (XML/A
connection). You must create OLAP client connections in order to use this functionality, which may be
restricted by your license. For more information on creating OLAP client connections, as well as other
administrative tasks regarding OLAP, refer to the Jaspersoft OLAP User Guide.

The Ad Hoc Editor displays a more focused tool bar when your Ad Hoc view is based on an OLAP connection.
It contains a subset of the options available in the standard tool bar, including Display Mode, Redo, Undo All,
Switch Group, Display Options, and View MDX Query. For a description of these options, see Table 4-1.

4.5.1 Dimensions and Measures
When you create a view based on an OLAP connection, the cube metadata defined in the connection’s OLAP
schema is automatically applied to your data: the dimensions and measures in the cube are shown in the Data
Source Selection panel.

Dimensions and measures describe your data in terms of these organizing principles and facts:
• Dimension: A categorization of the data in a cube. For example, a cube that stores data about sales figures

might include dimensions such as time, product, region, and customer’s industry. A dimension is a
hierarchical series of relationships in which each level has a parent and may also have children. Note that a
level is a particular location within the dimension, whereas a member is a specific data element at a

TIBCO Software Inc. 115



JasperReports Server User Guide

particular level. For example, if the dimension is Geography, then one of its levels might be Country; at the
Country level, USA might be a member.
Some dimensions include a special level at the top of the hierarchy that includes every level in the
dimension. This All member is used to display the summarized data across the dimension. The All member
of dimensions is a common feature in many OLAP solutions.

• Measure: A field that displays the facts that constitute the quantitative data in a cube. For example, a cube
that stores data about sales figures might include measures such as unit sales, store sales revenue, and store
sales cost.

The items in the Dimensions section of the Data Source Selection panel may appear in a multi-level tree
structure. You can add the entire dimension tree, or any sub-trees, to your crosstab by dragging the top-level
name into the Layout Band. Individual items can be added to the crosstab in the same manner.

Items in the Measures section are organized into a single-level list. Any calculated measures are indicated by a
calculation icon .

When working with OLAP connections, the Layout Band at the top of the Ad Hoc View panel allows you to
drag and drop dimensions and measures into the crosstab. As you add columns and rows, the crosstab
automatically builds on the panel. In the Columns and Rows fields, each item in your crosstab is represented
as a token; drag tokens left and right to change their position on an axis or drag them between the fields to
pivot them.

The cube metadata applied to your view provides structure to your crosstab: you can add a dimension with any
number of levels, but it must follow the hierarchy defined in the cube. For example, if a dimension’s levels are
Country, State, and City, you can place any one of them in the crosstab, but if you add two or more, their order
(defined in the OLAP schema) is enforced. For example:

Possible Impossible

Country, State, City State, Country, City

Country, City City, Country

State, City City, State

Country, State State, Country

In addition, you can’t mix members from different dimensions. For example, consider a crosstab that includes
both a Geography dimension (Country, State, and City) and a Time dimension (Year, Quarter, and Month): you
can’t insert the Year level between the Country and State levels. The levels of each dimension are always kept
together.

All measures in the crosstab must be either rows or columns. You can’t have measures on both axes at the same
time. To move measures between dimensions, right-click and select Switch To Column Group or Switch To
Row Group. All the measures move to the other axis.

4.5.2 Drilling Through Data
Drill-through functionality is available for crosstab data. A drill-through table displays the supporting details for
the selected roll-up value.
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To view the drill-through table for a value in your crosstab:
1. Click hyperlinked data to display additional columns related to that information.
2. Use the page controls to navigate the table.

The drill-through table opens in its own window or tab, depending on your browser settings.

4.5.3 Sorting
Like standard crosstabs, the rows and columns of an OLAP crosstab are sorted in alphabetical order of the group
names.

To change the sorting of your OLAP crosstab:
• Right-click the heading you want to use for sorting and select one of these options:

• Sort Ascending
• Sort Descending
• Don't Sort
The crosstab is updated to reflect your sorting option. A blue dot appears in the context menu next to the
currently applied sort option.

When the crosstab includes more than one row group or more than one column group, the inner groups are also
sorted according to your selection. Only one measure can be used for sorting at any one time; changing the sort
order for another measure resets all others to the default.

4.5.4 Viewing the MDX Query
You may want to view the MDX query created for the OLAP connection used with your crosstab, to verify
what data users are hitting. If this option is enabled, you can do this in the Ad Hoc Editor with the View
Query button.

The query is read-only, but can be copied to a document for review.

To view the MDX query:

• In the tool bar, click . The View Query window opens, displaying the query.

4.5.5 Working with Microsoft SSAS
The Ad Hoc Editor allows you to view data from Microsoft SQL Server Analytical Services (SSAS) to populate
views and reports with multi-dimensional OLAP data. XML/A connections that point to your SSAS data are
listed with the other OLAP connections when you create an Ad Hoc view, as in the following chart example.
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Figure 4-9 Search Results Listing

For details, refer to the Jaspersoft OLAP User Guide.

4.6 Calculated Fields and Measures
You can create new fields or measures in an Ad Hoc view by applying formulas to a view’s existing fields and
measures. For example, consider a view that includes both a Cost and a Revenue field. You could calculate the
profit for each record by creating a custom field that subtracts the Cost field from the Revenue field. For
example, you can divide the Profit custom field in the previous example by the Revenue field to express each
record’s margin as a percent.
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If you have installed the samples, the Ad Hoc view 10. Calculated Fields and Measures includes examples
of calculated fields (shown by the icon ) or calculated measures (shown by the icon ). You can explore
their formulas by right-clicking the field or measure name and selecting Edit. You can also create tables, charts,
or crosstabs to see how these calculations work in views.

4.6.1 Overview of the Calculated Fields Dialog Box
The Calculated Field or Calculated Measures dialog box allows you to create a calculated field or measure
and set its summary function. This section describes the functionality available in this dialog box.

To open the calculated fields dialog box for Ad Hoc views:
1. Create or open an Ad Hoc view.
2. Open the calculated fields dialog using one of these methods:

• Click at the top right of either the Fields section or the Measures section of the Data Source
Selection panel and select Create Calculated Field... from the context menu.

• Right-click on an existing calculated field (shown by the icon ) or calculated measure (shown by

the icon ) and select Edit.
The dialog displays a text field for the name and two tabs, Formula Builder and Summary.

The following are reserved words and cannot be used as field names: AND, And, and, IN, In, in, NOT, Not,
not, OR, Or, or. Names containing these strings, such as "Not Available", can be used.

4.6.1.1 The Formula Builder Tab

The Formula Builder tab is where you create the formula for your calculated field or measure. This tab includes
the following:
• Formula entry box — Shows the current formula for calculating your field or measure. You can edit the

formula by typing directly in the panel. You can also add Fields, Measures, and Functions by double-
clicking them. Click the buttons below the Formula field to add operators. Formulas must use the following
syntax:
a. Labels for fields and measures must be in double quotes ("): "Customer ID", "Date ordered".
b. Text must be in single quotes ('): '--'.
c. Levels must be in single quotes ('): 'ColumnGroup', 'Total'. See Levels in Aggregate Functions for more

information about levels.
For more information on syntax, see Calculated Field Syntax.

• Operator buttons — Click these buttons to insert the operator in the Formula entry box. For more
information on operators, see Operators in Ad Hoc Views

• Fields and Measures — Lists all the fields and measures currently in your Ad Hoc view, including any
calculated fields or measures you have already created.

• Functions — Lists all the available functions you can use in your formula. For more information, see
Calculated Field Reference.

• Function Description panel — Gives a brief description of the function selected in the Functions list, if any.
The sample inputs are intended to be as descriptive as possible. See Calculated Field Reference for the
precise syntax each function requires.

• Show arguments in formula checkbox — When this checkbox is selected, double-clicking a function name
in the Functions list adds the full description to the Formula entry box; when the checkbox is not selected,
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double-clicking a function name adds only the function. For example, double-clicking Round adds Round
("NumberFieldName", Integer) when the checkbox is selected, and adds Round() when the checkbox
is not selected. If you select this checkbox, you can double-click on a string, such as NumberFieldName,
and then replace it by double-clicking a name in the Fields and Measures list.

• Validate button — Checks the formula for syntax errors, such as missing parentheses or quotes. Your
calculated field or measure must be valid before you can create it. Syntax validation does not guarantee that
your formula will give the results you want.

4.6.1.2 The Summary Tab

Summaries show a result applied to all data values. For example, for a numeric fields such as Cost, the summary
value might be the sum of all the costs; for a text field such as Customer Name, the summary value might be the
count of all customers. The Summary tab lets you set the default summary function for your calculated field or
measure.
• Calculation list — Displays allowed summary functions for your calculated field or measure. The available

options depend on the data type of the calculation. See Summary Calculations for more information.
Depending on your selection, you may see additional options:
• Custom selection — Displays the same options available in the Formula Builder tab, including the

Formula entry box, operator buttons, Fields and Measures list, Functions list, and Validate button. You
use these options to build a formula for your custom summary. However, for summaries, you are limited
to aggregate functions, that is, functions that operate on all the values in your field. For example, Sum
and Mode are valid summary functions, because they use all available field values to get a result. Round
is not a valid summary function, because it operates on a single value at a time. See Summary
Calculations for more information.

• Weighted Average — Displays a Weighted On drop-down list, which allows you to choose another
field or measure to use as the weight for the average.

4.6.2 Creating a Calculated Field

To create a calculated field:
1. First, create the Ad Hoc view to use. To do this, select Create > Ad Hoc View from the menu. The Select

Data wizard appears.

2. Click and navigate to Domains.
3. Select Supermart Domain. Click Choose Data. The Data Chooser window appears.
4. In the Data Chooser window, double-click Sales to select it and click OK. A new Ad Hoc view opens.
5. In the Ad Hoc view, click at the top right of the Fields section and select Create Calculated Field...

from the context menu. The New Calculated Field dialog box appears, displaying the Formula Builder.
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Figure 4-10 Formula Builder Tab in New Calculated Measure Dialog Box

6. Enter Volume Tier for the Field Name.

Creating the formula:

This section shows how to create a simple text formula that says Low when the Unit Sales amount is under 100
and High otherwise.

Formulas must use the following syntax:
a. Labels for fields and measures must be in double quotes ("): "Customer ID", "Date ordered".
b. Text must be in single quotes ('): '--'.
c. Levels must be in single quotes ('): 'ColumnGroup', 'Total'.

7. Make sure Show arguments in formula is selected.
8. Now create the formula. Double-click IF() in the Functions list.

Because Show arguments in formula is selected, IF("BooleanFieldName", TrueCalc, FalseCalc)
is entered in the Formula Builder.

9. Double-click BooleanFieldName to select it, then double-click Unit Sales 2013 in the Fields and
Measures list.
The Formula Builder displays IF("Unit Sales 2013", TrueCalc, FalseCalc).

10. Edit the expression in the Formula Builder to read as follows: IF("Unit Sales 2013" IN (0:100),
'Low', 'High').

11. Click Validate to verify that the formula does not have any syntax errors.
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Creating a summary calculation:

The Ad Hoc Editor creates a default summary calculation based on the type of formula you have entered. This
section shows how to select a different summary function.
12. Click the Summary Calculation tab.

Figure 4-11 Summary Tab in New Calculated Measure Dialog Box

13. Select Mode from the Calculation menu.
14. Click Create Field.

The calculated field appears in bold text at the bottom of the list of available fields. A special icon

indicates it is a calculated field .

If you have installed the samples, the Ad Hoc view 10. Calculated Fields and Measures includes examples
of calculated fields and measures (indicated by ). You can explore their formulas by right-clicking the field
or measure name and selecting Edit. You can also create tables, charts, or crosstabs to see how these
calculations work in views.

4.6.3 Planning and Testing Calculated Fields and Measures
When you are creating calculated fields and measures, you may need to follow an iterative process: first create
your new fields and measures, then view the results, and finally adjust as needed. The following practices can
help:
• Reduce the size of your data set — To speed field creation and testing, reduce the size of your working data

set in the following ways:
• Select Sample Data from the drop-down menu in the Ad Hoc tool bar.
• Create one or more filters. This is especially useful for tables, which display all data by default.
• Limit the number of fields and measures you add to your test reports to restrict the number of summary

levels to one or two.
• Create one or more formulas, as described in Creating a Calculated Field.
• After you have created your fields and measures, add them to a table or crosstab in your view and verify

that they behave as you expect. You may need to edit your fields to get the desired behavior. See Creating
a Calculated Field for more information.
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In addition, keep the following in mind when creating calculated fields:
• When you create a calculated field, it appears at the bottom of the list.
• Calculated fields that use aggregate functions cannot be added to groups and should not be used as filters.
• By default, the Ad Hoc Editor supports only two decimal places. If the calculated fields return data that are

significant to the third decimal place, you can add new masking options by editing configuration files. For
more information, refer to the JasperReports Server Administrator Guide.

• You can’t delete a calculated field that is in use; these fields have their name in italics.
• If the calculated field is used in the Ad Hoc view panel, remove the calculated field from the Ad Hoc

View panel and then delete it from the Data Source Selection panel.
• If the calculated field is the basis of another field, you can’t delete it until you delete the one that

builds on it.

4.6.4 Calculated Field Reference
This section lists all functions that can be used to create calculated fields and measures in Ad Hoc views. For
details of the supported syntax, see Calculated Field Syntax.

These functions are available for calculated fields and measures in Ad Hoc views only. See Operators
and Functions for supported operators and functions in Domains.

The examples in this section indicate correct syntax, but are not necessarily associated with an Ad Hoc view. If
you have installed the Jaspersoft samples, the Ad Hoc view 10. Calculated Fields and Measures includes
examples of calculated fields (shown by the icon ) or calculated measures (shown by the icon ). You can

explore their formulas by right-clicking on the field or measure name and selecting Edit. You can also create
tables, charts, or crosstabs to see how these calculations work in views.

Absolute(NumericExpression)

Returns the absolute value of a number or field, that is, the non-negative value of the number.

Example:

Absolute("Transaction Amount") — Shows the magnitude of each transaction, regardless of whether the
transaction is positive or negative.

"Commission Rate" * Absolute("Transaction Amount") — Computes a positive commission on all
transactions, regardless of whether the transaction is positive or negative.

Attribute('StringExpression1', ['StringExpression2' ])

Given the name of an attribute as the first argument and an optional category as the second argument, returns
the attribute's current value as a String. If a category is specified (USER, TENANT, or SERVER), returns a
categorical attribute; returns a hierarchical attribute otherwise. This value can be cast to a different datatype
using one of the casting functions available in Ad Hoc: Boolean(), Date(), Decimal(), Integer(), Time(),
or Timestamp(). It is your responsibility to ensure the attribute's format and values work correctly with your
Ad Hoc view. See the JasperReports Server Administrator Guide for more information about creating and using
attributes.
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Average(NumericExpression[,'Level'])

Returns the average value of a measure or numeric field, based on an optional level. Null values are not
included. See Levels in Aggregate Functions for more information.

Example:
Average("Salary", 'RowGroup')

Boolean ('StringExpression')

Casting function that takes a String expression and converts it to a Boolean data type. The String can be any
expression that returns a supported string, including a field value or an attribute retrieved with the Attribute
() function. The Boolean() function requires one of the following Strings: true, false, True, False, TRUE, or
FALSE. Other Strings will return an error.

Example:
Boolean('true')

Case(Expression, ValueExpression1, ReturnExpression1, ValueExpression2, ReturnExpression2[,...,
ValueExpressionN, ReturnExpressionN][,DefaultReturnExpression])

Takes 2N+1 or 2N+2 arguments: an expression followed by one or more value expression/return expression
pairs, with an optional final return expression. Compares the expression in the first argument to each value
expression in order of appearance. Returns the value of the expression immediately following the first value
expression that matches. If no expression matches, returns the final DefaultReturnExpression if present, null
otherwise.

The types of all the return expressions must be compatible. For example, you can't mix numeric and text return
value types.

Example:
Case("Shipped by", 1, 'FedEx', 2, 'UPS', 3, 'USPS', 'Unknown')

CaseRange (NumericExpressionInput, NumericExpression1, ReturnExpression1, NumericExpression2,
ReturnExpression2[,..., NumericExpressionN, ReturnExpressionN][,DefaultReturnExpression])

Takes 2N+1 or 2N+2 arguments: an expression followed by one or more numeric expression/return expression
pairs, with an optional final return expression. Finds the first numeric expression that is greater than the input
expression and returns the value of the corresponding return expression. If no expression is greater, returns the
final DefaultReturnExpression if present, null otherwise.

The types of all the return expressions must be compatible. For example, you can't mix numeric and text return
value types.

Examples:
Case("Temperature", 60, 'too cold', 80, 'just right', 'too hot')

CaseRange(CountAll("Shipping charge") % CountAll("Shipping charge", 'Total'), 2.0, 'Less
than 2%', 5.0, '2% - 5%', 'More than 5%')

CaseWhen(BooleanExpression1, ReturnExpression1, BooleanExpression2, ReturnExpression2[,...,
BooleanExpressionN, ReturnExpressionN][, DefaultReturnExpression])

Takes 2N or 2N+1 arguments: one or more pairs of Boolean expressions followed by return expressions, with an
optional final return expression. Returns the expression immediately following the first true Boolean expression.
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If no expression is true, returns the final DefaultReturnExpression if present, null otherwise. This is the most
flexible construct.

The types of all the return expressions must be compatible. For example, you can't mix numeric and text return
value types.

Example:
CaseWhen("Shipped by" == 1, 'FedEx', "Shipped by" == 2, 'UPS', "Shipped by"== 3, 'USPS',
'Unknown')

Case("Temperature" <= 60, 'too cold', "Temperature" > 80, 'too hot', 'just right')

Concatenate(TextExpression1[ ,TextExpression2,...,TextExpressionN])

Combines multiple text strings and/or fields into a single text field. Text strings are enclosed in single quotes;
labels for fields or measures in Ad Hoc are enclosed in straight quotes.

Examples:
Concatenate("Last Name", ' , ', "First Name")

Concatenate("Product Category", ' -- ', "Product Name")

Contains(TextExpression1 ,TextExpression2])

Boolean that returns true if the first string contains the second, false otherwise.

Examples:
Contains("Product Name", 'Soda')

CountAll(Expression[,'Level')]

Returns the count of non-null items in a field or measure; note that CountAll always returns a non-negative
integer. Level can be one of the following: Current (default), ColumnGroup, ColumnTotal, RowGroup,
RowTotal, Total. See Levels in Aggregate Functions for more information.

Example:

CountAll("Transaction Amount", 'RowGroup') — Counts the total number of non-null transactions in the
specified group.

CountDistinct(Expression[,'Level'])

Returns the distinct count of non-null items in the input. Always returns a non-negative integer. Level can be
one of the following: Current (default), ColumnGroup, ColumnTotal, RowGroup, RowTotal, Total. See Levels
in Aggregate Functions for more information.

Example:

CountDistinct("Customer Name", 'Total')— Counts the number of distinct customers.

Date('StringExpression')

Casting function that takes a String expression and converts it to a Date data type. The String can be any
expression that returns a supported string, including a field value or an attribute retrieved with the Attribute
() function. The Date() function requires a String value formatted as 'yyyy-MM-dd'. Other Strings will return
an error.
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Example:
Date('2015-07-17')

Decimal('StringExpression')

Casting function that takes a String expression and converts it to a Decimal data type. The String can be any
expression that returns a supported string, including a field value or an attribute retrieved with the Attribute
() function. The Decimal() function requires a String value in decimal format, for example, '123.45'. Other
Strings will return an error.

Example:
Decimal('1234.567')

DayName (DateExpression)

Given a date field, returns a text field with the name of the day of the week.

Example:

DayName("Open Date")— Displays the day of the week on which a store was opened.

Mode(DayName("Open Date"), 'Total')— The day of the week on which the most stores were opened.

DayNumber (DateExpression)

Numeric field that returns the day of the month from a date field.

DayNumber("Open Date")— Displays the day of the month on which a store was opened.

ElapsedDays (DateExpression1, DateExpression2)

Calculates the number of days elapsed between two date fields that contain time values.

Example:

ElapsedDays ("Date shipped","Date required")

ElapsedHours (DateTimeExpression1, DateTimeExpression2)

Calculates the number of hours elapsed between two date fields that contain time values.

Example:

ElapsedHours ("Date shipped","Date required")

This replaces the two-date custom field operation Date Difference > Hours available in Ad Hoc
views created in Server 5.5 or earlier.

ElapsedMinutes (DateTimeExpression1,DateTimeExpression2)

Calculates the number of minutes elapsed between two date fields that contain time values.

Example:

ElapsedMinutes ("Date shipped","Date required")

This replaces the two-date custom field operation Date Difference > Minutes available in Ad Hoc
views created in Server 5.5 or earlier.
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ElapsedMonths (DateTimeExpression1,DateTimeExpression2)

Calculates the number of months elapsed between two date fields that contain time values.

Example:

ElapsedMonths ("Date shipped","Date required")

ElapsedQuarters (DateExpression1, DateExpression2)

Calculates the number of quarters elapsed between two date fields.

Example:

ElapsedQuarters ("Date shipped","Date required")

ElapsedSeconds (DateTimeExpression1,DateTimeExpression2)

Calculates the number of seconds elapsed between two date fields that contain time values.

Example:

ElapsedSeconds ("Date shipped","Date required")

This replaces the two-date custom field operation Date Difference > Seconds available in Ad Hoc
views created in Server 5.5 or earlier.

ElapsedSemis (DateExpression1,DateExpression2)

Calculates the number of semi-years elapsed between two date fields.

Example:

ElapsedSemis ("Date shipped","Date required")

ElapsedWeeks (DateExpression1,DateExpression2)

Calculates the number of weeks elapsed between two date fields that contain time values.

Example:

ElapsedWeeks ("Date shipped","Date required")

This replaces the two-date custom field operation Date Difference > Weeks available in Ad Hoc
views created in Server 5.5 or earlier.

ElapsedYears (DateExpression1,DateExpression2)

Calculates the number of years between two date fields.

Example:

ElapsedYears ("Date shipped","Date required")

This replaces the two-date custom field operation Date Difference > Years available in Ad Hoc views
created in Server 5.5 or earlier.

EndsWith(TextExpression1, TextExpression2]

Boolean that returns true if the first text input ends with the string specified in the second input; false otherwise.
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Examples:
EndsWith("Product Name", 's')

IF (BooleanExpression, ExpressionWhenTrue[, ExpressionWhenFalse])

Given a Boolean field or calculation as the first argument, returns the second argument if true; optionally returns
the third argument if false. Returns null if the first argument is null.

ExpressionWhenFalse must be of the same type as ExpressionWhenTrue. For example, if
ExpressionWhenTrueis a date, ExpressionWhenFalse must be a date in the same format. If
ExpressionWhenFalse is not set, then a false result returns a null value.

You can create a BooleanExpression using the comparison operators(“==”, “!=”, “>”, “>=”, “<”, “<=”);
any functions that return Boolean values (StartsWith, EndsWith, IsNull, Contains) and logical
operators (and, or, not).

When dates are used in comparisons or the IF function, they must be the same type, (date only, date/time,
or time only). Make sure to use the correct modifier (d, ts, t) when using date constants in comparisons.

Example:

IF(Contains("Product Name", 'Soda'), 'Yes', 'No')— Uses the Contains function to see whether the
product name contains the string "Soda"; if it does, sets the field value to Yes.

Integer('StringExpression')

Casting function that takes a String expression and converts it to a Integer data type. The String can be any
expression that returns a supported string, including a field value or an attribute retrieved with the Attribute
() function. The Integer() function requires a String value that can be read as an integer, such as '123'. Other
Strings will return an error.

Example:
Integer('123')

IsNull(Expression)

Boolean that returns true if the field value is null; false otherwise.

Examples:
IsNull("First Name")

Length(TextExpression)

Given a text string, returns its length. Null values return null.

Examples:
Length("First Name")

Max (NumericExpression|DateExpression[,'Level'])

Returns the maximum value reached by the specified field or calculation. Level can be one of the following:
Current (default), ColumnGroup, ColumnTotal, RowGroup, RowTotal, Total. See Levels in Aggregate
Functions for more information.
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Example:

Max("Salary")

Median (NumericExpression|DateExpression[,'Level'])

For an odd number of values, returns the middle value after all values are listed in order. For an even number of
values, returns the average of the middle two values. For example, if a field has only five instances, with values
{1,1,3,10,20}, the median is 3. Level can be one of the following: Current (default), ColumnGroup,
ColumnTotal, RowGroup, RowTotal, Total. See Levels in Aggregate Functions for more information.

Example:

Median("Salary")

Mid (TextExpression,Integer1,Integer2)

Given a text string, returns the substring starting at Integer1 with length Integer2.

Example:

Mid("Phone", 1, 3) — Given an American phone number starting with a 3-digit area code, extracts the area
code.

Min (NumericExpression|DateExpression[,'Level'])

Returns the minimum value reached by the specified field or calculation based on an optional level. Level can
be one of the following: Current (default), ColumnGroup, ColumnTotal, RowGroup, RowTotal, Total. See
Levels in Aggregate Functions for more information.

Example:

Min("Salary")

Mode (Expression[,'Level'])

Returns the most frequent value reached by the specified input, based on an optional level. For example, if a
field has only five instances with values {1,2,2,4,5}, the mode is 2. Level can be one of the following:
Current (default), ColumnGroup, ColumnTotal, RowGroup, RowTotal, Total. See Levels in Aggregate
Functions for more information.

Example:

Mode (DayName ("Order Date",RowGroup)) — For each row group, returns the day of the week on which
the most orders were placed.

MonthName (DateExpression)

Returns a text field with the name of the month.

Example:

MonthName ("Order Date" )

MonthNumber (DateExpression)

Returns the number of the month, with January = 1 and December = 12. Null values return null.

Example:

MonthNumber ("Order Date")
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PercentOf (NumericExpression[,'Level'])

Returns the value as a percent of total for the specified level. Null values are ignored. Note that possible values
for Level are ColumnGroup, ColumnTotal, RowGroup, RowTotal, Total (default). See Levels in Aggregate
Functions for more information.

PercentOf (NumericExpression, Total) replaces the custom field calculation Percent of Total
Group available in Ad Hoc views created in Server 5.5 or earlier.

Calculated fields using the PercentOf function should not be used as filters; if PercentOf is used as
a filter, then the total percent may not be 100.

Example:

PercentOf("")

Range (NumericExpression[,'Level'])

The difference between the largest and smallest values of the given input.

Example:

Range("Salary",'ColumnGroup')

Rank (NumericExpression)

Returns the position of each value relative to the other values after all the values are listed in order. For
example, the top ten in sales are the top ten in rank. Null values are ignored.

Example:

Rank("Store Sales")

Round (NumericExpression[,Integer])

Rounds a number to a specified number of digits; default is zero (0) digits. Decimal values greater than 0.5 are
rounded to the next largest whole number, and values less than 0.5 are rounded down.

Example:

Round("Sales")

StartsWith(TextExpression1, TextExpression2]

Boolean that returns true if the first text input starts with the string specified in the second input; false
otherwise.

Examples:

StartsWith("Product Name", 'Q')

StdevP (NumericExpression[,'Level'])

Standard deviation based on the entire population, taken over the values at the specified (optional) level. Null
values are excluded. Level can be one of the following: Current (default), ColumnGroup, ColumnTotal,
RowGroup, RowTotal, Total. See Levels in Aggregate Functions for more information.

Examples:
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StdevP("Sales",'RowTotal')

StdevS (NumericExpression[,'Level'])

Standard deviation based on a sample, taken over the values at the specified level. Null values are excluded.
Level can be one of the following: Current (default), ColumnGroup, ColumnTotal, RowGroup, RowTotal,
Total. See Levels in Aggregate Functions for more information.

Example:

StdevS("Sales",'RowTotal')

Sum (NumericExpression[,'Level'])

The sum of all values in the range. Null values are excluded. Level can be one of the following: Current
(default), ColumnGroup, ColumnTotal, RowGroup, RowTotal, Total. See Levels in Aggregate Functions for
more information.

Examples:

Sum("Sales",'RowGroup')

Time('StringExpression')

Casting function that takes a String expression in the format 'HH:mm:ss.SSS' and converts it to a Time data type.
The String can be any expression that returns a valid String, including a field value or an attribute retrieved
with the Attribute() function.

Example:
Time('17:12:33:147')

Timestamp('StringExpression')

Casting function that takes a String expression in the format 'yyyy-MM-dd HH:mm:ss.SSS' and converts it to a
Timestamp data type. The String can be any expression that returns a valid String, including a field value or an
attribute retrieved with the Attribute() function.

Example:
Timestamp('2015-07-17 17:12:33:147')

Today (Integer)

Calculates the date that is the specified number of days from the current system date.

Examples:

Today (0) — The current system date.

Today(1) — The day after the current system date.

Today(-1) — The day before the current system date.

WeightedAverage (NumericExpression1,NumericExpression2,'Level')

Returns the weighted average for the first input weighted with respect to the second input, calculated at an
optional level. Null values are excluded. Level can be one of the following: Current (default), ColumnGroup,
ColumnTotal, RowGroup, RowTotal, Total. See Levels in Aggregate Functions for more information.

Examples:
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WeightedAverage ("Price","Units", 'Current') — The extended price based on the number of units.

WeightedAverage ("Price","Units", 'RowGroup') — The sum of the extended price for all units in the
row group.

Year (DateExpression)

Given a date field, returns the year.

Examples:

Year("Order Date" )

4.6.5 Calculated Field Syntax
This section describes the syntax required when creating calculated fields in Ad Hoc views. See Calculated
Field Reference for more information.

Use the following syntax for inputs:
• To reference a text string, use single quotes (') — 'Text String'.
• To reference a field label, use double quotes (") — "Ad Hoc Label".
• To reference date constants, indicate the date type as part of the syntax, as listed below:

• To reference a date without time data (for example: yyyy-dd-mm), use d followed by single quotes (')
— d'2014-06-10'

• To reference a date with day and time data (for example: yyyy-dd-mm hh:mm:ss), use ts followed by
single quotes (') — ts'2014-06-10 01:30:00'. If you use ts and enter the date information only, the
time is automatically set to 00:00:00.

• To reference a date with time data only (hh:mm:ss), use t followed by single quotes (') —
t'01:30:00'

• To reference a date field label, use double quotes (") — "Ad Hoc Date Field Label".

The following are reserved words and cannot be used as field names: AND, And, and, IN, In, in, NOT,
Not, not, OR, Or, or. Names containing these strings, such as "Not Available", can be used.

When dates are used in comparisons or the IF function, they must be the same type, (date only, date/time,
or time only). Make sure to use the correct modifier (d, ts, t) when using date constants in comparisons.

In the function descriptions for calculated fields in Calculated Field Reference, the argument name describes
the type of input the function accepts. For more information about input types, see Datatypes:
• BooleanExpression — Any expression that takes on Boolean values, including the label of a Boolean

field or measure, a Boolean calculation, or a Boolean value.

You can create a BooleanExpression using the following: comparison operators (==, !=, >, >=, <, <=, in);
functions that return Boolean values (StartsWith, EndsWith, IsNull, Contains) and logical functions (AND,
OR, NOT).

• DateExpression — Any type of date or timestamp values, including the label of a date field or measure,
or a calculation that returns dates.

• DateTimeExpression — Date expressions that contain time values, including the label of a date field or
measure, or a calculation that returns dates. These values are also known as timestamp values.

• Expression — Any valid date, date-time, numeric, or string expression.
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• NumericExpression — Numeric values, including the label of a numeric field or measure, or a calculation
that returns numbers.

• TextExpression — Text values, including the label of a text field or measure, or a text string.
• Level — For aggregate functions, specifies the set of values used to compute the calculation. Possible

values include Current (not available for PercentOf), ColumnGroup, ColumnTotal, RowGroup, RowTotal,
Total. See Levels in Aggregate Functions for more information.

4.6.6 Operators in Ad Hoc Views
Ad Hoc views support the following operators in calculated fields. Operators are evaluated in the order they are
shown in the table:

Operator Syntax Description

multiply, divide i * j / k Arithmetic operators for numeric types only.

percent i % j Calculates i as a percent of j; numeric types only.

add, subtract i + j - k Arithmetic operators for numeric types only.

equal i == j Comparison operators for string, numeric, and
date types.

not equal i != j

less than i < j Comparison operators for numeric and date types
only.

less than or equal i <= j

greater than i > j

greater than or
equal

i >= j

IN set i IN ('apples','oranges') Sets can be of any type.

IN range i IN (j:k) Ranges must be numeric or date types.

NOT NOT( i ) Boolean operators. Parentheses are required for
NOT.

AND i AND j AND k

OR i OR j OR k

parentheses () Used for grouping.

When dates are used in comparisons or IF functions, they must be the same type, (date only, date/time, or
time only). Make sure to use the correct modifier (d, ts, t) when using date constants in comparisons.

The following reserved words cannot be used as field names: AND, And, and, IN, In, in, NOT, Not, not,
OR, Or, or. Names containing these strings, such as "Not Available", can be used.

TIBCO Software Inc. 133



JasperReports Server User Guide

4.6.7 Aggregate Functions
Aggregate functions in calculated fields perform calculations based on groups of rows, rather than on single
rows. For example, it doesn't make sense to use Sum or Average on a single value; instead, you want to take the
sum or average over a row or column group or over the total set. In many cases, aggregate functions in the Ad
Hoc Editor are analogous to SQL functions that can be used with the GROUP BY clause in a SELECT
statement.

The aggregate functions are as follows:

Average Median Range WeightedAverage

CountAll Min StdDevP

CountDistinct Mode StdDevS

Max PercentOf Sum

Because aggregate functions already operate on groups, their use is restricted in the following ways:
• You can use aggregate functions only in calculated measures; aggregates should not be used to create non-

measure fields.
• You cannot add an aggregate function to a group.
• You should not use an aggregate function as a filter.
• Only AggregateFormula, Custom, or None are supported as summary calculations for aggregate functions.

Custom appears in the Change Summary right-click menu only if you have defined a custom function in
the Create Calculated Field dialog box.

4.6.7.1 Levels in Aggregate Functions

Many aggregate functions accept an optional level to specify the grouping of the aggregate. A level used in an
aggregate, must be enclosed in straight quotes ('), for example, 'RowGroup'.

The available levels are as follows:
• Current (default) — use the current value when at a looking at detail rows in a table view.
• RowGroup — use the parent values from a row location.
• RowTotal — use the grand total value from a row location.
• ColumnGroup — use the parent values from a column location.
• ColumnTotal — use the grand total value from a column location.
• Total — use the grand total value from a cross tab and the RowTotal from a Table.

The following example shows how RowGroup works with the PercentOf() function.

Setting up the Ad Hoc view:

The examples in this section uses the Ad Hoc view created in Creating a Calculated Field. The initial view for
these examples can be set up as follows:
1. Select Crosstab from the View menu.
2. Add Store Sales 2013 and Low Fat to the Columns entry bar.
3. Add Country and Store Type to the Rows Entry Bar.
4. To make the example clearer, the data has been restricted. To do this, create three filters:

a. Expand Regions in the Fields Picker, right-click on Country, and select Create Filter. In the Filters
pane, set the filter to is one of then select Canada and USA.

b. Create a filter for Store Sales 2013. In the Filters pane, set the filter to is greater than, and enter 19.70.
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c. Right-click on Store Type and select Create Filter. In the Filters pane, set the filter to is one of then
select Deluxe Supermarket, Gourmet Supermarket, and Mid-Size Grocery.

Figure 4-12 Base Example for Levels

RowGroup example:

To create the layout for this example:
1. Click at the top right of the Measures section of the Data Source Selection panel and select Create

Calculated Measure... from the context menu.
2. In the Create Calculated Measure dialog box, enter Percent of Row Group for the name, and enter

PercentOf("Store Sales 2013",'RowGroup') in the Formula entry box. Then click Create Measure.
3. Drag the measure you just created to the Columns bar, between Store Sales 2013 and Low Fat.

The crosstab appears as shown in the following figure.

Figure 4-13 Example for RowGroup
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Look at the Low Fat values for "false" in the Canada group. The only non-null value under Store Sales 2013 is
in the first row, for Deluxe Supermarket. This value, 102.17, is 100% of the row group total of 102.17 on the
third line of the crosstab. This percentage is shown in the "false" subcolumn of the Percent of Row Group
column.

Compare this to the "true" entry under Store Sales for the same (first) row. There, the value is 19.90, and the row
group total is 39.65. The corresponding percentage shown in the "true" subcolumn of Percent of Row Group is
50.19%.

4.6.8 Summary Calculations
Summary calculations are aggregate functions used for sub-totals and totals. Summary calculations can be set in
the Domain Designer or in the Ad Hoc view.
• In Ad Hoc table views, each field can display a single summary calculation. The summary calculation is

automatically applied to all groups in the table. Summaries appear at the bottom of each group, as well as at
the bottom of the view. When a new group is added, it includes a summary for each column.

• In crosstabs, each measure displays a summarized value. Summaries determine the values of the Totals at the
intersection of each row and column.

• In charts, the type of chart determines whether measures are summarized. If summaries are used, they
determine the size or location of the graphical elements that represent your data.

For dual pie charts, the summary function for the field needs to be Sum or CountAll. Dual pie charts
with other summary functions may give unexpected results.

In general, you can change the summary calculation of any measure. By default, JasperReports Server
summarizes fields of each datatype as shown in the following table.

Datatype Default Summary
Calculation Description

Numeric Sum Displays the sum of all values in the set.

Date CountAll Displays the total number of values in the set.

String CountAll Displays the number of values in the set.

Boolean CountAll Displays the number of values in the set.

Aggregate AggregateFormula For a calculated field that uses an aggregate function, uses
the same aggregate formula as the summary.

Combined None For a calculated field that combines an aggregate function
with a non-aggregate function, the summary calculation is
null.

Table 4-3 Default Summary Functions in Calculated Fields
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Select from the following options to set a measure’s summary function in any type of view.

Function Meaning Available for….

AggregateFormula For a calculation that uses an aggregate function,
uses the same aggregate formula as the
summary.

Aggregate

Average Displays the average of all values in the set. Numeric

CountAll Displays the number of rows in the set. Boolean, Date, Numeric, and
String

CountDistinct Displays the number of unique values in the set. Boolean, Date, Numeric, and
String

Custom Allows you to enter an aggregate calculation for
the summary. Only available for calculated fields
and measures in the Ad Hoc Editor; not available
for Domains.

Aggregate, Date, Numeric

Max Displays the highest value in the set. Date, Numeric

Median Displays the median value of the set. Date, Numeric

Min Displays the lowest value in the set. Date, Numeric

Mode Displays the value that occurs most frequently in
the set.

Boolean, Date, Numeric, and
String

None The aggregate function is null; no summary
function is displayed.

Aggregate, Boolean, Date,
Numeric, and String

Range Displays the difference between the minimum
and maximum values of the set.

Numeric

RangeDays Displays the difference in days between the
minimum and maximum values of the set.

Date

RangeHours Displays the difference in hours between the
minimum and maximum values of the set.

DateTime

RangeMinutes Displays the difference in minutes between the
minimum and maximum values of the set.

DateTime

RangeMonths Displays the difference in months between the
minimum and maximum values of the set.

Date
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Function Meaning Available for….

RangeQuarters Displays the difference in quarters between the
minimum and maximum values of the set.

Date

RangeSemis Displays the difference in semi-annual periods
between the minimum and maximum values of
the set.

Date

RangeWeeks Displays the difference in weeks between the
minimum and maximum values of the set

Date

RangeYears Displays the difference in years between the
minimum and maximum values of the set.

Date

Aggregate Formula Uses the aggregate formula used to define the
calculated field as the summary function, and
sets the level appropriately for the context.

Aggregate

StdDevP Displays the standard deviation for the
population of the set.

Numeric

StdDevS Displays the standard deviation on a sample for
the set.

Numeric

Sum Displays the grand total for the set. Numeric

WeightedAverage Displays the weighted average for the set, based
on a second numeric field or expression. Only
available for calculated fields and measures in
the Ad Hoc Editor; not available for Domains.

Numeric

Note the following about summaries:
• If you select a summary calculation other than the default, that calculation is shown in parentheses after the

field name in the fields picker.
• In Ad Hoc views, you see special behavior when you create a calculated field or measure with the

following type of summary calculation:
• If you create a Custom summary calculation for a field or measure, Custom is available on the

Change Summary Function menu for that field. It is not available otherwise.
• If you create a WeightedAverage summary calculation for a field or measure,WeightedAverage is

available on the Change Summary Function menu for that field. It is not available otherwise.
• You can remove summaries by setting the summary function to None.
• Only AggregateFormula, Custom, or None are supported as summary calculations for aggregate functions.

Custom only appears in the Change Summary right-click menu if you have defined a custom function in
the Create Calculated Field dialog box.
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4.7 Using Filters and Input Controls
JRXML Topics, Domains, and OLAP connections use different mechanisms for screening the data they return:
• JRXML Topics can contain Parametrized queries. The parameters can be mapped to input controls that

allow users to select the data they want to include.
• Domains (and Domain Topics) can be filtered by selecting fields in the Domain and specifying comparison

values. The filters can be configured for users to select the data to include.
• Within the Domain design, filters based on conditions can also be defined; these filters are not displayed in

the report viewer when the report runs.
• OLAP connections rely on XML schemas to filter the data in an underlying transactional database. Input

controls are never generated directly from the OLAP schema.

You can define filters in the Ad Hoc Editor regardless of whether you are working with data from a Domain,
Topic, or OLAP connection. Such filters can be helpful in improving the view's initial performance by reducing
the amount of data the view returns by default. For more information, see “Input Controls and Filters
Availability” on page 145. To prevent users from seeing the full dataset, you can also use input controls in a
JRXML Topic or filters defined in the Domain design, which can be hidden from end users.

If you want to return different data to different users of the same view, define data-level security based on a user
roles and profile attributes. This is available for reports based on a Domain, Domain Topic, or OLAP client
connection. For more information, refer to the Jaspersoft OLAP User Guide.

Input controls and filters interact seamlessly. For example, you can create filters in an Ad Hoc view that gets
data from a JRXML Topic that includes input controls.

The server refreshes the editor against both the filters and the input controls. Because some combinations

of input controls and filters don’t return data, this can result in an empty view.

If the result set is empty, check for an incompatible combination of filters and input controls, such as a
standard filter (set to Mexico against a Country field) and a Keep Only filter (set to Canada against a
Country field), or an incorrectly-defined advanced filter expression (data must meet all criteria in multiple
filters, rather than meeting criteria in a subset of those filters). See “Custom Filtering” on page 141 for
information on advanced filter expressions.

In rare cases, filters can conflict with view parameters, and you’ll need to rename the field causing the conflict
by editing the JRXML file. Refer to the Jaspersoft Studio User Guide for more information about editing
JRXML files.

For more information about:
• JRXML Topics and input controls, see “Adding Input Controls” on page 170.
• Domain Topic filters, see “Creating Topics from Domains” on page 153.
• Localizing input control prompts and lists of values, see “Localizing Reports” on page 184.

4.7.1 Using Filters
Filters can be defined at three levels:
• In the Domain Designer.
• When creating a view from a Domain (with the Data Chooser).
• In the Ad Hoc Editor (even when the view is based on a JRXML Topic or OLAP connection).
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In this section, we discuss how to define filters in the Ad Hoc Editor. For information on defining filters in the
Domain Designer, see “The Pre-filters Tab” on page 222. For information on defining filters in the Data
Chooser, see “The Pre-filters Page” on page 149.

In addition, you can control how and what filters are applied to a field or fields by using custom expressions.
For more information, see “Custom Filtering” on page 141.

To create a filter in the Ad Hoc Editor:
1. Right-click a field in the Data Source Selection panel and select Create Filter. A new filter appears in

the Filters panel. If the Filters panel was hidden, it appears when you create a new filter.

If the results are empty and you don’t understand why, check for an incompatible combination of filters and
input controls. Click to compare input controls with the filters in the Filters panel.

2. Use the fields in the filter to change its value. Depending on the datatype of the field you selected, the
filter maybe multi-select, single-select, or text input.

3. Click and select Minimize All Filters or Maximize All Filters to toggle expansion of the items in the
filter.

4. Click and select Remove All Filters to remove the filters.
5. Click to hide the filter’s details. Click to display them again.
6. Click the Select All check box (if it appears in the Filters panel) to select all values currently available in

the dataset. The Select All check box does not appear in the Filters panel for numbers and dates.
Note that the Select All check box doesn’t guarantee that all values are selected every time the report runs.
Instead, the check box is a shortcut to help you quickly select all the values currently available in the
dataset. To ensure that all values appear in the view whenever it is edited or a report is run, remove the
filter entirely. On the panel, you can also create a filter from the right-click context menu of a column in a
table. On the Chart tab, you must right-click the field in the Data Source Selection panel.

When you change a filter, the server uses the filter's new value to determine what data to display. If you change
only the operator in a filter, you must deselect the value in that filter, then reselect it to apply the updated filter.

For filters with multiple values, you do not need to reselect all values. After changing the operator, use Ctrl-
click to deselect just one of the values, then Ctrl-click to reselect that value.

4.7.1.1 Relative Dates

You can filter information in your view based on a date range relative to the current system date. You can
accomplish this using date-based filters, and entering a text expression describing the relative date or date span
you want to display, using the format <Keyword>+/-<Number> where:
• Keyword indicates the time span you want to use. Options include: DAY, WEEK, MONTH, QUARTER,

SEMI, and YEAR.
• + or - indicates whether the time span occurs before or after the chosen date.
• Number indicates the number of the above-mentioned time spans you want to include in the filter.

For example, if you want to look at all Sales for the prior week, your expression would be: WEEK-1.

To create a relative date filter:
1. Following the instructions in “Using Filters” on page 139, create a filter based on a date field. The filter

appears in the Filters panel.
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2. In the filter’s first text entry box, enter an expression describing the relative date or date span you want to
display.

3. In the filter’s second text entry box, enter the date you want to base your filter on.
For instance, if you want to display all the sales numbers for one month before the current date, enter
MONTH-1 in the first text entry box, and enter today's date in the second box.

When you right-click a group member in a crosstab and select Keep Only or Exclude, you create complex
filters. When you create a filter against an inner group, the filter that appears may be created as a complex
filter. You can't edit a complex filter, but you can remove it. Complex filters also appear in the Ad Hoc
Editor if a Data Chooser filter was created and locked.

4.7.1.2 Custom Filtering

When you create multiple filters they are, by default, connected with an implicit AND operator. That is, the
data displayed in your table, chart, or crosstab is what remains after all your filters are applied.

However, with the custom filter functionality, you can exercise greater control over the displayed data by
applying a custom expression that includes more complex, nested AND, OR, and NOT operators, as well as by
applying multiple filters to a single field.

Custom filters are not available for Ad Hoc views created from OLAP connections.

Custom filters are useful in a number of situations, including:
• When using the AND operator isn’t sufficient. Consider an international company that wants to view

data for stores located on the Pacific Rim; they may create a custom expression with the following criteria:
• Country is USA

AND
• State is California OR Washington OR Oregon OR Hawaii OR Alaska.

OR
• Country is Japan OR Indonesia
Using the AND operator for all of these criteria returns an empty view, as no store is located in all of those
areas.

• When you need to eliminate some results in a field. For example, if your food and beverage
distribution company wants to view sales for all drinks except for high-price items, you might include the
following criteria in a custom expression:
• Product Group is Beverages

NOT
• Price is greater than 39.99
This filter displays all items in the Beverage Product Group, but filters out those with prices over $39.99

These are only two scenarios where custom filters can hone your results and make your view more precise.
There are, of course, many other situations where they can be applied.

In this section, we take you through these tasks:
• Creating a custom expression
• Editing a custom expression
• Removing a custom expression
• Applying multiple filters to a single field
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Custom filters are applied to views, but filter details don’t appear on previews or on the report generated
from that view.

To create and apply a custom filter:
1. Create two or more filters for your data, as described in “Using Filters” on page 139. These can be standard

field-based filters, or Keep Only and Exclude filters.
Note that as you create the filters for use in a custom expression, you may find that the data in your view
disappears, since most (if not all) of the data won’t meet all of the filter criteria. When you create your
custom expression and change some of the ANDs to ORs and NOTs, data reappears in the panel.

2. At the bottom of the Filters panel, expand the Custom Filter Expression section.
3. In the text entry box, enter a filter expression using the letter designations, and including the following

operators:
• AND narrows your results and includes only fields that meet the criteria of both filters before and after

the operator.
• OR broadens your results and includes fields that meet the criteria of either filter before or after the

operator.
• NOT excludes results that match the criteria.
• Parentheses combines multiple filters into a single item in the expression.

Filter letter designations are case sensitive, and must be UPPERCASE.

4. Click Apply. Your view is updated to reflect the newly-applied filter criteria.

After creating a custom filter, you may want to add another filter to the expression or remove one already
included in the expression.

If the simple filter you want to delete is part of a custom filter, you must first remove it from the custom
filter expression; otherwise deleting the filter deletes the custom filter expression.

To add a new filter to an existing custom expression:
1. If necessary, create the new filter in the Filter panel.
2. In the Custom Filter Expression section, click inside the text entry box to edit the expression.
3. Add the new filter to the expression.
4. Click Apply to apply the new filter criteria.

To remove a filter from a custom expression:
1. Expand the Custom Filter Expression section.
2. In the text entry box, remove the unwanted filter from the expression and adjust the expression as needed.
3. Click Apply to apply the new filter criteria.

When working with custom expressions, you may decide to delete an expression and create a new one.

To remove a custom expression from a view:
1. Expand the Custom Filter Expression section.
2. Clear the expression from the text entry box.
3. Click Apply. The expression is removed, leaving the remaining filters intact.
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When you refine your custom expression, you may also want to delete unused filters from the Filters panel.
• If the filter you want to remove isn’t part of the custom filter, hover your mouse over in the filter’s title

bar and select Remove Filter.
• If you want to remove all existing filters, including the custom expression, hover your mouse over in

the upper right corner of the Filters panhandle and select Remove All Filters.

You can apply multiple simple filters to a single field, if needed, to further refine your custom filter results. For
example, a user may want to view the data in the Shipping Cost field, but only when it meets certain criteria
combinations:
• When shipping costs to French cities with postal codes that begin with the number 5 are under five Euros
• When shipping costs to German cities with postal codes that begin with the number 1 are under five Euros

You can recreate the scenario below using the demo for adhoc topic.

In the following example a user has a table including the following columns:
• Country
• Postal Code
• Shipping Charge

To analyze the specific shipping costs described above, the user creates the following (simple) filters - including
two filters each for the Country and Postal code fields:
• A. Country equals France
• B. Postal code starts with 5
• C. Country equals Germany
• D. Postal code starts with 1
• E. Shipping Charge is less than 5

Then, to display only the information she needs, she creates the following custom expression:
• ((A and B) or (C and D)) and E

This translates to:
• ((FRANCE and POSTAL CODES THAT START WITH 5) or (GERMANY and POSTAL CODES THAT

START WITH 1)) and SHIPPING CHARGES LESS THAN 5 EUROS.

4.7.2 Using Input Controls
In the Ad Hoc Editor, you can display the input controls defined in the Topic as visible to users. You can
accept the controls’ default values or enter other values. The Ad Hoc Editor indicates that the view has input

controls by displaying as active on the tool bar. Click this icon to select new values or to save values as the
new defaults for this view.

There are two types of input controls: Single select and multi-select. The input control type is determined by the
operator you use. In turn, the available operators are determined by the field type (date, text, numeric, or
boolean) you use as a filter.

Single select controls present a calendar or drop-down list of values, from which you can choose a single value.
To create this type of input control select one of the following operators:
• equals
• is not equal to
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• is greater than
• is less than
• is greater or equal to
• is less or equal to
• contains
• does not contain
• starts with
• does not start with
• ends with
• does not end with
• is before
• is after
• is on or before
• is on or after

Multi-select controls display a calendar or drop-down list of values, from which you can choose multiple
values. You can click to select individual values or shift-click to select multiple sequential values. You can also
search for values, select all available values, deselect all available values, or invert the selection. A
Selected tab shows only items that are selected and allows you to delete them. To create this type of input
control select one of the following operators:
• is one of
• is not one of
• is between
• is not between

To add an input control to the view using a filter:
1. Create a new filter or use an existing one in the Filters panel.
2. In the Filters panel, click the operator drop-down menu in the filter's title bar.
3. Select an operator from the drop-down. The operator you select determines whether the input control is

single-select or multi-select.
4. Click Apply. The filter appears as an input control when the view is used to run the report.

5. Place your cursor over , select Save Ad Hoc View as....
6. Name the view, select a location, and click Save.

7. On the tool bar, click .
Only the input controls defined in the topic appear here. Again, if no input controls were defined in the
topic, the button appears inactive. You can create a report and open it in the report viewer to see a filter
listed as an input control.

To edit the values for a view’s input controls:

1. On the tool bar, click . A window listing the input controls defined in the Topic appears.

The Parametrized Report Topic already includes three input controls created when the report was
uploaded: Country, RequestDate, and OrderId.

2. Select new values. For example, select USA from the Country drop-down.
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3. To change default values of input controls, select the check box, Set these values as defaults when
saving your view. The selected values become the default values when you save the view.

4. Click OK. The Ad Hoc view shows USA data.

4.7.3 Input Controls and Filters Availability
Input controls and filters can appear in the Editor and when a report runs:
• Input controls can be set to be visible or invisible when you edit a view:

• Input controls set to Always prompt are displayed in the editor and always appear before the report is
run.

• Input controls that aren’t set to Always prompt are always hidden in the editor and hidden when the
report is run.

• Filters defined in the Domain design are always hidden in the editor and when the report is run.
• Filters created in the Data Chooser can be locked or unlocked:

• Filters that are unlocked display filter information in the editor and are available from the Options
button when the report is run.

• Filters that are locked display input controls in the editor when you click to see the view in
display mode but are not available from the Options button when the report is run. Users can remove
the filter while in the editor, allowing them to see all the data unfiltered when the report is run.

• You can’t change whether the filter is displayed after the report is created.
• Filters defined in the editor are always available in the Filters panel of the editor and from the Options

button when the report is run.

When setting up input controls for a huge view that takes a long time to run, consider setting the view to
Always prompt. Before a report is run, the report viewer prompts you to provide the input options, preventing
the report from running with the default input options.

Filters that are unlocked are available. When input controls or filters don’t appear in the report viewer, click the
Options button to view them. You can learn more about how filters and input controls interact in the editor by
walking through the data exploration tutorial with the Filters panel open.

To set an input control to always prompt:
1. Locate a Topic, such as the Parametrized Report Topic, in the repository and click Edit.
2. On the Controls & Resources page of the JasperReport wizard, under Input Control Options, select Always

prompt:

To determine whether an input control is visible:
1. Locate a Topic, such as the Parametrized Report Topic, in the repository and click Edit.
2. On the Controls & Resources page, click the name of an input control, such as Country.
3. On the Locate Input Control page, click Next.

At the bottom of the Create Input Control page, if the Visible check box is selected, the input control
appears on the report when it runs. For more information, see “Adding Input Controls” on page 170.

If you don’t provide a default value for the input control, users are prompted to select a value when
they create a view based on the Topic.
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To lock a filter:
1. Click Create > Ad Hoc View.

2. In the Select Data wizard, click and browse to Domains to create a new view based on a Domain.
3. Click Choose Data.
4. In Fields, move tables and fields from Source to Selected Fields.
5. Click Pre-filters.
6. Double-click a field in the Fields panel.
7. In the Filters panel, define a filter as described in “The Pre-filters Page” on page 149.
8. Check the Locked check box, and click OK.
9. Click Table to open the Ad Hoc Editor.

In the Filters panel, the name of the filter and a note about the lock appears under the heading Locked.

4.8 Creating a View from a Domain
Like Topics and OLAP connections, administrators and data analysts create Domains for reuse to simplify access
to data during view design. Domains give view makers more flexibility than Topics in choosing fields from the
database and allow filtering of the data before it is included in a view and the subsequent report.

A view based on a Domain can prompt the user for input that determines what data is presented. For example, if
a Domain includes all sales data for a company, the view can present detailed information grouped by postal
code and prompt the user to select the geographic area, such as a US state. The view displays only the pertinent
information.

For a more complete description of how to create Domains, see “Example of Creating a Domain” on
page 198.

To begin create a basic view from a Domain:
1. On the Home page, click Create > Ad Hoc View. The Select Data wizard opens.

2. Click and navigate to Domains. A description of the selected Domain appears at the bottom of the
Domains tab.
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Figure 4-14 Simple Domain Selected in the Select Data Dialog

3. Select the domain you want to use.
4. Click Choose Data. The Data Chooser opens to the Fields page.

You are now ready to configure your data using the Data Chooser Wizard.

4.8.1 Referential Integrity
When you create an Ad Hoc view from a Domain, the two elements are connected - the data in the view is
dependent on the Domain. This relationship affects users working with the Domain and the dependent view in a
number of ways:
• When an item or items from the Domain are used in the dependent Ad Hoc view, the Domain's

administrator is notified, and those items cannot be removed from the Domain.
• Items not used in dependent views can be removed from the Domain by the Domain's administrator; those

items no longer appear in the view's Available Fields list.

For more on this topic, see “Maintaining Referential Integrity” on page 231

4.8.2 Using the Data Chooser Wizard
To design a Domain Topic or a view based on a domain, use the Data Chooser wizard. To open the Data
Chooser wizard:
1. Click Create > Ad Hoc View.

2. Click and browse to a Domain, then click Choose Data to access the following pages of the Data
Chooser:
• The Select Fields Page – Choose the fields to make available in the Ad Hoc Editor.
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• The Pre-filters Page – Define a filter on any field, with the option of prompting for user input, or to
compare fields.

• The Display Page – Change the order and names of fields that appear in the Ad Hoc Editor.
• The Save as Topic Page – Save the settings as a Domain Topic.

You must start by selecting some fields on the Select Fields page, but the other three pages are optional and can
be completed in any order. Click Table, Chart, or Crosstab at any time to begin designing a view based on
the chosen data.

4.8.2.1 The Select Fields Page

Use this page to choose fields and sets of fields to use in the view or make available in the Domain Topic:

Figure 4-15 The Fields Page of the Data Chooser

• The Source panel displays the sets of fields in the Domain. Use and to collapse or expand each set.
• The Selected Fields panel shows the items you selected. You can move a field or set back and forth

between the panels by dragging, double-clicking, or selecting the item and clicking an arrow button, such

as .
• When you select any field from a set in the Source panel, the set name appears with the field in the

Selected Fields panel, If you do not want sets, use the settings on the Display page.
• Some Domains define sets that are not joined, also called data islands. When you select a field from such a

set, the behavior on the Select Fields page depends on how the joins were created in the Domain:
• If the Domain uses basic joins, the unjoined sets aren’t available. The Domain Designer only creates

basic joins.
• If the Domain uses advanced joins, all joins are available regardless of the join set of the fields you

add. In this case, you must manually make sure that you do not add fields that are in different data
islands to a single Ad Hoc view. Otherwise you will receive errors when attempting to work with the
view.
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4.8.2.2 The Pre-filters Page

You can pre-filter data in the Data Chooser before launching the Ad Hoc Editor or creating a Domain Topic.
Pre-filtering data limits the data choices available in a Domain Topic or the fields that ultimately appear in the
Ad Hoc view. You can also define a filter on a field that does not appear in the final report. The filter is still
applied and only data that satisfies all defined filters appear in the final report. For example, you can filter data
to select a single country, in which case it doesn’t make sense for the Country field to appear as a row, column,
or group. You can also design reports that prompt users to input data to use as a filter.

The Pre-filters page provides powerful functionality for designing views within the server.

Figure 4-16 Condition Editor in the Filters Panel on the Pre-filters Page

To define a filter:
1. In the Data Chooser, click Pre-filters.
2. Expand the options in the Fields panel.
3. Double-click to select a field in the Fields panel. Choices appear for filtering the selected field:
4. Choose a comparison operator.

Text fields have both substring comparison operators such as “starts with” or “contains” and whole string
matching such as “equals” or “is one of.” When you select a whole string matching operator, a list appears
showing all existing values for the chosen field retrieved in real-time from the database.
In the Filters panel, a drop-down appears containing the account names from which you can select multiple
values.

5. Click each value for comparison in Available Values to move it to Selected Values. The account names
appear in Selected Values.
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If there are more than 50 Available Values, click to search for the value. The maximum number

of items that can be displayed in Available Values is configurable. For details, see the JasperReports
Server Administrator Guide.

6. To limit the view design to the four account names in Selected Values, check the Locked check box.
By default, the Locked check box is unchecked, making the filter available to end-users running the report.
In the Report Viewer, users can click the Options button to enter a comparison value for this condition;
when the user clicks Apply or OK, the report preview refreshes with data that match the condition. The
condition is available as a prompt even if the filtered field does not appear in the report. For example, the
final report might present data for a single country, but the country is chosen by the user. Once defined,
filter prompts can be modified in the Ad Hoc Editor, as explained in “Using Input Controls” on page 143.
Note that when the Locked check box is checked, the filter is not available to end-users running the report.
The condition can be removed from the view, if needed, but not edited.

7. Click OK to create the filter.
The Filters panel shows the filters you have defined.

8. In the Filters panel, click Change to modify the condition. Click OK to save the changes. After selecting
a row, you can also click Remove to delete it from the list.

Data rows must match all conditions. In other words, the overall filter applied to the data is the logical AND
of all conditions you have defined.

4.8.2.3 The Display Page

Use the Display page to change the default label and order of the fields as they should appear in the list of
fields in the Ad Hoc Editor. You can always change the field labels and ordering in the Ad Hoc Editor, but
setting them here makes them available in a Domain Topic. The page includes these options:
• To change the order of fields, click once anywhere in a field’s row and use the Move to top, Move up,

Move down, or Move to bottom buttons:

, , , and
Fields may be moved only within their set, but sets as a whole may be also be moved.

• By default, the field name becomes the display label for the row, column, or measure that you create from it.
To change the default display label of a field or set, double-click anywhere in the row and type the new
label in the text box.

• Sets and the fields they contain appear in the list of fields in the Ad Hoc Editor. Sets are not used in views,
but can be used to add all their fields at once, expediting view creation.

• If you don’t want to use sets in the Ad Hoc Editor, select Flat List at the top of the Data Source Selection
panel. You can now relabel the fields and reorder them.

4.8.2.4 The Save as Topic Page

Here you can enter a name and a description to save the Data Chooser settings as a Domain Topic. Thereafter,
you can create different views from the Domain Topic, using its fields, filters, and display label settings. You
can also edit the Domain Topic to change the settings.

If an administrator has enabled the Data Staging feature, you can turn data staging on for your domain topic.
Data staging was added in version 6.0 of Server. With data staging, the entire dataset for a Domain Topic is
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indefinitely cached in the server's Ad Hoc cache. Ad Hoc views and reports from that Domain Topic run faster
because they fetch data from the local cache, not by querying the production database. To keep data fresh, you
can specify a refresh interval, and the server will periodically access the database in the background to reload
the entire dataset.
• By default, Domain Topics are saved in the standard Topics folder. This corresponds to the Ad Hoc

Components > Topics location in the repository; JRXML Topics and Domain Topics in this folder
appear on the Topics tab when you start a view. Do not modify this folder name.

• The description text appears with the Domain Topic in the repository and at the bottom of the Topics tab
on the Ad Hoc Source dialog. Enter an informative description that helps users understand the nature and
purpose of this Domain Topic.

4.9 Working with Topics
When a user clicks Create > Ad Hoc View on the Home page, the Select Data wizard offers a path to a list of
Topics populated from the Ad Hoc Components/Topics folder in the repository. There are two types of Topics:
• JRXML-based Topics – Created by administrators using Jaspersoft Studio and uploaded as JRXML files to

the proper location in the repository. Topics are typically of this type.
• Domain Topics – Created from a Domain by administrators using JasperReports Server.

Either type of Topic is an empty view associated with a data source in the server, and is then built on in the Ad
Hoc Editor.

4.9.1 Uploading a Topic Through the Web UI
JRXML-based topics are the most common type of topic. You can upload previously created JRXML topics via
the repository.

To upload a JRXML-based Topic:
1. Log into the server as administrator and select View > Repository.

While any user with sufficient repository permissions can upload a Topic to the server, this example
requires an administrator login to access the JServer Jdbc data source.

2. Locate the folder where Topics are stored. The location of the Topics folder depends on your system
configuration; by default, Topics are in the Ad Hoc Components > Topics folder.

3. Right-click the Topics folder name and select Add Resource  > JasperReport from the context menu.
The Set Up the Report page of the JasperReport wizard appears.

Add Resource appears on the context menu only if your login account has write privilege to the
folder.

4. In the Set Up the Report page, give the Topic a name, a Resource ID, and an optional description, then
click Next.
• The Name field is the visible name of the file in the repository, such as Example Topic.
• The Resource ID field is the internal ID of the object, such as Example_Topic. The server does not

accept spaces in an internal ID.
• The Description field, such as Topic uploaded for User Guide example, helps users understand

the purpose of the file.
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5. In the Locate the JRXML File section, select Upload a Local File, and click Browse to locate the file
and upload the Topic from the file system. In this example, the file is <js-
install>/samples/adhoc/topics/adhoc_sample.jrxml.

To locate adhoc_sample.jrxml, you need access to the server host file system.

6. Click Data Source.

Because this is a simple Topic without parameters, there are no controls and resources associated
with it. If the Topic has a Parametrized query, you can create input controls for it. See “Selecting a
Data Source for Running the Complex Report” on page 180. Such input controls can appear in the
Ad Hoc Editor and when the report is run.

7. Click Select data source from repository and Browse to locate the data source named Data
Sources/JServer Jdbc data source.

8. Select Data Source, then click Select.
Topics must be associated with the data source that they were designed for.

9. Click Submit at the bottom of the screen.
Topics usually do not need a query or customization, but you can define them.

When you select Create > Ad Hoc View and click in the Select Data wizard, you can browse to Ad
Hoc Components > Topics. If you select the Example Topic, you can create a report using the columns
available in the data source selected in step 7.

When you create a JRXML file for use as a Topic, you can specify the name to display for each field that the
Topic returns. To do so, define a field property named adhoc.display for each field declared in the JRXML.
The adhoc.display field property must have the following syntax:

<property name=”adhoc.display” value=”Any Name”/>

If the Topic includes fields with unusual datatypes, those fields don't appear in the Ad Hoc Editor because
it's not equipped to manage them properly. For example, if the Topic is defined against a MongoDB
instance that returns data of type array, this field isn't available in the Ad Hoc Editor. For more information
on datatype support in the Ad Hoc editor, see the JasperReports Server Administrator Guide.

For example, this JRXML code declares a StoreState field that is displayed in reports as Store State:

<field name=”StoreState” class=”java.lang.String”>

<property name=”adhoc.display” value=”Store State”/>
</field>

Topics also support the $R expressions for field names; for more information, see “Localizing Reports” on
page 184.

For fields in a non-domain topic the following properties may be of interest:
• dimensionOrMeasure: marks a field as a field or a measure
• defaultAgg: which aggregation should be used for this measure (avg, etc)
• semantic.item.desc: A description for the field
• defaultMask: set a measure as a $, date etc
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For more information on working with JRXML topics, see the Jaspersoft Studio User Guide.

4.9.2 Creating Topics from Domains
In some circumstances it is important to create a Topic based on the Domain and data settings you chose, but
it's not always necessary. The main consideration is how reports based on the Domain-based view are used. The
following table explains the choices.

If you want to… Then do this Explanation

Create a single-use report
from the Domain with your
settings.

Click Table, Chart, or
Crosstab after defining your
settings in the Data Chooser,
then format the view and
create your report.

Your field selections appear in the Ad Hoc
Editor and you can create views from them,
but the settings themselves are not saved.

Run a report repeatedly as is
or with prompting for new
input, or make very similar
reports in the Ad Hoc Editor.

Click Table, Chart, or
Crosstab after defining your
settings in the Data Chooser,
then format and save the view
in the Ad Hoc Editor.

After you save a view, users can create
reports to be run from it repeatedly and be
prompted for input each time if you defined
unlocked filters.

Reuse your field, filter, and
display settings on this
Domain to create new views
with different formatting.

After saving your settings as a
Domain Topic in the Data
Chooser, start a new view and
choose your Domain Topic
from the Domains tab.

Domain Topics are saved in JRXML format
in the repository. They appear on the Topics
tab when you start a view.

Be able to modify one or more
of the settings you made in
the Data Chooser wizard.

After saving your settings as a
Domain Topic in the Data
Chooser, find your Domain
Topic in the repository and
open it in the Domain
Designer.

Domain Topics can be edited as described
in “Editing a Domain Topic ” on page 154.
After you save your changes, you can create
views based on the modified Domain Topic.

Create views from the same
repository data source but
with different Domain settings,
such as derived fields and
different joins to make new
fields available in a report.

Edit the Domain and save it
with a new name. Then start a
new view and choose your
data from the new Domain.

Domains provide advanced functionality
such as table joins and derived fields based
directly on a data source. Domains usually
require administrator permissions to create
and modify.

4.9.2.1 Access Permissions in Domain Topics

If other users create reports from your Domain Topic-based view, and the Domain is configured for security, it's
important to consider everyone’s access permissions. You might not have access to all of the fields in the
Domain nor to all the data in those fields. There may be fields that can be seen only by other users, and in the
fields that you can see, some data may be hidden from you. When you save the Domain as a Topic, only the
fields that you selected appear in the Domain Topic. When you create a view from the Topic, only the data that
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you can access in those fields appears. When others create views from the Topic, they see only fields that they
have permission to access. These rules also apply to the reports generated from these views.

For example, in a Domain, user Tomas can access fields B-C and data rows 1-3; Anita can access fields C-E and
data rows 2-5. Tomas uses the Data Chooser and saves a Domain Topic based on the Domain. When Tomas and
Anita create reports from the same view, they see different combinations of fields and the data in them.

Fields Data

Tomas's report from his Domain Topic B C 1 2 3

Anita’s report from the same Domain Topic C 2 3 4 5

Even though Anita has permission to see more fields, they're not available to her because Tomas did not have
access to them when he created the Domain Topic. However, Anita does have permission to see more data than
Tomas, so when she creates a view, or opens or runs the report based on that view, she can see more rows than
Tomas can when he views the report. See “Editing a Domain” on page 229 for a technical explanation of data
security for Domains. See the note in “Editing a Domain” on page 229 about the impact of editing a Domain
or Domain Topic.

4.9.2.2 Saving Domain Settings as a Domain Topic

To save settings in the Data Chooser wizard as a Domain Topic:
1. While making selections in the Data Chooser, navigate to the Save Topic page.
2. Enter a Topic name and description.

Do not change the location folder. Using the default /adhoc/topics folder makes the saved Domain Topic
available in the Ad Hoc Components > Topics folder when you select Create > Ad Hoc View.

3. If your data selections, filter definitions, and display settings are complete, click Table, Chart, or
Crosstab.

If settings are incomplete, navigate to the other pages to finish, then click Table, Chart, or Crosstab

The new Topic appears in the Ad Hoc Components > Topics folder.
Because a Domain Topic is a type of report, it appears when the Search page is filtered to show reports:

4.9.2.3 Editing a Domain Topic

You can modify a Domain Topic you created using the Data Chooser .

To edit the settings in a Domain Topic:
1. Select View > Repository and search (or browse) for the Domain Topic you want to modify. Domain

Topics are usually kept in the Ad Hoc Components > Topics folder.
2. Right-click the Domain Topic and select Open in Designer from the context menu. The Domain Topic

opens in the Data Chooser wizard.
3. Follow the guidelines in “Using the Data Chooser Wizard” on page 147 to edit the Domain Topic as

needed.
4. To save changes to the selected Domain Topic, click Table, Chart, or Crosstab on any page.
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Use caution when editing Domain Topics that may have been used to create other views. Users relying
on the Domain Topic might receive unexpected data or errors. It's safer to save changes as a new Domain
Topic.

To save changes as a new Domain Topic, navigate to the Save as Topic page and enter identifying information
for the new Topic, then click Table, Chart, or Crosstab.
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CHAPTER 5 ADDING REPORTS DIRECTLY TO THE REPOSITORY

This section describes functionality that can be restricted by the software license for JasperReports
Server. If you don’t see some of the options described in this section, your license may prohibit you from
using them. To find out what you're licensed to use, or to upgrade your license, contact Jaspersoft.

Using the Ad Hoc Editor, you can create reports within JasperReports Server from pre-defined Topics and
Domains. You can also create reports outside of JasperReports Server and add them to the repository. To add a
report to the repository, you need a valid JRXML file. To create and validate this file, you can use Jaspersoft
Studio. Jaspersoft recommends Jaspersoft Studio for most users because its graphical user interface simplifies the
job. If you have a thorough understanding of the file structure, you can use a text editor to create the file
containing JRXML code.

You can add a report to the server’s repository in two ways:
• From within the server

Add the JRXML file and any other resources the report needs as a report unit. A wizard guides you through
each step.

• From Jaspersoft Studio
Design the report in Jaspersoft Studio, and use a connection to JasperReports Server to add the JRXML and
resources to the JasperReports Server repository.

This chapter includes examples of adding a report to the repository using the server’s wizard and the plug-in.
The chapter contains the following sections:
• Overview of a Report Unit
• Adding a Simple Report Unit to the Server
• Adding a Complex Report Unit to the Server
• Adding Cascading Input Controls to a Report
• Editing JRXML Report Units
• Localizing Reports

5.1 Overview of a Report Unit
In the server, a report unit is the collection of elements used for retrieving data and formatting output. Figure 5-
1 on page 158 shows these elements:
• The data source and the query that retrieves data for the report.
• The main JRXML that determines the layout and is the core of the report unit.
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• The main JRXML defines other elements in one of the following ways:
• Creating definitions internally
• Referring to existing elements in the repository using the repo: syntax

• The input controls and other resources.

For more information about the report unit, refer to the JasperReports Server Ultimate Guide.

Figure 5-1 Anatomy of a Report Unit

5.2 Adding a Simple Report Unit to the Server
This section presents an example of uploading a JRXML to the server. The report only has two image resources.
The example defines a custom query for the report unit.

To add the simple report unit to the server, you need access to the following sample data installed with the
server:
• <js-install>/samples/reports/AllAccounts.jrxml
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• <js-install>/samples/images/logo.jpg files

5.2.1 Uploading the Main JRXML
If you want to validate the JRXML before uploading it, use Jaspersoft Studio. The server doesn’t validate the
JRXML when you upload it.

This procedure shows you how to set up a name for the report in the repository and upload the main JRXML
file that references all other elements.

To upload the main JRXML for the simple report example:
1. Log into the server as administrator and select View > Repository.

If you log in as a user, you can upload a report unit to the server, but this example requires an
administrator login to access the image resources.

2. Locate the folder where you want to add the report. For example, go to Organization > Reports.
3. Right-click the Reports folder and select Add Resource > JasperReport from the context menu. The Set

Up the Report page of the JasperReport wizard appears.

Add Resource appears on the context menu only if you have write permission to the folder.

4. In Naming, enter the name and description of the new report and accept the generated Resource ID:
• Name – Display name of the report: New Simple Report

• Resource ID – Permanent designation of the report object in the repository: New_Simple_Report
• Description – Optional description displayed in the repository: This is a simple example

5. Select Upload a Local File and Browse to <js-install>samples/reports/AllAccounts.jrxml.

You can upload a new JRXML or select a JRXML from the repository.

In Figure 5-2 you can see the Set Up the Report page.
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Figure 5-2 Required Set Up Values

6. Click Controls & Resources. The server uploads the main JRXML file. The Controls & Resources page
reappears. If the server needs additional resources to validate the report, you'll be prompted to locate those
resources.

Figure 5-3 Suggested Resources in the Resources List

A JRXML file doesn’t embed resources, such as images. When the server uploads the JRXML, it tries to
detect any missing resources. For example, Figure 5-3, “Suggested Resources in the Resources List,” on
page 160 shows that two image files are missing:
• Logolink
• AllAccounts_Res2
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5.2.2 Uploading Suggested File Resources
If needed files are missing, as shown in Figure 5-3. you need to take one of the following actions:
• Upload resources that the report needs
• Select a resource from the repository

If the Controls & Resources page doesn’t suggest resources, perhaps the report doesn’t reference any. However,
the server can’t always detect all the referenced resources, as discussed in “Uploading Undetected File
Resources” on page 168.

To upload suggested file resources for the simple report example:
1. Click Add Now in the row of the missing resource. For example, LogoLink. The Locate File Resource page

appears.
2. Choose Select a resource from the Repository and Browse to the needed file (Images/JR Logo).

Any image file works.

3. Click Select.
The path to the image appears in the wizard.

4. Click Next. The Add a Report Resource page appears.

Figure 5-4 Properties of a Resource

The properties include the LogoLink name, resource ID, and description. These properties don’t
redefine the properties of the JRLogo file in the repository.

5. Click Next to accept the default naming of the file resource.
The Controls & Resources page appears again, showing that the LogoLink resource was added.

6. Click Add Now in the AllAccounts_Res2 row. The Locate File Resource page appears again.
7. Select Upload a Local File and Browse to <js-install>/samples/images/logo.jpg.
8. Open logo.jpg, and click Next. The server uploads the file.

The Add a Report Resource page appears, showing the properties of the file resource.

TIBCO Software Inc. 161



JasperReports Server User Guide

The properties include the AllAccounts_Res2 name, resource ID, and description.

9. Click Next to accept the default naming of the file resource.
The Controls & Resources page reappears, showing the addition of both resources referenced in the main
JRXML.

10. Click Data Source and define a data source as described in the next section.

5.2.2.1 Referencing Styles

You can apply a style to your report by referencing a property sheet, created in Jaspersoft Studio, that contains
information on a style.

To do this, you will need to edit the Styles.jrxml file and change the <templates> statement.

To reference styles from an external property sheet:
1. Locate and open the Styles.jrxml file.
2. In the JRXML file, declare <template>"repo:styles"</template> (do not include the .jrtx extension).
3. Save the JRXML file.
4. Log into the sever as an administrator, and select View > Repository.
5. Expand the Organization folder.
6. Right-click the Reports folder and select Add Resource > JasperReport to open the Add JasperReport

wizard.
7. On the Set Up page, enter the required information.
8. Select Upload a Local File and click Browse...
9. Locate Styles.jrxml, and click Open.
10. Click Submit.
11. Copy the base_styles.jrtx file from the directory:

<jrs-install>\samples\templates\reports

and place into the C:\ directory.
12. Edit the styles.jrtx file and add C:\\ before base_styles.jrtx.
13. Back on the server, select View > Repository, then expand the Organization folder.
14. Right-click Images, and select Add Resource > File > Style Template.
15. Under Path to File, click Browse... then locate the style.jrtx file.
16. Enter a Name (Styles) and click Submit.
17. In the repository, open the Reports > Styles folder, then right click on Styles report and select Edit.
18. Click Control & Resources, then click the Add Resource... link.
19. Select Select a resource from the Repository radio button, Browse...
20. Locate Organization > Images > Styles, and click Select.
21. Click Next button
22. On the Add a Report Resource screen, enter Name: Styles, then click Next.
23. Click Submit
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5.2.3 Defining the Data Source
Data sources belong to the report engine, JasperReports Server, and are not defined in the main JRXML. The
JRXML does not retain data sources defined in Jaspersoft Studio when you add the JRXML to the server. You
need to define a data source for your report unit in the server. On the Data Source page, select a data source in
the repository or create a new data source on-the-fly. The data source can be different from the database
configured for JasperReports Server if the application server can find its driver. For example, in a default
installation of JasperReports Server, Tomcat looks for data source drivers in <js-install>/apache-tomcat/lib. Put a
copy of the driver in this location.

To define the data source for the simple report example:
1. In the JasperReport wizard, click Data Source. The Link a Data Source to the Report page presents these

choices:
• Do not link a data source – Select or define the data source at a later time. You see an error if you run

the report in this state.
• Click here to create a new data source – Define a new data source available only to your report.
• Select data source from repository – Select an existing data source from the repository.

2. Choose Select data source from the Repository and Browse to /Data Sources/JServer JNDI Data
Source. Click Select. The path to the data source appears.

Figure 5-5 Data Source Page

3. Click Query to define the Query as described in the next section.

5.2.4 Defining the Query
The query in the report unit determines the data that the server retrieves from a data source. You can use an
existing query or define a new one. You can create multiple reports that look the same but contain different data
by defining different queries for the same JRXML file. The simple report example uses a custom query that
returns accounts from a single country.

To define a custom query for the simple report example:
1. In the JasperReport wizard, click Query. The Locate Query page presents these choices:

• Do not link a Query – Select this option to use a query already defined within the main JRXML.
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• Click here to create a new Query – Guides you through defining a new query for this report only.
• Select a Query from the Repository – Select a query from the repository. The AllAccounts.jrxml file

uploaded in “Uploading the Main JRXML” on page 159 already contains a query. This example
overrides the existing query by defining a new one.

2. Select the Click here to create a new Query option.

Figure 5-6 Query Page

3. Click the link, Click here to create a new Query. The Name the Query page appears.
4. Enter the name, resource ID, and description of the query. In this example, the query must retrieve only

Canadian accounts. Enter the following values:
• Name – CanadaAccounts

• Resource ID – CanadaAccounts

• Description – Query for New Simple Report in User Guide

This query and its properties are visible only within the report unit.

Figure 5-7 Name the Query Page

5. Click Next. The Link a Data Source to the Query page appears. You can select a query from the repository,
define a new one, or select not to link a data source.
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6. Select Do not link a data source to use the data source you selected in “Defining the Data Source” on
page 163.

7. Click Next. The Define the Query page appears.
8. Select SQL in the Query Language drop-down and enter the following Query String to retrieve only

Canadian accounts:
SELECT * FROM accounts WHERE billing_address_country = ‘Canada’ ORDER BY billing_
address_city

Figure 5-8 Definition of a Query

9. Click Save to save the query. The Customization page appears. No customization is required for the
example.

10. Click Submit to submit the new report unit to the repository.

5.2.5 Saving the New Report Unit
To submit a new report unit to the repository, click Submit on any page of the JasperReport wizard, from the
Set Up page to the Customization page. You don’t have to set options you don't need, such as Customization.
When you click Submit, the server validates the report unit. If validation is successful, a message appears at the
top of the repository page, indicating that the report was saved. The report appears in the repository with the
description you entered on the Set Up page. To run the report and view the output, click its name, New Simple
Report.

Figure 5-9 New Simple Report Added to the Repository
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The following figure shows the output, only Canadian accounts.

Figure 5-10 Output of the New Simple Report

In the report viewer, click to go to the end of the report. The logo images that you added as file resources
appear.

5.3 Adding a Complex Report Unit to the Server
This section includes an example of how to add a report unit with all these resources:
• SalesByMonth.jrxml – the main JRXML file
• SalesByMonthDetail.jrxml – a subreport
• sales.properties – an English resource bundle file
• scriptlet.jar – a scriptlet class JAR file
• JR Logo – an image in the repository
• JServer JNDI data source – a data source file in the repository

These resources are part of the sample data installed with the server. To complete this example and run the
report without server errors, you need access to these resources.

The example also guides you through defining every type of input control:
• Text
• Check box
• Drop-down
• Date
• Query

If you’re not interested in creating all types of input controls, but want to work through part of the example,
delete parameters for the input controls you don’t create before you run the report.

The complex report you create in this example is almost exactly like the SalesByMonth report in the Reports
folder of the repository.

To upload the main JRXML and suggested resource files for the complex report unit:
1. Log into JasperReports Server as administrator and select View > Repository.
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If you log in as a user, you can upload a report unit to the server, but this example requires an
administrator login to access the image resources.

2. Navigate to the folder containing your report. For example, navigate to Organization > Reports.
3. Right-click the Reports folder and select Add Resource > JasperReport from the context menu. The Set

Up the Report page appears.

Add Resource appears on the menu only if you have write privilege to the folder.

4. Enter these properties:
• Name – New Complex Report

• Resource ID – New_Complex_Report

• Description – This is a complex report

5. Select Upload a Local File.
6. Click Browse to locate the file <js-install>/samples/reports/SalesByMonth.jrxml.
7. Click Controls & Resources.

On the Controls & Resources page, Figure 5-11, suggests resources to be uploaded for the report:
• A sub-report (the SalesByMonthDetail.jrxml file)
• A logo image

Figure 5-11 Suggested Resources for the Complex Report

8. On the Controls & Resources page, upload the sub-report:
a. Click Add Now in the SalesByMonthDetail row. The Locate File Resource page appears.
b. Select Upload a Local File.
c. Click Browse and locate the file <js-install>/samples/reports/SalesByMonthDetail.jrxml. Select

SalesByMonthDetail.jrxml.
The path to SalesByMonthDetail.jrxml appears in the Upload a Local File field.
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d. On the Locate File Resource page, click Next.
e. On the Add a Report Resource page, click Next to accept the default report resource name and resource

ID.
9. On the Controls & Resources page, upload the logo image resource:

a. Click Add Now in the Logo row. The Locate File Resource page appears.
b. On the Locate File Resource page, click Select a resource from the Repository.
c. Click Browse to locate the file /Images/JR Logo and select JR Logo.
d. Click Next. The Add a Report Resource page appears.
e. On the Add a Report Resource page, click Next to accept the default name, resource ID, and

description.

5.3.1 Uploading Undetected File Resources
The JasperReport wizard can’t detect every type of resource referenced in the main JRXML. You need to add
the undetected resources; so the server can validate the report. For the following example we provide the names
of these resources. To discover undetected resources open the JRXML in Jaspersoft Studio and examine its
parameters and properties. For more information about the JasperReports Server Plug-in, see the Jaspersoft
Studio User Guide.

These are the undetected resources in the SalesByMonth.jrxml:
• A scriptlet JAR – The scriptlet writes the message, “I’m a scriptlet in a jar,” to the last page of the report

output.
• An English language resource bundle.
• The optional Romanian language resource bundle.

If you’re interested in working with a multi-lingual report, add the Romanian resource bundle. The
Romanian resource bundle is part of the sample data installed with the server.

On the Controls & Resources page, upload the undetected resources to the server using exactly the same name
Jaspersoft Studio uses for the resource ID.

To upload the undetected file resources for the complex report example:
1. Add and upload the scriptlet JAR file:

a. On the Controls & Resources page, click Add Resource.
b. On the Locate File Resource page, select Upload a Local File and click Browse to locate the <js-

install>/samples/jars/scriptlet.jar file. Select scriptlet.jar.
The path to the file appears in the Upload a Local file field.

c. Click Next.
The Add a Report Resource page appears. Figure 5-12 on page 169 shows the file name scriptlet.jar,
indicating that the server successfully loaded and automatically detected the JAR.

d. Enter the following information:
• Name – Scriptlet

• Resource ID– Scriptlet. The Resource ID is referenced in the main JRXML file, so do not
change it.

• Description – Scriptlet JAR for complex report

Figure 5-12 on page 169 shows these values entered on the Add a Report Resource page.
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Figure 5-12 Scriptlet JAR Resource Properties

2. Click Next.
3. Add and upload the English resource bundle:

a. On the Controls & Resources page, click Add Resource. The Locate File Resource page appears.
b. Select Upload a Local File, click Browse to locate the file <js-install>/samples/resource_

bundles/sales.properties, and select it. The path to the resource bundle appears in the Upload a Local
file field.

c. In Locate File Resource, click Next. The Add a Report Resource page indicates that the file was
successfully loaded and automatically detected as a resource bundle.

d. Enter the following information:
• Name – sales.properties

• Resource ID – sales.properties

• Description – Default English resource bundle

4. Click Next.
5. Add and upload the Romanian Resource bundle:

a. On the Controls & Resources page, click Add Resource.
b. Select Upload a Local File, click Browse to locate the file <js-install>/samples/resource_

bundles/sales_ro.properties, and select it.
c. In Locate File Resource, click Next. The Add a Report Resource page shows that uploading the file

was successful. The server recognized the type (resource bundle) and name (sales_ro.properties) of the
selected resource.

d. Enter the following information:
• Name – sales_ro.properties

• Resource ID – sales_ro.properties

• Description – Romanian resource bundle

e. Click Next. Controls & Resources lists all the files.
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Figure 5-13 List of Detected and Undetected File Resources

If you want to upload a different file for a named resource, click its resource ID in the Resources list and
locate the new file or repository object. You can change the name and description of the resource, but not its
resource ID. If there’s a mistake in a resource ID:
• Locate the ID in the list of resources on the Controls & Resources page, and click Remove.
• Re-add the resource, entering the correct resource ID.

5.3.2 Adding Input Controls
Input controls are graphical widgets the server displays with the report. Input controls perform the following
functions:
• Prompt the user for input
• Validate the format of the input
• Pass the input to the report

Based on the input, the server modifies the WHERE filter clauses in SQL parametrized queries.

Input controls correspond to the parameters defined in JRXML reports, such as $P{name}. The server maps the
value the user enters for the input control to the parameter of the same name. If you define an input control in
the JasperReport and the server can’t find a parameter by the same name in the JRXML, the input control won’t
function when the report runs.

The JRXML can define a default value for the input control. To prevent users from changing the default,
you can make the input control read-only or invisible.

When you create an input control, you provide a datatype. Datatypes define the expected input (numbers, text,
date, or date/time) and can include range restrictions that the server enforces. The server uses the datatype to
classify and validate the data.
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To define a datatype, set properties on the Set the Datatype Kind and Properties page. Properties differ for other
datatypes that appear on the page.

Type The classification of the data, which can be Text, Number, Date, or Date-Time.

Name The name of the datatype.

Resource ID The unique ID of the datatype that you cannot edit.

Description Any additional information you provide about the datatype.

Pattern A regular expression that restricts the possible values of the field for the Text data type.

Minimum value The lowest permitted value for the field.

Maximum value The highest permitted value for the field.

Minimum Is Strict If checked, the maximum value itself is not permitted; only values less than the
maximum value are permitted.

Maximum Is Strict If checked, the minimum value itself is not permitted; only values greater than the
minimum value are permitted.

After determining the list of values to be presented to the user, choose one of these widget types for the input
control:
• Boolean – A check box widget for entering a yes/no value.
• Single value – A text, number, date, or date/time widget. Input can be constrained to a minimum value,

maximum value, or both. Text input can also be constrained by a matching pattern. A text box widget for
entering a value, or a calendar for selecting date and date/time.

• Multiple values – To present a static or a dynamic list of values to the user, choose one of these:
• Drop-down list to select a single value
• Radio buttons to select a single value
• Multi-select list to select multiple values
• Check boxes to select multiple values

The query in the SalesByMonth.jrxml file has several input control parameters, one for each type of input
control. These procedures show you how to add each type to the report unit.

5.3.2.1 Adding a Text Input Control

The simplest input control is a text box. In this example, the datatype for the input value is a number; the server
verifies that the user enters a number into the text box.

To add a text input control to the complex report example:
1. After completing steps in “Uploading Undetected File Resources” on page 168, click Controls &

Resources in the JasperReport wizard.
2. On the Controls & Resources page, click Add Input Control. The Locate Input Control page appears.
3. Select Define an Input Control in the next step.
4. Click Next.
5. On the Create Input Control page, accept the default (Single Value) from the Type drop-down.
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6. Enter the other properties for the input control:
The name is referenced in the main JRXML file, so enter it exactly as shown.
• Prompt Text – The label the user sees next to the widget for this input: Text Input Control

• Parameter Name – The name of the report parameter that receives the user value: TextInput
• Description – An optional description that appears only within the report wizard: leave blank in this

example.
• Mandatory, Read-only, Visible – A setting that determines how the input control is displayed: check

only Visible.

Figure 5-14 Properties of the Text Input Control

To reuse an input control, add it to the repository independent of any report using Add Resource >
Input Control. Before using the input control in a report, check that the parameter name in the JRXML
matches the name in the Create Input Control page. If it doesn't the server can’t run the report.

7. Click Next.
8. In Locate Datatypes, select Define a DataType in the next step and click Next:

Instead of defining a datatype, you can use one in the repository if its type and range are compatible
with your input control.

9. In Set the Datatype Kind and Properties, enter the properties for the datatype:
a. In Type, select Number from the drop-down as the type of data the user can enter.

The number format allows users to enter integers and decimals.
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b. Enter a name – Integer Type

c. Enter a resource ID – Integer_Type

The name and resource ID are required, but are visible only when defining the input control.

Figure 5-15 Integer Datatype Properties

d. Leave these properties blank in this example:
• Description – An optional description that appears only within the report wizard.
• Minimum value – The lower bound of the value the user may enter.
• Maximum value – The upper bound of the value the user may enter.
• Minimum is strict – Means the minimum value itself is not allowed.
• Maximum is strict – Means the maximum value itself is not allowed.

10. Click Save.
The Controls & Resources page now lists the Text Input Control.
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Figure 5-16 Text Input Control in Input Controls List

5.3.2.2 Adding a Simple Check Box Input Control

A check box input control accepts true/false (boolean) input from the user.

To add a simple check box input control to the complex report example:
1. Continuing with the previous example, on the Controls & Resources page, click Add Input Control.
2. On the Locate Input Control page, click Define an Input Control in the next step.
3. Click Next.
4. On the Create Input Control page, select Boolean from the Type drop-down.
5. Enter the other properties:

• Prompt Text – Check Box Input Control

• Parameter Name – CheckboxInput. Enter the parameter name exactly as shown because the main
JRXML file references this name.

• Description – Leave blank in this example.
• Mandatory, Read-only, Visible – Check only visible.

6. Click Submit. The Controls & Resources page appears with the new check box input control.

5.3.2.3 Adding a Drop-Down Input Control

The drop-down input control, also called a list, gives the user a pre-determined list of choices. As a report
designer, you make these decisions about a drop-down input control:
• To present a single-select or multi-select list to the user
• To present a single choice as a drop-down list or a set of radio buttons
• To present a multi-select control as a multi-select list or a set of check boxes

Radio buttons and check boxes usually work well for five or fewer choices. This example shows how to create
an input control that presents three choices in a drop-down list. You can create a new list of values for this
input control or use a list of values in the repository.
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To add a drop-down input control to the complex report example:
1. Continuing with the previous example, on the Controls & Resources page, click Add Input Control.
2. On the Locate Input Control page, click Define an Input Control in the next step.
3. Click Next.
4. On the Create Input Control page, select Single-select List of Values from the Type drop-down.
5. Enter the other properties:

• Prompt Text – List Input Control

• Parameter Name – ListInput Enter the parameter name exactly as shown because the main JRXML
file references this name.

• Description – Leave blank in this example.
• Mandatory, Read-only, Visible – Check only visible.

6. Click Next.
7. On the Locate List of Values page, select Define a list of values in the next step.

Instead of defining a list of values, you can use one in the repository if its values are compatible with
the parameter defined in the JRXML report.

8. Click Next.
9. On the Add List of Values page, enter a name, resource ID, and optional description for the list of values.

These properties aren’t visible outside of the input control. Enter these values:
• Name – list type

• Resource ID – list_type

• Description – Leave blank in this example.
10. In the Name Value panel, enter names and values to present as choices to the user:

• Enter unique names. The server requires unique names to distinguish which item the user chose.
• Enter values of the type that match the parameter definition in the JRXML report.
After entering a name and value, click Add. If you make a mistake click Remove.
For this example enter:
• Name First Item with value 1.
• Name Second Item with value 2.
• Name Third Item with value 3.
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Figure 5-17 Definition of the List of Values

11. Click Submit. The Controls & Resources page appears with the new List Input control.

5.3.2.4 Adding a Date Input Control

This example uses a datatype from the sample data in the repository.

To add a date input control to the complex report example:
1. On the Controls & Resources page click Add Input Control.
2. On the Locate Input Control page select Define an Input Control in the next step, then click Next.
3. On the Create Input Control page, select Single-Value from the Type drop-down.
4. Enter the other properties:

• Prompt Text – Date Input Control

• Parameter Name – DateInput Enter the parameter name exactly as shown because the main JRXML
file references this name.

• Description – Leave blank in this example.
• Mandatory, Read-only, Visible – Check only Visible.

5. Click Next.
6. On the Locate Datatypes page select Select a Datatype from the Repository.
7. Click Browse.
8. In Select Resource from Repository, expand Input Data Types, and select the Date Datatype.
9. Click Select. The Locate DataTypes page shows the location of this datatype in the repository,

/datatypes/DateDatatype.
10. Click Next. The Controls & Resources page appears with the new Date Input Control.
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5.3.2.5 Adding a Query-Based Input Control

A query-based input control presents a dynamically-created list of choices to the user. The server performs a
query whose results are used to create the list of choices. You must perform the following tasks:
• Configure the query.
• Designate how to display the results in the input control.
• Specify the value to pass as the corresponding parameter.

To add a query-based input control to the complex report example:
1. On the Controls & Resources page, click Add Input Control.
2. On the Locate Input Control page, select Define an Input Control in the next step.
3. Click Next.
4. On the Create Input Control page, select Single-select Query from the Type drop-down.
5. Enter the naming properties for the input control:

• Prompt Text – Query Input Control

• Parameter Name – QueryInput Enter the parameter name exactly as shown because the main JRXML
file references this name.

• Description – Leave blank in this example.
• Mandatory, Read-only, Visible – Use the default settings in this example.

6. Click Next. The Locate Query page appears. Options are:
• To locate a reusable query in the repository
• To define a new query dedicated to this input control

7. For this example, select Define a Query in the next step.
8. Click Next.
9. On the Name the Query page, enter naming properties for the new query. For this example, enter

testQuery in both the Name and Resource ID fields.

Figure 5-18 Entering a Query Name
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10. Click Next. The Link a Data Source to the Report page appears. Options are:
• To use the same data source for the input control as you use for the report
• To define a new data source, dedicated to this input control
• To select a reusable data source from the repository

11. For this example, select Do not link a data source to use the same data source for the input control as
you use for the report. You will select the data source for the report in “Selecting a Data Source for
Running the Complex Report” on page 180.

Figure 5-19 Data Source Link for the Query Input Control

12. Click Next.
13. On the Define the Query page, select SQL from the Query Language drop-down.
14. Enter this Query String to retrieve the labels and values to be displayed for this input control:

SELECT user_name, first_name, last_name FROM users
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Figure 5-20 Query String Definition

15. Click Save.
16. For each row in the results of the query, the server presents a single value, such as Sarah Smith, in the input

type widget (drop-down, radio buttons, multi-choice, check boxes). On the Query Information page, name
the database columns to comprise the input value presented to the user. The column names must exactly
match those in the SELECT clause of the query string:
a. In the Value Column enter the user_name.
b. In the Visible Column enter first_name.
c. Click Add.
d. In the Visible Column enter last_name.
e. Click Add.

For each column you want to display as a choice, enter the name then click Add. If you make a
mistake click Remove.

17. Click Submit. The Controls & Resources page displays all the resources, including the new input controls.
Figure 5-21 on page 180 shows these resources.

5.3.2.6 Setting the Input Control Options

In this procedure, you set the display mode in Input Control Options at the bottom of the Controls &
Resources page. These options appear only after you add an input control to the report. Figure 5-21 on page
180 shows these options.

To configure the appearance of the input controls for the complex report example:
1. Select Pop-up window.

You can also select Separate page to display the input controls in a separate browser window, Top of
page to display them above the report, or In page to display them on the side of the report.

2. Check Always prompt when you want the server to display the Input Controls dialog to prompt the user
when the report runs.

The definition of input controls in this example specified Visible and not Mandatory. When input controls
aren’t mandatory and Always prompt isn’t checked on the Controls & Resources page, the user must click
the Options button in the report viewer to change input controls; otherwise the report runs with default
input controls

3. Leave Optional JSP Location blank for this example.
You can use the Optional JSP Location option to specify the path to a JSP file that affects the appearance
of the input controls.
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Figure 5-21 Input Controls and Resources

Select the data source to finish the complex report example.

5.3.3 Selecting a Data Source for Running the Complex Report
You select a data source to retrieve data for the report and the query input control; otherwise the report and the
list of users in the query input control will be blank.

To select a data source and run the complex report:
1. On the Controls & Resources page of the JasperReport wizard, select Data Source.
2. On the Locate Data Source page, choose Select data source from repository.
3. Click Browse, choose Organization > Data Sources > JServerJNDI Data Source, and lick Select.
4. On Link a Data Source to the Report, click Submit.
5. On the Locate Query Page, click Submit again to save the complex report.

Skip the Query and Customization pages of the JasperReport wizard to use the default settings on those
pages.
The server validates the report and a message appears indicating that the report was added to the repository.

6. In the Repository, click the name New Complex Report to run and view the report.
Input controls appear.

7. Enter these input values, as shown in Figure 5-22:
a. Text Input Control: myText
b. Check Box Input Control: Check the checkbox.
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c. List Input Control: Select Third Item.
d. Date Input Control: Click and select December 31, 2010.
e. Query Input Control: Select Sarah Smith from the drop-down.

Figure 5-22 Input Controls Dialog for the New Complex Report

8. Click OK or Apply to run the report with the selected input, including the incorrect non-numerical input
for the Text Input Control.
The server enforces the proper format defined for each input control. You defined the Text Input Control as
a numeric type, so it accepts only valid numbers, as indicated by the message to specify a valid float
number, as shown in Figure 5-23.
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Figure 5-23 Invalid Input Message

9. In Text Input Control, enter 3 and click OK or Apply.
The sample report includes a header that displays the value of each parameter received from the input
controls. Values and labels appear in the language specified by the active resource bundle, in this case
English.

Figure 5-24 Output Controlled by Input

In the report viewer, you can open the Input Controls dialog at any time by clicking the Options button.
Click OK to run the report using the chosen values and close the Input Controls dialog; click Apply to run
the report using the chosen values, but keep the Input Controls open for choosing other values and re-
running the report.
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If you get an error when you run the report, open it for editing as described in “Editing JRXML Report
Units” on page 183. Review your settings. If you can’t find the problem, edit the SalesByMonth sample
report (in the repository at /reports/samples) and compare its settings to your report.

To see the message written by the scriptlet JAR on the last page of the report, click in the report
viewer.

5.4 Adding Cascading Input Controls to a Report
JRXML-based reports can include input controls that have dynamic values. The values depend on a user's
selection in other input controls. For example, a report has input controls for country, state, and city. The
options in the State input control depend on the value selected in the Country input control. When the user
selects a state, the list of City values includes only those in the selected state. These cascading input controls
use queries to determine the values to display in each input control field.

To use input controls as parameters for a query that populates another input control, you use a special syntax to
reference a parameter name in the input control's query. The syntax is identical to the $P{parameter_name}
and $X{...} syntax used in queries for .

For example, a report returns data identified by country and city. It includes input controls called COUNTRY
and CITY. COUNTRY is a query-based input control that returns the list of countries in the data source. CITY
is also a query-based input control, but its query uses COUNTRY as input:

select address_city from accounts where $X{EQUALS, address_country, COUNTRY}

When the user selects a country from the COUNTRY input control, the value selected is used by the query of
the CITY input control. The CITY input control is refreshed to show the list of cities for the chosen country.
Making two selections from smaller lists is much clearer and quicker for report users. For an example of viewing
a report that has cascading input controls, see “Cascading Input Controls” on page 68.

Note that there are other ways to use a parameter in a query. For details about the $P and $X syntax and an
example of creating a cascading input control, see the JasperReports Server Administrator Guide.

5.5 Editing JRXML Report Units
After you add a report unit to the repository, you can edit any of its elements, including file resources and input
controls. This example modifies the display text of the ambiguous Text Input Control.

To edit the complex report example:
1. Log into the server as an administrator and select View > Repository

If you log in as a user, you can edit a report that you created. This example requires an administrator login
because an administrator created the complex report.

2. Search or browse the repository to locate the report. In this example, go to Organization > Reports.
3. Right-click the New Complex Report and select Edit from the context menu. The JasperReport wizard

opens the report unit.
4. Navigate to the page of the wizard for making the change; in this example, click Controls & Resources.
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5. Make changes to an input control prompt and the display mode of the input controls, for example:
a. Click the name of the TextInput control. The Locate Input Control page shows that this input control

is locally defined.
b. Click Next. The Create Input Control page appears.
c. Change the contents of the Prompt Text field to Enter a number. Click Next. The Locate Datatypes

page appears. You can select a different datatype from the repository. For this example, accept the
existing datatype setting.

d. In Locate Datatypes, click Next.
e. In Set the Datatype Kind and Properties, click Save to accept the datatype property settings.

6. On the Controls & Resources page:
a. Change the Display Mode to In Page.
b. Clear the Always prompt check box.
c. Click Submit.

7. Run the New Complex Report again.
Instead of appearing in a pop-up before the report, the input controls appear in the Filters panel of the
report. In Figure 5-25 you can see the new prompt Enter a number for the text input control. Because
none of the input controls in this example are required, the report can display with blank input controls.
Enter values and click Apply to modify the report output according to your input.

Figure 5-25 Output of the Modified Report

5.6 Localizing Reports
You can adapt reports to global audiences by localizing input controls and field names:
• Input controls – The server supports multi-lingual prompts and static lists of values in reports.
• Field names – The server supports multi-lingual field names in reports.

A $Rexpression that you write in the report design triggers linguistic changes in the report output for different
locales. Each $R expression refers to a name-value pair (your translations) in a resource bundle. A resource
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bundle file is a text file that has a .properties extension. You create a resource bundle in Jaspersoft Studio or
a text editor. You set the base name of the resource bundle in the header of the JRXML file:

<jasperReport name=”StoreSales” pageWidth=”595” pageHeight=”842” columnWidth=”515”
leftMargin=”40” rightMargin=”40” topMargin=”50” bottomMargin=”50”
resourceBundle=”simpleTable”>

For example, simpleTable is the base name of the resource bundle file for this report. If you prefer using a
graphical user interface to coding in XML, use Jaspersoft Studio to set the base name of the resource bundle.

5.6.1 Running a Localized Report
In this procedure, you run the Romanian version of the complex report that you added in “Uploading
Undetected File Resources” on page 168.

To run the Romanian version of the complex report:
1. Choose the Romanian locale on the login page of the server, and login as an administrator.
2. Click View > Repository, and navigate to Organization > Reports.
3. Click the name of the complex report, New Complex Report. The Input Controls dialog appears.
4. Enter input control values:

a. Text Input Control: 3
b. Check Box Input Control: Check the check box.
c. List Input Control: Select Third Item.
d. Date Input Control: Click and select March 31, 2010.
e. Query Input Control: Select Sarah Smith from the drop-down.
f. Click OK.
The fields in the title band and column names (sales person, sales account, and sales amount), shown in
Figure 5-26, appear in the language set by the Romanian resource bundle sales_ro.properties:

title=Raport al v\u00E2nz\u0103rilor lunare
sales.person=Agent de v\u00E2nz\u0103ri
sales.account=Client
sales.amount=Sum\u0103
param.number=Num\u0103r
param.date=Dat\u0103

The currency and dates in the report output header map to Romanian locale settings.
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Figure 5-26 A Report Localized for the Romanian Locale

By default, the web interface elements appear in US English when you choose an unsupported locale, such as
the Romanian locale. If you choose a supported language, the web interface elements appear in that language.
Supported languages are Chinese (Simplified), French, German, Japanese, and Spanish. You can customize the
server to support additional languages. You can translate the web interface into a different language, server
property names, and messages in another language. For some locales, you may also need to change the default
locale and time zone. For more information about localizing the server, see the JasperReports Server
Administrator Guide.

5.6.2 Adding Multi-lingual Prompts to Input Controls
This section describes how to create an Ad Hoc report that prompts for input in multiple languages. The tasks
are:
• Set the base name of the resource bundles in the JRXML Topic.
• Create resource bundles that contain translations for the prompts.
• Create an Ad Hoc report based on the JRXML Topic.
• Edit an input control to make prompts multi-lingual.
• Upload the resource bundles.
• Run the report and use the localized input control.

The order of these tasks is important: Set the base name of the resource bundle in the JRXML Topic first, then
create the Ad Hoc report. If you open the JRXML Topic after creating an Ad Hoc report, Jaspersoft Studio
removes grouping or sorting of data if there is any.

To set the base name of the resource bundles in the JRXML Topic:
1. Start Jaspersoft Studio. In Jaspersoft Studio, click Window >JasperReports Server Repository. The

Repository Navigator appears. This is where you set up a connection to the server.
2. Navigate to Ad Hoc Components > Topics and right-click the JRXML topic for this report:

Parametrized Report.
3. Select Copy.
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4. Navigate to the Reports folder, right-click and select Paste. The Parametrized Report topic appears in
Reports.

5. To open the topic in the Designer tab, expand the Parametrized Report folder and double-click its main
JRXML: ParametersJRXML_label. The Shipping Report appears in the Designer tab.

6. Click Window > Report Inspector.
7. In the Report Inspector, right-click the root node: ParamMany and choose Properties. In the main

JRXML, ParamMany is the report name.
In Figure 5-27, you can see the ParamMany root node and Properties context menu.

Figure 5-27 Selecting Properties of the ParamMany report

8. In the ParamMany Properties dialog, set the base name of the resource bundle to freight:
a. Scroll down to the Resource bundle property.

b. Click .
c. Enter freight and click OK .

In Figure 5-28, you can see the properties of the ParamMany report.

Figure 5-28 Setting the Base Name of the Resource Bundle
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9. Click Close.
10. Click File > Save to save the resource bundle name to the JRXML.
11. In the Repository Navigator, right-click ParametersJRXML_label and choose Replace with Current

Document.

Figure 5-29 Saving the Current Document in iReport to the Repository

The modified JRXML with a base resource bundle name overwrites the Parametrized Report Topic in the
repository.

To create resource bundles that contain translations for prompts:
1. In a text editor, create a new file for English translations.
2. Enter these name-value pairs in the file:

BundleCountry = Country
BundleDate = Date
BundleOrder= Order

3. Save the file as freight.properties.

The file name of the default (English) resource bundle consists of the base name of the resource
bundle and the properties extension.

4. In a text editor, create a new file for French translations and enter these name-value pairs in the file:

BundleCountry = Pays
BundleDate = Date
BundleOrder = Pour ID

5. Save the file as freight_fr.properties.
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The file name of a localized resource bundle follows this Java naming convention:

<default_file_name>_<locale>.properties

• <default_file_name> is the base name of the resource bundle
• <locale> is a Java-compliant locale identifier

To create an Ad Hoc View based on the JRXML Topic:
1. Log into the server as administrator, and choose Create > Ad Hoc View.

2. In the Select Data wizard, click and navigate to Ad Hoc Components > Topics and choose
Parametrized Report.

3. Click Table. The Parametrized Report topic (a blank report) opens in the Ad Hoc Editor.
4. In the Measures list, double-click these fields:

• Order ID
• Freight

5. In the Fields list, right-click Customer Id and select Add as Group.
6. Click Click to add a title and enter Multi-lingual Input Prompts View.

Figure 5-30 Creating an Ad Hoc View

7. Click and select Save Ad Hoc view As and Create Report. In the Save As dialog, select the Ad
Hoc Reports folder, and enter:
• Data View Name: Multi-lingual Input Prompts View

• Data View Description: A report that prompts for input in French and English.

• Report Name: Multi-lingual Input Prompts View Report

8. Browse to a location to save both the view and report.
9. Click Default Report Template.
10. Click Save.

To edit an input control to make prompts multi-lingual:
1. In the server, click View > Repository.
2. Locate the Multi-lingual Input Prompts View Report, right-click it, and choose Edit. The JasperReport

wizard appears.

TIBCO Software Inc. 189



JasperReports Server User Guide

3. Click Controls & Resources. The Controls & Resources page lists these input controls:
• Country
• RequestDate
• OrderID

4. Click the Country input control.
5. On the Locate Input Control page, click Next to define an input control in the next step.
6. On the Create Input Control page, change the prompt text from Country to this expression:

$R{BundleCountry}

In Figure 5-31 this expression is entered in the prompt text field.

Figure 5-31 Entering a $R Expression in the Prompt Text Field

7. Click Next.
8. Accept the default settings on subsequent pages by clicking Next and Save:

a. On the Locate Query page, click Next.
b. On the Name the Query page, click Next.
c. On the Link a Data Source to the Query page, click Next.
d. On the Define the Query page, click Save.

9. On the Set Parameter Values page, click Submit.
The Controls & Resources page now shows the $R{BundleCountry} expression instead of Country at the
top of the list of input controls.
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Figure 5-32 Input Controls Include One Multi-lingual Input Control

10. Change the prompt text of the other input controls in a similar manner:
a. Repeat step 4 through step 6 to change the RequestDate and OrderID input controls to these

expressions:
RequestDate: $R{BundleDate}
OrderID: $R{BundleOrder}

b. Accept the default settings on subsequent pages of the JasperReport wizard by clicking Next and
Save. The Controls & Resources page now shows the $R expressions for all three input controls.

To upload the resource bundles:
1. On the Controls & Resources page, click Add Resource. The Locate File Resource page appears.
2. Select Upload a Local File.
3. Click Browse, select the freight.properties file, and click Open.
4. On the Locate File Resource page, click Next.

On the Add a Report Resource page, freight.properties appears as the Selected Resource, indicating that the
server automatically detected it as a resource bundle.

5. On the Add a Report Resource page, enter these properties:
• Name – freight.properties

• Resource ID – freight.properties

• Description – Default English resource bundle

6. Click Next. The list of resources on the Controls & Resources page now includes the resource bundle
freight.properties.

7. On Controls & Resources, click Add Resource again, but this time upload the French resource bundle:
a. On the Controls & Resources page, click Add Resource again.
b. Select Upload a Local File, click Browse, select the freight_fr.properties file you created, and click

Open.
c. In Locate File Resource click Next. The Add a Report Resource page appears.
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d. Enter the following information:
• Name – freight_fr.properties

• Resource ID – freight_fr.properties

• Description – French resource bundle

8. Click Next. The Controls & Resources page shows the English and French resource bundles in the resources
list.

9. Click Submit.

To run the report and use the localized input control:
1. Click Log Out.
2. On the Login page click Show locale & time zone.
3. Select the en_US-English (United States) locale and log into the server as an administrator.
4. Run the Multi-lingual Input Prompts Report. The report appears in the report viewer.

Figure 5-33 Viewing the Report in English

5. Click Options.
The input controls appear with English prompts.

6. Click Log Out.
7. On the Login page, click Show locale & time zone.
8. Select the fr - French locale, and log in as administrator.
9. Run the report again and click Options.

In Figure 5-34, you can see the input controls that with English and French prompts.
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Figure 5-34 Input Control Prompts in English and French

5.6.3 Reusing Resource Bundles
The location of a resource bundle determines whether it's reusable and the conditions under which the server
uses it. To resolve a $R expression in a report, the server scans resource bundles at two levels in the order
described in this table.

Order Level Description

1 Report/
Repository

A report-level bundle declares the resource bundle base name in the header of its
JRXML file. The Romanian resource bundle is a report-level bundle. A repository-level
bundle is independent of any specific report and can be linked to multiple reports, as
described in “Locale Bundles” on page 271).

2 Server A server-wide bundle typically contains server messages and labels of user interface
components, as described in the JasperReports Server Administrator Guide. This
bundle typically resides in the WEB-INF/bundles directory of the server.

First, the server searches the report/repository level and stops scanning resource bundles if it finds a resolution to
the $R expression. If the server does not find a resolution, it scans the server level for the resource ID of the
field and uses this ID.

5.6.4 Using Default Fonts in JasperReports Server
By default, the server uses three fonts for reports:
• DejaVu Sans
• DejaVu Serif
• DejaVu Sans Mono

Using the DejaVu fonts shipped with the server ensures availability of fonts in all environments; the PDF is
pixel-perfect every time.
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The DejaVu fonts replace the Java logical fonts used in previous versions of the server:
• SansSerif
• Serif
• Monospaced

SansSerif, Serif, Monospaced can still be used, but are deprecated because these Java logical fonts map
to different TTF files in different environments, and run the risk of text being cut when exported to PDF due
to font metric mismatches. Also, these Java logical fonts aren't recognized by some browsers, resulting in
font substitutions. For example, Firefox in a Windows environment renders the SansSerif logical font as
Serif.

When using the DejaVu fonts coming from font extensions, you don’t need to set any other font attributes (such
as the pdfXXX attributes) in the JRXML or specify font mapping. The font extension file that makes these fonts
available sets font attributes and mapping.

For more information about DejaVu, refer to its SourceForge project at:
http://dejavu-fonts.org/wiki/index.php?title=Main_Page.

When you upload a TrueType font to the repository, the file name must include the correct extension
(.TTF).
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Ad Hoc Editor

The interactive data explorer in JasperReports Server Professional and Enterprise editions. Starting from a
predefined collection of fields, the Ad Hoc Editor lets you drag and drop fields, dimensions, and measures to
explore data and create tables, charts, and crosstabs. These Ad Hoc views can be saved as reports.

Ad Hoc Report

In previous versions of JasperReports Server, a report created through the Ad Hoc Editor. Such reports could be
added to dashboards and be scheduled, but when edited in Jaspersoft Studio, lost their grouping and sorting. In
the current version, the Ad Hoc Editor is used to explore views which in turn can be saved as reports. Such
reports can be edited in Jaspersoft Studio without loss, and can be scheduled and added to dashboards.

Ad Hoc View

A view of data that is based on a Domain, Topic, or OLAP client connection. An Ad Hoc view can be a table,
chart, or crosstab and is the entry point to analysis operations such as slice and dice, drill down, and drill
through. Compare OLAP View. You can save an Ad Hoc view as a report in order to edit it in the interactive
viewer, schedule it, or add it to a dashboard.

Aggregate Function

An aggregate function is one that is computed using a group of values; for example, Sum or Average. Aggregate
functions can be used to create calculated fields in Ad Hoc views. Calculated fields containing aggregate
functions cannot be used as fields or added to groups in an Ad Hoc view and should not be used as filters.
Aggregate functions allow you to set a level, which specifies the scope of the calculation; level values include
Current (not available for PercentOf), ColumnGroup, ColumnTotal, RowGroup, RowTotal, Total

Analysis View

See OLAP View.

Audit Archiving

To prevent audit logs from growing too large to be easily accessed, the installer configures JasperReports Server
to move current audit logs to an archive after a certain number of days, and to delete logs in the archive after a
certain age. The archive is another table in the JasperReports Server's repository database.

Audit Domains

A Domain that accesses audit data in the repository and lets administrators create Ad Hoc reports of server
activity. There is one Domain for current audit logs and one for archived logs.
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Audit Logging

When auditing is enabled, audit logging is the active recording of who used JasperReports Server to do what
when. The system installer can configure what activities to log, the amount of detail gathered, and when to
archive the data. Audit logs are stored in the same private database that JasperReports Server uses to store the
repository, but the data is only accessible through the audit Domains.

Auditing

A feature of JasperReports Server Enterprise edition that records all server activity and allows administrators to
view the data.

Calculated Field

In an Ad Hoc view or a Domain, a field whose value is calculated from a user-defined formula that may include
any number of fields, operators, and constants. For Domains, a calculated field becomes one of the items to
which the Domain's security file and locale bundles can apply. There are more functions available for Ad Hoc
view calculations than for Domains.

CRM

Customer Relationship Management. The practice of managing every facet of a company's interactions with its
clientele. CRM applications help businesses track and support their customers.

CrossJoin

An MDX function that combines two or more dimensions into a single axis (column or row).

Cube

The basis of most OLAP applications, a cube is a data structure that contains three or more dimensions that
categorize the cube's quantitative data. When you navigate the data displayed in an OLAP view, you are
exploring a cube.

Custom Field

In the Ad Hoc Editor, a field that is created through menu items as a simple function of one or two available
fields, including other custom fields. When a custom field becomes too complex or needs to be used in many
reports, it is best to define it as a calculated field in a Domain.

Dashboard

A collection of reports, input controls, graphics, labels, and web content displayed in a single, integrated view.
Dashboards often present a high level view of your data, but input controls can parametrize the data to display.
For example, you can narrow down the data to a specific date range. Embedded web content, such as other web-
based applications or maps, make dashboards more interactive and functional.

Dashlet

An element in a dashboard. Dashlets are defined by editable properties that vary depending on the dashlet type.
Types of dashlet include reports, text elements, filters, and external web content.

Data Island

A single join tree or a table without joins in a Domain. A Domain may contain several data islands, but when
creating an Ad Hoc view from a Domain, you can only select one of them to be available in the view.

Data Policy

In JasperReports Server, a setting that determines how the server processes and caches data used by Ad Hoc
reports. Select your data policies by clicking Manage > Server > Settings Ad Hoc Settings. By default, this
setting is only available to the superuser account.
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Data Source

Defines the connection properties that JasperReports Server needs to access data. The server transmits queries to
data sources and obtains datasets in return for use in filling reports and previewing Ad Hoc reports.
JasperReports Server supports JDBC, JNDI, and Bean data sources; custom data sources can be defined as well.

Dataset

A collection of data arranged in columns and rows. Datasets are equivalent to relational results sets and the
JRDataSource type in the JasperReports Library.

Datatype

In JasperReports Server, a datatype is used to characterize a value entered through an input control. A datatype
must be of type text, number, date, or date-time. It can include constraints on the value of the input, for example
maximum and minimum values. As such, a datatype in JasperReports Server is more structured than a datatype
in most programming languages.

Denormalize

A process for creating table joins that speeds up data retrieval at the cost of having duplicate row values
between some columns.

Derived Table

In a Domain, a derived table is defined by an additional query whose result becomes another set of items
available in the Domain. For example, with a JDBC data source, you can write an SQL query that includes
complex functions for selecting data. You can use the items in a derived table for other operations on the
Domain, such as joining tables, defining a calculated field, or filtering. The items in a derived table can also be
referenced in the Domain's security file and locale bundles.

Dice

An OLAP operation to select columns.

Dimension

A categorization of the data in a cube. For example, a cube that stores data about sales figures might include
dimensions such as time, product, region, and customer's industry.

Domain

A virtual view of a data source that presents the data in business terms, allows for localization, and provides
data-level security. A Domain is not a view of the database in relational terms, but it implements the same
functionality within JasperReports Server. The design of a Domain specifies tables in the database, join clauses,
calculated fields, display names, and default properties, all of which define items and sets of items for creating
Ad Hoc reports.

Domain Topic

A Topic that is created from a Domain by the Data Chooser. A Domain Topic is based on the data source and
items in a Domain, but it allows further filtering, user input, and selection of items. Unlike a JRXML-based
Topic, a Domain Topic can be edited in JasperReports Server by users with the appropriate permissions.

Drill

To click on an element of an OLAP view to change the data that is displayed:
• Drill down. An OLAP operation that exposes more detailed information down the hierarchy levels by

delving deeper into the hierarchy and updating the contents of the navigation table.
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• Drill through. An OLAP operation that displays detailed transactional data for a given aggregate measure.
Click a fact to open a new table beneath the main navigation table; the new table displays the low-level
data that constitutes the data that was clicked.

• Drill up. An OLAP operation for returning the parent hierarchy level to view to summary information.

Eclipse

An open source Integrated Development Environment (IDE) for Java and other programming languages, such as
C/C++.

ETL

Extract, Transform, Load. A process that retrieves data from transactional systems, and filters and aggregates the
data to create a multidimensional database. Generally, ETL prepares the database that your reports will access.
The Jaspersoft ETL product lets you define and schedule ETL processes.

Fact

The specific value or aggregate value of a measure for a particular member of a dimension. Facts are typically
numeric.

Field

A field is equivalent to a column in the relational database model. Fields originate in the structure of the data
source, but you may define calculated fields in a Domain or custom fields in the Ad Hoc Editor. Any type of
field, along with its display name and default formatting properties, is called an item and may be used in the Ad
Hoc Editor.

Frame

In Jaspersoft Studio, a frame is a rectangular element that can contain other elements and optionally draw a
border around them. Elements inside a frame are positioned relative to the frame, not to the band, and when you
move a frame, all the elements contained in the frame move together. A frame automatically stretches to fit its
contents.

Frame can also refer to an element in a legacy dashboard; it's the equivalent of a dashlet.

Group

In a report, a group is a set of data rows that have an identical value in a designated field.
• In a table, the value appears in a header and footer around the rows of the group, while the other fields

appear as columns.
• In a chart, the field chosen to define the group becomes the independent variable on the X axis, while the

other fields of each group are used to compute the dependent value on the Y axis.

Hierarchy Level

In an OLAP cube, a member of a dimension containing a group of members.

Input Control

A button, check box, drop-down list, text field, or calendar icon that allows users to enter a value when running
a report or viewing a dashboard that accepts input parameters. For JRXML reports, input controls and their
associated datatypes must be defined as repository objects and explicitly associated with the report. For
Domain-based reports that prompt for filter values, the input controls are defined internally. When either type of
report is used in a dashboard, its input controls are available to be added as special content.
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Item

When designing a Domain or creating a Topic based on a Domain, an item is the representation of a database
field or a calculated field along with its display name and formatting properties defined in the Domain. Items
can be grouped in sets and are available for use in the creation of Ad Hoc reports.

JasperReport

A combination of a report template and data that produces a complex document for viewing, printing, or
archiving information. In the server, a JasperReport references other resources in the repository:
• The report template (in the form of a JRXML file)
• Information about the data source that supplies data for the report
• Any additional resources, such as images, fonts, and resource bundles referenced by the report template.

The collection of all the resources that are referenced in a JasperReport is sometimes called a report unit. End
users usually see and interact with a JasperReport as a single resource in the repository, but report creators must
define all of the components in the report unit.

Jaspersoft Studio

A commercial open source tool for graphically designing reports that leverage all features of the JasperReports
Library. Jaspersoft Studio lets you drag and drop fields, charts, and sub-reports onto a canvas, and also define
parameters or expressions for each object to create pixel-perfect reports. You can generate the JRXML of the
report directly in Jaspersoft Studio, or upload it to JasperReports Server. Jaspersoft Studio is implemented in
Eclipse.

JasperReports Library

An embeddable, open source, Java API for generating a report, filling it with current data, drawing charts and
tables, and exporting to any standard format (HTML, PDF, Excel, CSV, and others). JasperReports processes
reports defined in JRXML, an open XML format that allows the report to contain expressions and logic to
control report output based on run-time data.

JasperReports Server

A commercial open source, server-based application that calls the JasperReports Library to generate and share
reports securely. JasperReports Server authenticates users and lets them upload, run, view, schedule, and send
reports from a web browser. Commercial versions provide metadata layers, interactive report and dashboard
creation, and enterprise features such as organizations and auditing.

Jaspersoft ETL

A graphical tool for designing and implementing your data extraction, transforming, and loading (ETL) tasks. It
provides hundreds of data source connectors to extract data from many relational and non-relational systems.
Then, it schedules and performs data aggregation and integration into data marts or data warehouses that you
use for reporting.

Jaspersoft OLAP

A relational OLAP server integrated into JasperReports Server that performs data analysis with MDX queries.
The product includes query builders and visualization clients that help users explore and make sense of
multidimensional data. Jaspersoft OLAP also supports XML/A connections to remote servers.

Jaspersoft Studio

An open source tool for graphically designing reports that leverage all features of the JasperReports Library.
Jaspersoft Studio lets you drag and drop fields, charts, and sub-reports onto a canvas, and also define parameters
or expressions for each object to create pixel-perfect reports. You can generate the JRXML of the report directly
in Jaspersoft Studio, or upload it to JasperReports Server. Jaspersoft Studio is implemented in Eclipse.

TIBCO Software Inc. 283



JasperReports Server User Guide

JavaBean

A reusable Java component that can be dropped into an application container to provide standard functionality.

JDBC

Java Database Connectivity. A standard interface that Java applications use to access databases.

JNDI

Java Naming and Directory Interface. A standard interface that Java applications use to access naming and
directory services.

Join Tree

In Domains, a collection of joined tables from the actual data source. A join is the relational operation that
associates the rows of one table with the rows of another table based on a common value in given field of each
table. Only the fields in a same join tree or calculated from the fields in a same join tree may appear together in
a report.

JPivot

An open source graphical user interface for OLAP operations. For more information, visit
http://jpivot.sourceforge.net/.

JRXML

An XML file format for saving and sharing reports created for the JasperReports Library and the applications
that use it, such as Jaspersoft Studio and JasperReports Server. JRXML is an open format that uses the XML
standard to define precisely all the structure and configuration of a report.

Level

Specifies the scope of an aggregate function in an Ad Hoc view. Level values include Current (not available for
PercentOf), ColumnGroup, ColumnTotal, RowGroup, RowTotal, Total.

MDX

Multidimensional Expression Language. A language for querying multidimensional objects, such as OLAP (On
Line Analytical Processing) cubes, and returning cube data for analytical processing. An MDX query is the
query that determines the data displayed in an OLAP view.

Measure

Depending on the context:
• In a report, a formula that calculates the values displayed in a table's columns, a crosstab's data values, or a

chart's dependent variable (such as the slices in a pie).
• In an OLAP view, a formula that calculates the facts that constitute the quantitative data in a cube.

Mondrian

A Java-based, open source multidimensional database application.

Mondrian Connection

An OLAP client connection that consists of an OLAP schema and a data source. OLAP client connections
populate OLAP views.

Mondrian Schema Editor

An open source Eclipse plug-in for creating Mondrian OLAP schemas.
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Mondrian XML/A Source

A server-side XML/A source definition of a remote client-side XML/A connection used to populate an OLAP
view using the XML/A standard.

MySQL

An open source relational database management system. For information, visit http://www.mysql.com/.

Navigation Table

The main table in an OLAP view that displays measures and dimensions as columns and rows.

ODBO Connect

Jaspersoft ODBO Connect enables Microsoft Excel 2003 and 2007 Pivot Tables to work with Jaspersoft OLAP
and other OLAP servers that support the XML/A protocol. After setting up the Jaspersoft ODBO data source,
business analysts can use Excel Pivot Tables as a front-end for OLAP analysis.

OLAP

On Line Analytical Processing. Provides multidimensional views of data that help users analyze current and past
performance and model future scenarios.

OLAP Client Connection

A definition for retrieving data to populate an OLAP view. An OLAP client connection is either a direct Java
connection (Mondrian connection) or an XML-based API connection (XML/A connection).

OLAP Schema

A metadata definition of a multidimensional database. In Jaspersoft OLAP, schemas are stored in the repository
as XML file resources.

OLAP View

Also called an analysis view. A view of multidimensional data that is based on an OLAP client connection and
an MDX query. Unlike Ad Hoc views, you can directly edit an OLAP view's MDX query to change the data
and the way they are displayed. An OLAP view is the entry point for advanced analysis users who want to
write their own queries. Compare Ad Hoc View.

Organization

A set of users that share folders and resources in the repository. An organization has its own user accounts, roles,
and root folder in the repository to securely isolate it from other organizations that may be hosted on the same
instance of JasperReports Server.

Organization Admin

Also called the organization administrator. A user in an organization with the privileges to manage the
organization's user accounts and roles, repository permissions, and repository content. An organization admin
can also create suborganizations and mange all of their accounts, roles, and repository objects. The default
organization admin in each organization is the jasperadmin account.

Outlier

A fact that seems incongruous when compared to other member's facts. For example, a very low sales figure or a
very high number of help desk tickets. Such outliers may indicate a problem (or an important achievement) in
your business. The analysis features of Jaspersoft OLAP excel at revealing outliers.

TIBCO Software Inc. 285

http://www.mysql.com/


JasperReports Server User Guide

Parameter

Named values that are passed to the engine at report-filling time to control the data returned or the appearance
and formatting of the report. A report parameter is defined by its name and type. In JasperReports Server,
parameters can be mapped to input controls that users can interact with.

Pivot

To rotate a crosstab such that its row groups become column groups and its column groups become rows. In the

Ad Hoc Editor, pivot a crosstab by clicking .

Pivot Table

A table with two physical dimensions (for example, X and Y axis) for organizing information containing more
than two logical dimensions (for example, PRODUCT, CUSTOMER, TIME, and LOCATION), such that each
physical dimension is capable of representing one or more logical dimensions, where the values described by
the dimensions are aggregated using a function such as SUM. Pivot tables are used in Jaspersoft OLAP.

Properties

Settings associated with an object. The settings determine certain features of the object, such as its color and
label. Properties are normally editable. In Java, properties can be set in files listing objects and their settings.

Report

In casual usage, report may refer to:
• A JasperReport. See JasperReport.
• The main JRXML in a JasperReport.
• The file generated when a JasperReport is scheduled. Such files are also called content resources or output

files.
• The file generated when a JasperReport is run and then exported.
• In previous JasperReports Server versions, a report created in the Ad Hoc Editor. See Ad Hoc Report.

Report Run

An execution of a report, Ad Hoc view, or dashboard, or a view or dashboard designer session, it measures and
limits usage of Freemium instances of JasperReports Server. The executions apply to resources no matter how
they are run (either in the web interface or through the various APIs, such as REST web services). Users of our
Community Project and our full-use commercial licenses are not affected by the limit. For more information,
please contact sales@jaspersoft.com.

Repository

The tree structure of folders that contain all saved reports, dashboards, OLAP views, and resources. Users access
the repository through the JasperReports Server web interface or through Jaspersoft Studio. Applications can
access the repository through the web service API. Administrators use the import and export utilities to back up
the repository contents.

Resource

In JasperReports Server, anything residing in the repository, such as an image, file, font, data source, Topic,
Domain, report element, saved report, report output, dashboard, or OLAP view. Resources also include the
folders in the repository. Administrators set user and role-based access permissions on repository resources to
establish a security policy.
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Role

A security feature of JasperReports Server. Administrators create named roles, assign them to user accounts, and
then set access permissions to repository objects based on those roles. Certain roles also determine what
functionality and menu options are displayed to users in the JasperReports Server interface.

Schema

A logical model that determines how data is stored. For example, the schema in a relational database is a
description of the relationships between tables, views, and indexes. In Jaspersoft OLAP, an OLAP schema is the
logical model of the data that appears in an OLAP view; they are uploaded to the repository as resources. For
Domains, schemas are represented in XML design files.

Schema Workbench

A graphical tool for easily designing OLAP schemas, data security schemas, and MDX queries. The resulting
cube and query definitions can then be used in Jaspersoft OLAP to perform simple but powerful analysis of
large quantities of multi-dimensional data stored in standard RDBMS systems.

Set

In Domains and Domain Topics, a named collection of items grouped together for ease of use in the Ad Hoc
Editor. A set can be based on the fields in a table or entirely defined by the Domain creator, but all items in a
set must originate in the same join tree. The order of items in a set is preserved.

Slice

An OLAP operation for filtering data rows.

SQL

Structured Query Language. A standard language used to access and manipulate data and schemas in a
relational database.

System Admin

Also called the system administrator. A user who has unlimited access to manage all organizations, users, roles,
repository permissions, and repository objects across the entire JasperReports Server instance. The system admin
can create root-level organizations and manage all server settings. The default system admin is the superuser
account.

Topic

A JRXML file created externally and uploaded to JasperReports Server as a basis for Ad Hoc reports. Topics are
created by business analysts to specify a data source and a list of fields with which business users can create
reports in the Ad Hoc Editor. Topics are stored in the Ad Hoc Components folder of the repository and
displayed when a user launches the Ad Hoc Editor.

Transactional Data

Data that describe measurable aspects of an event, such as a retail transaction, relevant to your business.
Transactional data are often stored in relational databases, with one row for each event and a table column or
field for each measure.

User

Depending on the context:
• A person who interacts with JasperReports Server through the web interface. There are generally three

categories of users: administrators who install and configure JasperReports Server, database experts or
business analysts who create data sources and Domains, and business users who create and view reports and
dashboards.
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• A user account that has an ID and password to enforce authentication. Both people and API calls accessing
the server must provide the ID and password of a valid user account. Roles are assigned to user accounts to
determine access to objects in the repository.

View

Several meanings pertain to JasperReports Server:
• An Ad Hoc view. See Ad Hoc View.
• An OLAP view. See OLAP View.
• A database view. See http://en.wikipedia.org/wiki/View_%28database%29.

Virtual Data Source

A virtual data source allows you to combine data residing in multiple JDBC and/or JNDI data sources into a
single data source that can query the combined data. Once you have created a virtual data source, you create
Domains that join tables across the data sources to define the relationships between the data sources.

WCF

Web Component Framework. A low-level GUI component of JPivot. For more information, see
http://jpivot.sourceforge.net/wcf/index.html.

Web Services

A SOAP (Simple Object Access Protocol) API that enables applications to access certain features of
JasperReports Server. The features include repository, scheduling and user administration tasks.

XML

eXtensible Markup language. A standard for defining, transferring, and interpreting data for use across any
number of XML-enabled applications.

XML/A

XML for Analysis. An XML standard that uses Simple Object Access protocol (SOAP) to access remote data
sources. For more information, see http://www.xmla.org/.

XML/A Connection

A type of OLAP client connection that consists of Simple Object Access Protocol (SOAP) definitions used to
access data on a remote server. OLAP client connections populate OLAP views.
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